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81199A User's Guide

Introduction

1 Introduction

The 81199A Wideband Waveform Center builds on

e the accuracy and wide bandwidth of 81180B and M8190A Arbitrary
Waveform Generators (AWG),

e the high performance of 90000A/X Series Real-Time Oscilloscopes,

¢ and the flexibility of the 89601B Vector Signal Analysis (VSA)
software,

to deliver an integrated stimulus / analysis test solution for the next
generation of wideband vector modulated signals.

The 81199A software currently supports selected specifications addressing
the 57 to 66 GHz unlicensed band; specifically IEEE 802.11ad and
WirelessHD. These specifications were chosen, principally because they are
important emerging technologies, but also because the 81199A software, in
conjunction with the high performance of the associated hardware platform,
makes it, for the first time, possible to accurately generate and analyze such
wideband signals.

The 81199A software is not limited to the currently supported formats. It is
a general purpose framework, and the associated hardware platform is
similarly flexible. As well as the specified formats, the software has generic
stimulus / analysis capabilities, such as multi-tone, and can be extended to
support other wideband signals for which the associated hardware platform
is an appropriate solution.

Users may also extend the 81199A software functionality by means of their
own "plug in" DLLs, as described in Agilent Wideband Waveform Center
81199A — User Defined Plugins Guide (81199-91030).

13
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Features and
Benefits

e Integrated stimulus and analysis

e Unrivalled accuracy and wide bandwidth

e Fully featured and flexible signal generation

e Comprehensive signal analysis

e Unique support for important emerging technologies
e User extendable functionality

e SCPI remote control for test automation

What's inside this
Manual

This manual provides detailed information about the following:

e 81199A software installation and configuration.
e Possible measurement hardware configurations.
e Using 81199A for wideband waveform generation and analysis.

Purpose of this
Manual

The purpose of this manual is to enable you to install and use the 81199A
Wideband Waveform Center software and to give some guidance on the
configuration of the associated hardware platform.

Who should read
this Manual

This manual is intended for;

e Anyone wishing to use the 81199A software to develop, debug or
verify an implementation of any of the supported wideband
modulation formats.

e Anyone wishing to use the 81199A software to exercise RF
components or subsystems that have been designed to process any
of the supported wideband modulation formats.

e Anyone wishing to generate or analyze very wide bandwidth vector
modulated signals.




Introduction

How this This section provides information on the chapters, and their content.
document is
organized
Navigating this manual
Chapter Chapter Heading This Chapter...
No.
1 Introduction Provides an overview of 81199A.
2 Installation Describes the steps required to install 81199A software
package.
3 Licensing Describes Agilent software licensing and the licenses
required to run the Agilent 81199A Wideband Waveform
Center software.
4 Getting Started Introduces to a typical 81199A workflow.
Hardware Configuration Provides guidance on how to configure your
measurement hardware.
6 Menu Describes the functions available via the main 81199A
menu.
7 Tool Bar Describes the 81199A tool bar.
8 Status Bar Describes the 81199A status bar.
9 Window Management Describes the docking panel window system.
and
Manipulation
10 Working with Describes how to work with the various result displays
Measurement Displays available in the 81199A software.
1" Generate Describes the general operation and layout of the
waveform generation part of the 81199A software.
12 Pre-Correction Describes how to compute and apply a pre-correction
filter to compensate for signal path imperfections.
13 Supported Formats Describes the modulation and coding options supported
(Generate) by the waveform generation part of the 8§1199A
software.
14 Measure Describes the modulation analysis part of the 81199A
software.

81199A User's Guide
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Chapter Chapter Heading This Chapter...

No.

15 Supported Formats Describes the functionality of the measuring

(Measure) demodulators currently supported by 89601B VSA time-

capture post-processing in the 81199A software.

16 FAQ Provides answers to frequently asked questions about
the 81199A software.

17 Release Notes Directs you to a version-by-version list of the new
features and known defects in the 81199A software.

18 Contacting Agilent Provides contact information for support on the 81199A
Wideband Waveform Center and the associated
hardware platform.

Conventions used

in this manual

The following table lists the icon conventions used in this manual:

Conventions

The icon...

Indicates...

A note or important information.

A tip

1
@
%

A caution or warning




Acronyms used in

The following table lists the acronyms used in this manual:

Introduction

this manual
Acronyms used in this document
Acronym Explanation
Ack Short for Acknowledge
ADT Antenna Direction Tracking
AGC Automatic Gain Control
API Application Programming Interface
AWG Arbitrary Waveform Generator
BPSK Binary Phase Shift Keying
BS Beam Search
CD Compact Disc
CSv Comma Separated Value
DAC Digital to Analog Converter
DLL Dynamic Link Library
DVD Digital Versatile/Video Disc
DUT Device Under Test
EEP Equal Error Protection
EVM Error Vector Magnitude
FD Frequency Domain
FEC Forward Error Correction
FOE Frequency Offset Estimation
GUI Graphical User Interface
GB Giga Byte
GPIB General Purpose Interface Bus
HCS Header Check Sum
HRP High Rate PHY
IEEE Institute of Electrical and Electronics Engineers
IF Intermediate Frequency
IP Internet Protocol
0] In-phase and Quadrature (the real and imaginary parts)
LRP Low Rate PHY
OFDM Orthogonal Frequency Division Multiplexing

81199A User's Guide
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PCS Payload Check Sum

LAN Local Area Network

LDPC Low Density Parity Check

LO Local Oscillator

LPSCPHY Low Power Single Carrier PHY
MB Mega Byte

OFDM Orthogonal Frequency Division Multiplex
0QPSK Offset QPSK

PCS Payload Check Sum

PSG Performance Signal Generator
0AM Quadrature Amplitude Modulation
QPSK Quadrature Phase Shift Keying

RF Radio Frequency

RTU RF Test Unit

RUI Remote-control User Interface
SCPHY Single Carrier PHY

SCPI Standard Commands for Programmable Instruments
SCS Short Check Sum

SDF Standard Data Format

D Time Domain

UEP Unequal Error Protection

USB Universal Serial Bus

VSA Vector Signal Analyzer

WEFA Wi-Fi Alliance

WGA Wireless Gigabit Alliance

18
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2.1 Introduction

This chapter shows you the steps required to install 81199A software package.

Installation

2 Installation

2.1.1 Pre-Requisites

The following are the hardware pre-requisites for Agilent 81199A software:

Operating System

Hardware (Preferred) Microsoft Windows® 7 (Optional) Microsoft® Windows® XP
Professional, Enterprise, or Ultimate Professional SP3
CPU 1 GHz or faster 32-bit (x86) or 64-bit 1 GHz or faster
(x64) processor 2 GHz recommended
RAM 2 GB recommended (32-bit) / 4 GB 2 GB recommended
recommended (64-bit)
Video RAM 128 MB 128 MB
(512 MB recommended) (512 MB recommended)
Hard Disk 1 GB available 1 GB available
Additional DVD to load software; license transfer DVD to load software; license transfer
Drives requires network access, USB Flash requires network access, USB Flash
drive, USB hard drive, or USB DVD drive  drive, USB hard drive, or USB DVD drive
Interface LAN, GPIB, USB or IEEE-1394 (only for LAN, GPIB, USB or IEEE-1394 (only for
Support VXI hardware and 1690 Series Logic VXI hardware and 1690 Series Logic
Analyzer), AXle, PXle Analyzer), AXle, PXle
Network 10 Mbps 10 Mbps
Bandwidth

81199A User's Guide
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Software The following are the software pre-requisites for Agilent 81199A software:
Pre-Requisites
1. Supported Operating System:
Windows XP SP3 (32 bit)
Windows 7 (32 bit)
Windows 7 (64 bit)

2. Ensure that you have Agilent |0 Libraries Suite 16.1 Update 1 or higher
installed on your system. The Agilent 10 Libraries Suite can be found
on the CD that is part of shipment content or at
http://www.agilent.com/find/iosuite

3. If you have a license for 81199A option 002 (analysis) and wish to use
this capability, then you will also need Agilent 89601B VSA version 14
or higher installed on your system.

2.1.2 Installation Process
Follow the given steps to install Agilent 81199A software on your system.

1. Double-click the executable (Agilent 81199A Setup.exe) to run the
81199A setup. The 81199A setup will be available either on CD, USB
drive or Web.

L]

i

agilent_i1199a_setup.exe

The following welcome screen will appear:



Installation

Agilent 811994 Wideband Wavefarm Center - InstallShield Wizard 23]

Welcome to the Install5hield Wizard for Agilent
81199A Wideband Waveform Center

The InstallShield 'wizard will install Agilent 817334,
Wideband Wawveform Center on wour computer. To
continue, click Nest,

<Back | Mest: |[ Cancel l

2. Click “Next” to continue. The license agreement window will appear.

Agilent 811994 Wideband Waveform Center - InstallShield Wifizard

Licenze Agreement

»

AGILENT TECHNOLOGIES, INC. SOFTWARE LICENSE | |
TERMS

ATTENTION: DOWNLOADING, COPYING, PUBLICLY DISTRIBUTING,

OR USING THIS SOFTWARE IS SUBJECT TO THE LICENSE TERMS SET
FORTH EELOW.

TO DOWNLOAD, STORE, INSTALL, OR RUN THE SOFTWARE, YOU
MUST FIRST AGREE TO AGILENT'S SOFTWARE LICENSE TERMS ~

@1 accept the terms of the licenze agreement

() | do not accept the terms of the license agreement

< Back ][ Hest » l[ Cancel l

3. Select “l accept the terms of the license agreement” and click “Next”
to continue. The following window will appear.
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Agilent 811994, Wrideband Wavefarm Center - InstallShield Wizard (225

Choose Destination Location i,

&

Setup will install Agilent 811334 wideband “waveform Center in the following folder.

Select folder where setup will inztall files.

Tainzstall bo thiz folder, click Mext. Tainzstall to a different folder, click Browse and select
another folder.

Destination Folder

C:h hAagilenth 311994 Wideband Waveform Centert, Browsze...
| < Back ” Ment » || Cancel |

Click "Next" to install in the default folder. However, if you want to
install to a different folder, click "Browse" and select another folder.
The following screen will appear.

Agilent 811994 Wideband Wavefarm Center - InstallShield Wizard 23]

'y

If you want to review or chanage any of your installation zettings, click Back. Click Cancel ta exit
the wizard.

Ready to Install the Program

§

The wizard iz ready to begin inztallation.

Click Inzstall ta beain the inztallation.

| <Back [ Install || Cancel

Click "Install" to begin the 81199A installation. The following screen
will appear that displays the setup status of the 81199A installation.
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Installation

Agilent 811994 Wideband Waveform Center - TnstallShield Wizard
Setup Status

The InztallShield Wizard iz installing Agilent 311394 Wideband W aveform Center

L4 8877998 Wideband W avetorm CenteriwiGigD emodLibran. il

InztallShield

Cancel

The following screen will appear once the Agilent 81199A software is
successfully installed on your system. Click “Finish” to exit 81199A
setup.

Agilent 811994 Wideband Waveform Center - InstallZhield Wizard

Install5hield Wizard Complete

The InztallShield Wizard hag successiully installed Agilent
311334 Wideband ' aweform Center. Click. Finizh to exit the:
wizard,

< Back Cancel

This step completes the Agilent 81199A installation process.
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Licensing

0e® 3 Licensing
-0 0 @ Q@o-.
.....

3.1 Introduction

This chapter describes Agilent software licensing and the licenses you will
need to run the Agilent 81199A Wideband Waveform Center software.

3.2 Agilent Software Licensing

The 81199A software can be installed on any PC that meets the pre-requisites
specified in section 2.1.1. However, to run the software on a specific PC you
must also obtain and install a PC-specific license key file.

When you purchase 81199A you will be provided with a License Redemption
Entitlement Certificate that documents the options to which you are entitled.

You can redeem the certificate at
http://www.agilent.com/find/softwaremanager

using the purchase order number, entitlement certificate number and the
licensing serial number for the PC on which you want to run the software.

To find the licensing serial number for your PC; once you have successfully
installed the product, right-click on the Agilent License Manager icon in the
status bar notification area and select "About Agilent License Notifier".

From the resulting dialog, note the hostid. The hostid has two parts,
the fixed "model number”, PCSERNO, and a "licensing serial number’
unique to your PC. You will need the licensing serial number part.
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The licensing serial number is not the manufacturer's serial number of your
PC, is an identifier generated based on your PC hardware after installing the
Agilent License Service.

The Agilent Software Licensing system will issue a license file for each
purchased option, by email, to an address you specify. Each license file is a
plain text file attachment with a filename in the form XXXXXX_YYYYYY lic.

When you receive the email you should save the attached .lic file(s) to the
Agilent license directory, which is, by default, located at

C:\Program Files\Agilent\licensing

The Agilent License Service on the PC constantly monitors the license
directory and will install the license as soon as the new .lic file(s) appears in
the license directory. The result of the license installation is reported by a
status balloon in the notification area.

You can check the status of your software licenses by running the optional
Agilent License Manager or by selecting Help > About... from the 81199A
menu then selecting the Licenses tab in the About dialog.

If a license is not available or not valid, the corresponding feature will not be
enabled by the Agilent 81199A Wideband Waveform Center.

The 89601B VSA software is not a part of the 81199A installation, but you will
need a licensed installation of the 89601B VSA with at least options 200
(Basic VSA) and 300 (Hardware Connectivity) in order to use 81199A option
002 (analysis). You will also need 89601B option AYA (Vector Modulation
Analysis) if you wish to analyze vector modulated signals other than those
supported directly by 81199A.




3.3 81199A Licenses

Licensing

Table 1. Agilent 81199A Software Options

81199A-TRL

1.000

Trial

A 30-day free trial license that
temporarily enables option 001,
002 and IAD functionality to
permit product evaluation.

81199A-001

1.000

Generation

Generate waveforms and
download to Agilent wideband
AWGs. Generation options are
subject to presence of options
IAD and WHD.

81199A-002

1.000

Analysis

Acquire signal data from the
89601B VSA software.
Measurement options are
subject to presence of options
IAD and WHD.

81199A-1AD

1.000

IEEE 802.11ad

Generate and measure
waveforms compliant with the
IEEE 802.11ad / WiGig
MAC/PHY v1.2 specification.

81199A-WHD

1.000

WirelessHD

Generate and measure
waveforms compliant with the
WirelessHD 1.0b specification.

81199A-DFP

1.000

File Output

Save waveform data to an
unencrypted file, in CSV, BIN or
MAT format, on the host PC.

89601B-200
89601B-300
89601B-AYA (optional)

YYYY.VVVV

VSA Licenses

The 81199A analysis capability is
built upon the 89601B Vector
Signal Analysis product. In
addition to the 81199A license,
you will need to have these
89601B features installed and
licensed in order for 81199A-002
to function.

81199A User's Guide
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Getting Started

*0%e’ 4 Getting Started

4.1 Introduction

This chapter introduces you to a typical 81199A workflow, To do this, we will
perform the following introductory activities,

¢ Configure the hardware

e (Create a simple waveform

e Download the waveform

o Configure the VSA/oscilloscope to acquire the signal

e Look at time and spectrum results

e Enable pre-corrections

e Create an IEEE 802.11ad compliant waveform

e Download the waveform

e Enable demodulation and look at some measurement results

4.2 Configure the Hardware

Hardware configuration is described fully in Chapter 5. Here we will make a
very simple baseband-to-baseband connection, which will be sufficient to get
you familiar with the software workflow.

You are assumed to have the following equipment available,
e A computer with the 81199A and 89601B software correctly installed.
e An Agilent 81180B or M8190A AWG.

e An Agilent 90000A or 90000X Series oscilloscope.
e LAN connectivity between the computer, AWG and oscilloscope.
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If you are only using 81199A for waveform generation (81199A option 001
only) then you do not require the 89601B software or the oscilloscope.
(Unless you also plan to use the generator's Pre-Correction capability).

If you have 81199A option DFP, you can save waveforms to a file and recall
them as "recordings" into the analysis part of the tool. This allows evaluation
and demonstration of the software without any hardware.

421 Connect the AWG to the Oscilloscope

81180B

M8190A

Agilent wideband AWGs have differential outputs; each channel has a normal
and inverted output. To simplify the connection to the oscilloscope we shall
only use the normal output and terminate the inverted output with a 50Q load.

On the 81180B, the channel output connectors are labeled Out 1, /0ut 1, Out
2, and /0ut 2. These connectors are used for all output coupling modes.

e Connect 81180B Out 1 to 90000A/X Channel 1
e Connect 81180B Out 2 to 90000A/X Channel 3
e Connect a 50 ohm load to the unused 81180B /0ut 1 connector
e Connect a 50 ohm load to the unused 81180B /0ut 1 connector

On the M8190A, there are two sets of output connectors for each channel,
labeled Direct Out and Amp Out. We will use the Direct Out connectors
which are used in the DAC output coupling mode.

e Connect M8190A Channel 1 Direct Out to 90000A/X Channel 1
e Connect M8190A Channel 2 Direct Out to 90000A/X Channel 3

e (Connect a 50 ohm load to the unused M8190A Channel 1 /Direct Out
connector

e Connect a 50 ohm load to the unused M8190A Channel 2 /Direct Out
connector
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4.2.2 Connect the LAN

There are so many possible ways to achieve LAN connectivity that you will
have to decide the best solution for your circumstances. However, we will
suggest one possibility that is arguably the easiest way to achieve private test
equipment LAN connectivity; especially if your organization's IT rules disallow
connecting test equipment to the company LAN infrastructure.

Using a home router You can use an inexpensive home networking (broadband) router to create a
private LAN. The advantage of using a router intended for home use is that it
will include a DHCP server which automates the allocation of IP addresses. If
permissible, the router can also be connected to your company network for
WAN connectivity.

81180B If you have an 81180B AWG simply connect it, the computer, and the
90000A/X series oscilloscope to the router. Optionally, connect the router's
WAN port to your company LAN.

M8190A If you have an M8190A AWG that is connected to your computer using a PCle
cable then, assuming the M8190A firmware is also running on the computer,
LAN connectivity is achieved via the localhost loopback.

If you have an M8190A AWG that is connected to another computer (such as
an Agilent M9536A AXle Embedded Controller) then connect that computer to

the router.
Establishing the The oscilloscope is not connected directly to the 81199A software; instead it
connections is configured in the 89601B VSA software.

Setting up and using the Infiniium Oscilloscope with the VSA software is
described in the application note Agilent Infiniium Oscilloscopes with 89600B
VSA Software (P/N 5990-6819EN).

81180B If you have an 81180B AWG you only need to know the IP address, which can
be discovered from the 81180B front panel by pressing Utility > Remote
Interface > LAN.
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M8190A

Entering the AWG IP
Address

If you have an M8190A AWG that is hosted on the same computer as the
81199A software then the IP address is 127.0.0.1, or you can enter the
equivalent hostname "localhost".

If you have an M8190A AWG that is hosted on another computer then you
can determine that computer's IP address by opening a command window
(Start > Run... > cmd.exe) and executing the ipconfig command. Alternatively
you can enter the computer's hostname.

To enter the AWG's IP address, select the appropriate output device using the
menu selection Generate > Qutput Device > Agilent M8190A — Precision
Mode (14 bit, 8 GHz), then, in the Current Output Device Settings window,
enter the IP address or hostname in the Instrument Address setting.

The associated port number should normally be left at its default value of
5025.

It is only necessary to change the port number if the 81199A software and
M8190A firmware are hosted on the same computer AND you want to
remotely control the 81199A software.

4.3 Create a Simple Waveform

If you are hosting the M8190A on the same computer as the 81199A
software, run the M8190A firmware before starting 81199A. This ensures
that the M8190A firmware can claim ownership of port 5025 for remote
control purposes.

1. Run the 81199A software.
Select the Multi-tone Segment Library window.
Drag and drop Segment 1 from the Segment Library window into the
Waveform Layout window by clicking on the colored box numbered 1.
This action will cause the Multi-tone Segment 1 Settings window to
be selected in the docking panel on the left.
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Change the segment 1 settings to,

e Tone Type: Multi Tone

e  Multitone Number of Tones: 20

e  Multitone Occupied Bandwidth: 1.800000 GHz
e Multitone Suppressed Tone: Tone at Fc

e Multitone Single-sided: True

4.4 Download the Waveform

81199A User's Guide

If you have not already done so then, on the menu, select Generate > Output
Device and select your output device.

In the Current Output Device Settings window enter the AWG IP address or
hostname as the Instrument Address (you only need to do this once).

In the Final Waveform Settings window Set Sin(x)/x Correction On to True
(because you are outputting to an AWG).

On the menu, select Generate > Generate and Output..., or click the Tool Bar
Generate and Output... button.
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4.5 Configure the VSA/Oscilloscope to Acquire the Signal

In the Acquisition Settings window, click the "Basic" button to select the
simpler settings list, then change (if necessary) the settings to,

e Channel Config : | and Q Baseband Inputs (always change this setting
first because it resets the center and span values)

e Center:0.000 000 000 Hz

e Span:2500000 000 GHz

e Points: 102,401

e Mirror Freq: False

e Main Length : 40.000000000 ps

You can then set the Range manually (400 mV is a good value for this
configuration), or automatically by clicking the Auto-Range button in the Tool
Bar. When in | and Q baseband mode, the channel 1 and 2 range settings are
linked, you need only change the range value for channel 1.

4.6 Look at Time and Spectrum Results

If the analysis is not already running, click the Start button in the toolbar.

By default, Measurement Display window 1 should be mapped to the
measurement result called Main Time and Measurement Display window 2
should be mapped to the measurement result called Spectrum.

The displays should be showing time and frequency traces similar to Figure 1
and Figure 2.

0 The individual Measurement Display windows can be brought out into a
resizable floating window by double clicking on the window's tab, and can be
returned to their original position by double clicking on the floating window's
title bar.
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Main Time

Log
Magnitude |

dBm

2 : [Spectrum]

SpeCtrum i g€ | (W)start (®@)stop | (A S

Magnit

Main Length: ps

Figure 2. Spectrum trace for a single sided multi-tone signal with 5 ps
IQ skew
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Exploring the traces  Looking at Figure 2, the multi-tone spectrum is less than perfect at this stage.

9 This serves to illustrate an important point; small inaccuracies in 1Q gain,

- timing, symbol clock etc., that you may have regarded as inconsequential
when working at lower symbol rates can have a large impact on vector
modulated signals at very high symbol rates.

In the example signal, the unexpected spurious tones in the lower half of the
spectrum are largely due to a skew of just 5 ps between the | and Q signals.

(5 ps skew equates to about 0.8 mm difference in the electrical length of the
| and Q paths).

This skew can be manually compensated using the delay adjustment in the
M8190A soft front panel, or the 81180B Ch1 / Ch2 Qutput | X-Channel
controls, to give the improved spectrum shown in Figure 3.

2 : [Spectrum]

an:2

2!

Main Lel

Figure 3. Multi-tone Spectrum with Manual Skew Correction.

In this simple hardware setup, we are mainly correcting for cable mismatch
so a manually adjustment is practical, but for more realistic signal
impairments, such as would be present in a fully modulated, up and down
converted configuration, the necessary pre-corrections are complex and
interactive, so the 81199A software provides an automated process.

Before we introduce the automatic pre-corrections capability, you should take
some time to explore the display options.
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Display Zoom If you have a mouse with a wheel, a very useful display feature is Zooming,
which enables you to quickly and easily zoom into interesting parts of the
signal. Zooming is described in section 10.4.

1 : [Main Time]

Figure 4. Main Time display with zoom active.

Display Settings Most of the labeling on the display is active, meaning that you can double-
click on the current value to select a different choice or a new value. For
example in the Main Time trace you can double click on the default Y-axis Log
Magnitude representation to change to, for example, Real, or Wrapped Phase.
You can similarly change the units from dBm to, for example, Watts or Vrms,
and you can change the ranges of both axes by double clicking on the current
limits.

These features are described more fully in section 10.
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4.7 Enable Pre-Corrections

In the Final Waveform Settings window, change the Calibration settings,

e (alibration Mode : Cal On Every Download
o (alibration Center Frequency : 0.000000 Hz

Then click the Generate and Qutput... button in the tool bar.

The software will automatically download and analyze a test signal to
determine the mean channel response (magnitude and phase) and the 1Q
imbalance (magnitude and phase) of the end-to-end signal path from the
AWG DAC outputs to the oscilloscope ADC inputs.

On completion of the calibration phase, graphs of the channel response and
10 imbalance are presented for inspection. The software offers an opinion as
to whether the calibration was successful, but the outcome is so dependent
on your particular hardware configuration that the final judgment is left to
you.

Specific assessment criteria are discussed in section 12, but in general the
old saying, “a smooth answer is a good answer” generally applies here.

The calibration algorithm also returns an estimate of the Frequency Offset and
Quadrature error present in the signal path.

Figures Figure 5 and Figure 6 show measurements typical of the simple
loopback setup we are using as an example.
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Pre-Correction Verification

The calibration is complete, do you wish to apply the pre-corrections to the
downloaded waveform?

The calibration completed successfully, please double check the measurement displays below and verify that no
7 unexpected characteristics are present.
. - Estimated Frequency Offset is -1 kHz

- Estimated Quadrature Error is 0.00093422 degrees.

Mean Channel Response | |Q imbalance

I you press Yes, the results of this calibration will be used to pre-correct the signal.
if you press No the signal will not be pre-corrected. Yes No Retry
if you wish to adjust your systzm press Retry to re-run the calibration.

Figure 5. Measured Mean Channel Response
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Pre-Correction Verification

The calibration is complete, do you wish to apply the pre-corrections to the
downloaded waveform?

The calibration completed successfully, please double check the measurement displays below and verify that no
7 unexpected characteristics are present.
. - Estimated Frequency Offset is -1 kHz

- Estimated Quadrature Error is 0.00093422 degrees.

Mean Channel Response | 1Q Imbalance

I you press Yes, the results of this calibration will be used to pre-correct the signal.
if you press No the signal will not be pre-corrected. Yes No Retry
if you wish to adjust your systzm press Retry to re-run the calibration.

Figure 6. Measured IQ Imbalance

Assuming the calibration has been successful, click the Yes button. You can
also abandon calibration by clicking No, or repeat the calibration (e.g. after
making an adjustment) by clicking Retry.

When you click the Yes button, the software will calculate an appropriate pre-
correction filter based on the measured responses, then apply the filter to the
final waveform and download it to the M8190A.

This calibration procedure will be repeated every time you download a new
waveform by clicking the Generate and Qutput... button.

If your hardware configuration and fundamental signal properties, such as
sample rate, do not change from download to download, this represents
unnecessary extra processing and time. For this situation the software
provides a slightly smarter Calibration Mode setting, Cal On Settings Change,
which only invokes a calibration when setting changes require it; see section
11.4.1 for details.
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@ We have has only introduced the use of pre-correction here. See section 12
for a full description.

4.8 Create an IEEE 802.11ad Compliant Waveform

Once you can generate and receive a simple signal, such as the multi-tone, it
is a relatively small step to do the same for more complex signals.

Delete the multi-tone segment from the Waveform Layout window by right-
clicking on the segment label and selecting "Delete this segment instance"
from the drop down menu.

Assuming that you have 81199A option IAD licensed, select the 802.11ad
Segment Library window tab. If you have another waveform creation option
licensed then you can likely follow a very similar procedure with that.

Drag and drop Segment 1 from the Segment Library into the Waveform Layout
window by clicking on the colored box numbered 1. This action will cause the
802.11ad Segment 1 settings list to appear in the Settings Window on the left.

Leave the segment 1 settings at their default values.

4.9 Download the Waveform

Assuming that you have previously downloaded the multi-tone signal then
then the output device will already have been selected and its IP address will
have been set.

So that we can see later the improving effect of pre-corrections on a vector
modulated signal, we turn them off initially. To do this, in the Final Waveform
Settings window, set Calibration Mode to No Cal.

On the menu select Generate > Generate and Output, or click the Tool Bar
Generate and Output button.
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4.10 Enable Demodulation and Look at Analysis Results

Assuming that you have previously analyzed the example multi-tone signal
then then the acquisition settings will already be correct for this 802.11ad
signal.

To enable IEEE 802.11ad demodulation, set Demod On to True in the 802.11ad
Demodulation Settings window.

To see the initial demodulation analysis results, select any of the
Measurement Results windows, right mouse click on the window tab or on
the title of the currently displayed measurement result, and select 802.11ad
Error Summary from the drop-down menu.

4 : [802.11ad Error Summary]

Detected MCS Type

Frequency Error

SymbalC

Estimated L 43.777 dB
= -17.503 dB
EVM (DG Compensated) -17.543 dB
1&Q DC =

1 Amplitude Imbalance

LO Quadrature Error

F209 hex

o
1000
0
42 hex
0
0
ponse False
Additional PPDU V]

Figure 7. Initial 802.11ad Error Summary
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We notice that the signal has been correctly identified as an MCS1 packet,
but the EVM is surprisingly high at 13.3%.

If we right click on the result title and select 802.11ad 1Q Data the reason
becomes clear. The constellation points are very diffused. However, it is
clearly a systematic problem rather than noise.

In fact we know from experience that this sort of constellation distortion is
due to a symbol clock error. Another look at the Error Summary shows that
the demodulator is reporting a Symbol Clock Error of 4.0 ppm.

4 :[802.11ad I} Data]
: €€ | (p)start (W)5top

4802 11ad 1Q Zoomed:False
1,0000 '

Vpk

-1.0000 * 1.0000

Vpk Vpk

Figure 8. MCS1 Constellation with 4 ppm Symbol Clock Error
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This error conveniently highlights an assumption about the test setup that
you should be aware of. We are assuming that that transmitter's
understanding of symbol clock frequency is exactly the same as the
receiver's.

For an 802.11ad single carrier modulation they are both nominally 1.76 GHz,
but the accuracy of that assumption is dependent upon the frequency
references local to the transmitter (in this case the M8190A reference clock)
and the receiver (in this case the 90000A/X reference clock).

If they are in fact slightly different, perhaps by just a few parts-per-million,
then the receiver's understanding of symbol clock frequency will be similarly
in error relative to the transmitter and this will result in a degraded EVM and
constellation; as we see in Figure 7 and Figure 8.

As mentioned, the Error Summary shows that, in this case, there is a 4 ppm
difference between the transmitter and the receiver's reference clocks.

Assuming that the acquisition hardware is locked to a traceable precision
frequency reference, the Symbol Clock Error result provides a measure of the
absolute transmitter symbol clock accuracy.

We want to measure this error (which is why it is displayed), but we would
also like to correct for it (as the DUT would) so the 802.11ad demodulator has
a setting in the Demodulator Settings window called Symbol Clock Offset
which can be adjusted manually to match the source and destination symbol
clocks Alternatively there is a similar adjustment in the Segment Settings
window on the generate side.

On the test setup used to create the graphics for this guide, the demodulator
Symbol Clock Offset was adjusted to -4 ppm to give a measured symbol clock
error around 0.0 ppm and an EVM value of about 1.5 % EVM without further
adjustment.
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4 :[802.11ad I} Data]
E (¥)5tart (M) Stop

4. 802.11ad 1Q Data Zoomed:False
.
1.0000 24 063
Vpk paints

= .0000
Vpk
-1.0000 1.0000
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Figure 9. MCS1 Constellation after Symbol Clock Offset Adjustment

Now we can explore the benefit of pre-correcting the signal.

In the Final Waveform Settings window set Calibration Mode to Cal On Every
Download and click the Generate and Output button. Once the calibration
procedure has generated satisfactory channel response and 1Q imbalance
results, click the Yes button to compute and apply the corrections and
download the waveform to the M8190A.

See section 12 for a full description of pre-correction.

On the test setup, pre-correction improved the measured EVM (DC
Compensated) to less than 1.0%
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4 :[802.11ad IQ Data]
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Figure 10. MCS1 Constellation with Pre-Corrections Applied




81199A User's Guide

3:[802.11ad Error Summary]
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802.11ad Error Summary
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LO Quadrature Error
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Figure 11. MCS1 Error Summary with Pre-Corrections Applied.
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Hardware Configuration

5 Hardware Configuration

.1 Introduction

81199A User's Guide

This chapter provides guidance on how to configure your measurement
hardware.

There are many possible test hardware configurations. The system can
provide stimulus and / or analysis at the baseband IQ, IF or RF interfaces of
the Device Under Test (DUT).

We will describe one possible complete hardware configuration here, and
indicated where subsets and alternatives are possible. For further assistance
please contact product support.

Figure 12 introduces the hardware aspects of the example test system.

Controlling PC
(Could be Desktop, Laptop or Embedded)

g 3 M8190A Wideband AWG (I/Q Generation)
Wfm Data e s
& \I-I

8267D-520-016 (1/Q Modulation)

81199A Wideband
Waveform Center (WWC)

N5152A 5GHz/60GHz U.C.
3 j —

. N5183A-520 MXG (Tx LO)

DU
“"- N5183A-520 MXG (Rx LO)

-

A" N1999A 60GHz/5GHz D.C.

89601B Vector Signal
Analyzer

& & 58 DSO090804A Infiniium Real-time Oscilloscof

Figure 12. 81199A-based 60 GHz PHY test solution
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Stimulus

Digital IF Generation

Analysis

Test waveforms are downloaded from the 81199A software to an M8190A or
81180B wideband AWG where they are “played” to produce differential or
single-ended analog | and Q signals representing the signal as a baseband
(zero IF) modulation.

The I and Q signals can be fed directly to a baseband DUT or to the wideband
1Q inputs of an E8267D PSG Vector Signal Generator which can modulate the
baseband signals onto an IF carrier in the range 4 to 44 GHz. If the DUT has
an IF input in that range, then it can be driven by the PSG output.

If the PSG is set to generate a b GHz IF, then the signal can be fed to the IF
input of an N5152A 5 GHz / 60 GHz Up-Converter to produce a 60 GHz RF
stimulus.

It is also possible to perform the first [F modulation in software and use a
single channel M8190A to drive the N5152A directly, thus omitting the PSG.
This alternative is discussed in sections 5.4.1 and 5.6.

In the example configuration, an N5183A MXG Microwave Signal Generator
provides the local oscillator (LO) for the up-converter to determine which of
the 4 RF channels the final modulation is delivered to.

The output of the N5152A Up-Converter is a WR-15 waveguide bulkhead to
which a standard gain horn (SGH) can be attached for over-the-air stimulus of
the DUT. Alternatively a V281A WR-15 to 1.85mm adapter can be used to
implement a cabled connection to the DUT.

For analysis at 60 GHz, an N1999A 60 GHz / 5 GHz Down-Converter can be
tuned to the RF channel of interest by an LO. In the example configuration, an
N5183A MXG Microwave Signal Generator is used to provide the LO.

The input of the N1999A Down-Converter is a WR-15 waveguide bulkhead so,
as for the transmit side, either over-the-air or cabled connection to the DUT is
possible.
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The 5 GHz modulated IF output from the N1999A Down-Converter is digitized
directly by the 90000A/X series Infiniium real-time oscilloscope. Depending
on the chosen model of Infiniium oscilloscope, any IF up to 30 GHz can be
acquired. Alternatively, the oscilloscope can be configured to accept
differential or single-ended baseband 1Q signals directly from a baseband
DUT.

Digitized signal data from the oscilloscope is passed first to the 89601B VSA
software and then on to the 81199A software for modulation analysis.

h.2 Waveform Generation

Test waveforms created in 81199A can be mathematically “perfect” or have
quantified amounts of distortion, noise and other interferers added for test
purposes.

Test waveforms can be “played” on Agilent hardware to generate a physical
signal, or they can be saved to a file so that they can be, for example,
streamed into a simulated DUT modeled in another software tool such as
Agilent EESof SystemVue or MATLAB.

The Output Devices Tool Bar and the Current Output Device Settings window
select the active output device and its settings respectively.

5.2.1 81180B

81199A User's Guide

This section summarizes briefly how the 81180B can be used with the 81199A
software. For a full description of the configuration and functionality of the
81180B Arbitrary Waveform Generator please refer to the 81180B User's
Guide (P/N 81180-91020).
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Connecting the DUT

>

Settings

The relatively limited sample rate of the 81180B (for this application) means
that it can only be used to generate the baseband | and Q component signals.
The complex modulation of these signals onto a first IF must be performed by
an external hardware modulator such as the Agilent E8267D Performance
Signal Generator with option 016 (Wideband 1/Q inputs).

The 81199A software controls the 81180B by means of SCPI commands sent
over LAN, therefore the computer hosting the 81199A software and the
81180B must both be connected to the same LAN.

The LAN can be anything from a corporate network to a simple cross-over
cable connection. Refer to the LAN configuration section in the 81180A
User's Guide for more information.

The 81180B provides differential outputs. If the device to be connected has
differential baseband | and Q inputs then connect the 81180B Out 1 and /Qut
1 outputs to the device's |+ and |- inputs, and similarly connect the 81180B
Out 2 and /0ut 2 outputs to the device's Q+ and Q- inputs.

If the device to be connected has single-ended baseband | and Q inputs then
connect the 81180B Out 1 output to the device's | input and terminate the
81180B /0ut 1 output with a 50Q load. Similarly connect the 81180B Qut 2
output to the device's Q input and terminate the 81180B /0ut 2 output with a
50Q load.

The output signal quality will be degraded if the unused outputs are not
terminated properly.

To select the output device; on the menu, select Generate > Qutput Device
and choose "Agilent 81180B AWG".

If you have the older 81180A model, then you should choose "Agilent 81180A
AWG". This will ensure that the maximum sample rate is set to 4.2 GHz for
the 81180A rather than 4.6 GHz for the 81180B.

Once the output device has been selected, the Instrument Address and
Socket Port Number should be set in the Current Output Device Settings
window. Set the Instrument Address setting to the IP address of the 81180B
and set the port number to 5025.
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The 81199A software cannot control the 81180B over USB.

The Current Output Device Settings window also allows you to set the
required output configuration (coupling, amplitude, DC offset, skew etc.). The
81180B will be set to these values every time a waveform is downloaded.

52.2 M8190A

Sample Rate
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This section summarizes briefly how the M8190A can be used with the
81199A software. For a full description of the configuration and functionality
of the M8190A Arbitrary Waveform Generator product please refer to the
M8190A User's Guide (P/N M8190-91030).

The high sample rate of this product means that it is possible to generate a
complex-modulated first IF directly.

The maximum possible IF depends upon the selected mode (Speed or
Precision), the modulation bandwidth of the signal, and the 5 GHz analog
bandwidth of the M8190A output amplifier.

So, for example, an |IEEE 802.11ad signal could be modulated onto a 3.5 GHz IF
in Speed Mode, or a 2.0 GHz IF in Precision Mode.

The relatively low frequencies of these IFs makes image free up conversion
more challenging, but avoids the expense and imperfections of a hardware
modulator. This is described more fully in sections 5.4.1 and 5.6.
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Connecting the DUT

The M8190A is a modular product, typically hosted in a 2 or 5-slot AXle rack.

The M8190A must be controlled by a PC-based application that serves as the
product's firmware to provide a remote control interface that translates SCPI
commands to low-level hardware control. The M8190A firmware can reside
on an embedded controller in the same AXle rack as the M8190A module or
on an external PC connected to the AXle rack using a PCle extender cable.

The 81199A software controls the M8190A by means of SCPI commands sent
over LAN, therefore the computer hosting the 81199A software and the
computer hosting the M8190A firmware must both be connected to the same
LAN.

The LAN could be anything from a corporate network to a simple cross-over

cable connection. It is also possible for the 81199A and M8190A software to
reside on the same computer and communicate via the localhost (127.0.0.1)

IP address. Refer to the M8190A User's Guide for more information.

The M8190A provides differential outputs. If the device to be connected has
differential baseband | and Q inputs then connect the M8190A Channel 1
DIRECT OUT and /DIRECT OUT outputs to the device's I+ and I- inputs, and
similarly connect the M8190A Channel 2 DIRECT OUT and /DIRECT OUT
outputs to the device's O+ and Q- inputs.

If the device to be connected has single-ended baseband | and Q inputs then
connect the M8190A Channel 1 DIRECT OUT output to the device's | input
and terminate the M8190A Channel 1 /DIRECT OUT with a 50Q load.
Similarly connect the M8190A Channel 2 DIRECT OUT output to the device's |
input and terminate the M8190A Channel 2 /DIRECT OUT with a 500 load.

Warning: The output signal quality will be degraded if the unused output is
not terminated properly.

You may also (optionally) provide an external frequency reference to the REF
CLK'IN input.
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Settings A fully optioned M8190A (-12G, -14B and -DUC) has six distinct hardware
modes of operation.

In 81199A, for simplicity, each M8190A mode is treated as a logically separate
output device because the mode choice significantly alters the configuration
of the M8190A in terms of valid sample clock range, data precision and data
download format.

In addition, there is a mode in which the M8190A is configured to drive an
N5152A 5 GHz / 60 GHz up-converter. This particular hardware combination
is made considerably easier to configure and use by treating is as a special
case composite device.

So there are seven M8190A output modes listed as separate “devices”,

e Agilent M8190A AWG — Precision Mode (14 bit, 8 GHz)
o Agilent M8190A AWG — Speed Mode (12 hit, 12 GHz)
e Agilent M8190A/N5152A

o Agilent M8190A AWG — DUC Mode (x3 Interpolation)
o Agilent M8190A AWG — DUC Mode (x12 Interpolation)
e Agilent M8190A AWG — DUC Mode (x24 Interpolation)
o Agilent M8190A AWG — DUC Mode (x48 Interpolation)

If the M8190A does not have option DUC installed, only the first three modes
will be listed.

The digital up-conversion (DUC) modes (and specifically the x3 interpolation
mode) can support a maximum IQ sample rate of 2.4 GSa/s. This does not
quite meet the requirements for 802.11ad signal generation, so digital up-
conversion modes will not be considered further in this introduction.
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M8190A and 81199A
on the same PC

The most appropriate mode for 802.11ad signal generation is the Precision
mode, with up to 8 GHz sample rate and 14 bit sample resolution, so select
this as the output device. On the menu, select Generate > Qutput Device and
choose "Agilent M8190A AWG — Precision Mode (14 bit, 8 GHz)".

The special M8190A/N5152A mode is described separately in section 5.4.1.

Once the output device has been selected, the Instrument Address and
Socket Port Number should be set in the Current Output Device Settings
window. Set the Instrument Address setting to the IP address of the
computer hosting the M8190A firmware and set the port number to 5025.

The 81199A software cannot control the M8190A over USB.

The Current Output Device Settings window also allows you to set the
required output configuration (coupling, amplitude, DC offset, skew etc.). The
M8190A will be set to these values every time a waveform is downloaded.

As mentioned above (Connecting to the 81199A software) the 81199A and
M8190A software may reside on the same computer and communicate via the
localhost (127.0.0.1) IP address.

In this configuration, where two applications are sharing the same computer
and hence the same LAN interface, it is important to understand the role of
LAN socket ports, especially if you wish to programmatically control the
81199A software using SCPl commands.
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Agilent instruments and remotely controllable applications, by default, listen
on LAN socket port 5025 for SCPI commands.

When the M8190A firmware is started it will take ownership of LAN port 5025
unless another application has already claimed the port.

If another application has possession of port 5025, then the M8190A software
will have no SCPI access via sockets, and consequently the 81199A software
(or any other application that uses SCPI over sockets) will not be able to
connect to the M8190A.

Ironically, the most likely application to prevent the M8190A from using port
5025 is the 81199A software itself.

In anticipation of being remotely controlled the 81199A will also, by default,
take ownership of LAN socket port 5025 for SCPI commands, if the port is
available.

This is why, in this shared computer configuration, the M8190A firmware
must be started before the 81199A software. This sequence ensures that the
MB8190A firmware gets port 5025 and hence is controllable by 81199A.

81199A Remote If you wish to remotely control the 81199A software in a shared computer

Control configuration, then you must move the M8190A to a different socket port so
that the 81199A can claim port 5025 for SCPI control. This is achieved by
means of an M8190A command line switch. For example, to change to socket
port 5022, run the M8190A firmware using the command line,

AgM8190Firmware.exe /s 5022 /t-1 /i -1

The full list of M8190A firmware command line switches is given on page 92
of the M8190A User's Guide (P/N M8190-91030).

You must also configure the alternative socket port number into the 81199A
software by entering the new value as the Socket Port Number setting in the
M8190AP and/or M8190AS Current Output Device Settings windows.
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5.2.3 File Output

If the current output device is set to "File (csv, binary or matlab)" then the
generated waveform data can be saved to a file on the host computer.

For file data, the maximum sample rate is not limited by hardware, so for
internal coding purposes a nominal limit of 5 GHz is set. Within this limit, the
auto sample rate algorithm will choose the most appropriate sample rate for
the generated waveform. If a higher sample rate is needed, then this nominal
limit can be over-ruled by using the manual sample rate setting.

The output files are unencrypted and can be formatted in various ways to
facilitate their import into other Agilent and non-Agilent tools.

Output to all supported Agilent AWGs is standard as part of 81199A option
001 functionality but file output is separately licensed as 81199A option DFP.
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5.3 Waveform Acquisition

81199A User's Guide

When underpinned by Agilent’s 89601B Vector Signal Analyzer application,
the 81199A application also provides comprehensive standards compliant
modulation and coding analysis of physical signals acquired at baseband, IF or
RF. It can also analyze synthesized or pre-recorded signals read from file, to
permit use in a simulation environment.

The 81199A software always takes its data for analysis from the subordinate
instance of the 89601B Vector Signal Analyzer software in order to
immediately take advantage of the wide range of acquisition platforms already
supported by that tool.

So the waveform acquisition mechanism is configured in the 89601B, the
acquired calibrated time records are extracted from the 89601B into 81199A
using the 89601B's COM-based API.

Currently the only Agilent products with sufficient acquisition bandwidth to
capture a very wideband modulated signal in real time are members of the
Agilent range of Real-Time Oscilloscopes.
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5.3.1 90000A Series Oscilloscope

Connecting the DUT

Differential
connection using
probes

The Agilent Infiniilum 90000A Series real time oscilloscopes can be used to
acquire complex baseband (I + jQ) or modulated IF signals.

The 90000A Series oscilloscope range offers a variety of bandwidths and the
right choice depends on the DUT configuration.

For complex baseband acquisition only, an entry level model (2.5 GHz) is
sufficient. If you also want to acquire the 5 GHz IF from the N1999A 60 GHz /
5 GHz block down-converter, then the DSO 90804A is recommended.

To acquire IF signals at higher frequencies then the carrier frequency and
modulation bandwidth will determine the appropriate model.

If the device to be connected has single ended baseband | and Q outputs then
connect the device | output to the 90000A series Channel 1, and connect the
device Q output to Channel 3. In the 81199A Acquisition Settings window set
Channel Config to | and Q Baseband Inputs.

If the device to be connected has differential haseband | and Q inputs then
you have two choices.

You can use probe amplifiers fitted with differential probe heads such as the
1169A / N5380A combination, in which case the 81199A configuration is the
same as for single ended operation because the probes convert the
differential signals to single ended signals into the oscilloscope.



Differential
connection using
cables
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Or you can use the differential input capability of the oscilloscope. The
configuration of the equipment is a little more complicated and has some
documented limitations, but it permits a simpler connection to the DUT.

First connect the device to the 90000A series oscilloscope as follows,

e Device I+ output to oscilloscope Channel 1,
e Device |- output to oscilloscope Channel 3,

e Device 0+ output to oscilloscope Channel 2,
e Device Q- output to oscilloscope Channel 4.

In the 81199A Acquisition Settings window, select the Advanced tab to reveal
the 89600 State setting and set it to Visible. This will make the GUI of the
underlying 89601B VSA instance visible.

The 89601B VSA GUI is usually hidden because, in general, making changes
to the 89601B settings directly will create conflicts with the 81199A state;
however, there are some advanced settings which can safely be changed.

On the 89601B VSA GUI, select Input > Channels > Custom. The dialog box
should show that VSA Logical Channel 1 is enabled, the operator should be
I+jQ and Inputs 1 and 2 sources should be shown as Ch1 and Ch3
respectively. This is the default setting for the 1+jQ channel configuration.

Use the drop-down list to change Input 2 to come from Ch2. (rather than Ch3)
and click OK.

On the 89601B VSA GUI, select Input > Extensions and double-click on the
UserSCPIPreset text field. In the dialog box, enter

:CHAN1:DIFF ON;:CHAN2:DIFF ON

and click OK.

This will sent the SCPI command string to the oscilloscope, which will have
the effect of putting channels 1 and 2 into differential mode so that Ch1 =
Ch1-Ch3 and Ch2 = Ch2-Ch4. You can confirm that the oscilloscope is in the
correct mode by noting that channels 1 and 2 are active and are labeled on
screen as [1-3] and [2-4] (rather than [1] and [2]).
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These settings will be retained by an 81199A setup save/recall and will not
be reset unless you change the Channel Config setting in the 81199A
software.

There are known limitations with this configuration,

1. The overload indicator in the 81199A / 89601B will not be accurate.

2. The input ranges on the scope channels used to form the differential
channel are coupled and cannot be set independently.

3. The differential hardware channel from the scope cannot be explicitly
assigned to a particular VSA channel.

4. Channel triggering occurs on a non-differential scope channel and not
on the differential channel.

The oscilloscope is not connected directly to the 81199A software; instead it
is configured in the 89601B VSA software.

Setting up and using the Infiniium Oscilloscope is described in the application
note Agilent Infiniium Oscilloscopes with 89600B VSA Software (P/N 5990-
6819EN).

The 81199A software will look for and run an instance of the 89601B VSA
software, which, in turn, will connect to the configured hardware (which may
be any device of sufficient bandwidth that is supported by the 89601B VSA
software, not just oscilloscopes).

If you recall an 81199A setup file, then a matching 89601B setup file will be
recalled at the same time.

5.3.2 90000X Series Oscilloscope

The Agilent Infiniium 90000X Series real time oscilloscopes can be used to
acquire complex baseband (I + jQ) or modulated IF signals. In particular, to
acquire IF signals at frequencies beyond the range of the 90000A series
oscilloscopes.

The IF carrier frequency and modulation bandwidth will determine the
appropriate model.
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Connecting the DUT  The options for connecting to the DUT are the same in principle as for the
90000A series oscilloscopes.

Because of the frequency range of the 90000X series oscilloscopes, the probe
connectors on the front panel are 3.5mm threaded RF connectors instead of
the precision BNC connectors on the 90000A series and consequently the
probe accessories are also different.

However, for lower frequencies, the N5442A BNC adapter can be used to
simplify the connection of BNC probes and cables.

Connecting to the The oscilloscope is not connected directly to the 81199A software; instead it
81199A software is configured in the 89601B VSA software.

Setting up and using the Infiniium Oscilloscope is described in the application
note Agilent Infiniium Oscilloscopes with 89600B VSA Software (P/N 5990-
6819EN).

5.3.3 File Input

The 89601B VSA software can read data from "recordings”, which are simply
data files containing sampled baseband or IF waveforms.

As a consequence, the 81199A can also analyze data from a file.

These signal data could have come from alternative acquisition hardware, or a
previous recording taken with Agilent hardware. They could also be the
output of a device simulation in Agilent EESof SystemVue or MATLAB, or
from an 81199A generated waveform file.
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5.4 RF Modulation and Up-Conversion

vector modulation

up-conversion

@

In the example hardware configuration we have used the E8267D PSG Vector
Signal Generator fitted with option 016 (Wideband External |/Q Inputs) to
modulate the complex | + jQ signals from the M8190A onto a first IF.

Depending on the chosen frequency range option of the E8267D, this first IF
can be at any frequency from 3.2 GHz to 44 GHz

The recommended drive level for the E8267D wideband 1/Q inputs is 0 dBm.

For an IEEE 802.11ad single carrier modulation this level can be achieved by
selecting the M8190A DC amplifier output, driving the E8267D differentially,
and setting the M8190A output amplitude to 820mV.

For further information about the E8267D PSG please consult the data sheet
(P/N 5989-0697EN).

If the E8267D PSG or an equivalent vector modulator is set to produce a first
IF at 5.0 GHz then the N5152A 5 GHz / 60 GHz Up-Converter can be used to
translate the signal to the 60 GHz band.

To deliver the best CW performance, the PSG employs band filtering, which
unfortunately introduces a gain slope when modulating a very wideband
signal onto a 5 GHz carrier. However, you can easily force the PSG firmware
to select the next overlapping filter band (which has a much flatter response)
by incrementing the RF frequency by 1 Hz to 5.000000001 GHz.

The center frequency of the up-converter output is determined by the local
oscillator frequency according to the equation

Fro = (Fenan — 17.5 GHz) / 4.0
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For the ITU approved 60 GHz channelization, the LO frequencies are as listed
here,

e Channel 1: FC = 58.32GHz, FLO = 10.205 GHz
e Channel 2: FC = 60.48GHz, FLO = 10.745 GHz
e Channel 3: FC = 62.64GHz, FLO = 11.285 GHz
e Channel 4 : Fc = 64.80GHz, Fo = 11.825 GHz

In the example configuration, for maximum flexibility, the LO is provided by an
N5183A MXG Analog Signal Generator, however any low phase noise 10 GHz
to 12 GHz source will serve this purpose.

A procedure for configuring the operating point of the N5152A to maximize
signal to noise ratio and minimize signal distortion is described in the N5152A
manual (P/N N5152-90001).

541 The M8190A/N5152A Special Mode

For reasons explained in section 5.6, the M8190A output driver provides a
special mode which configures the 81199A software and M8190A to produce
a digitally modulated first IF at 5 GHz that is suitable for direct connection to
an N5152A 5 GHz / 60 GHz wideband up-converter.

We will describe here only how to test this special mode in loopback for
verification purposes. To use the mode in practice, you should use the same
up-converter / down-converter setup as is described in the preceding

sections.
Configure the The M8190A provides differential outputs. In this mode we are using the
Hardware Direct output single ended so connect the M8190A Channel 1 DIRECT OUT to
oscilloscope channel 1. Terminate the M8190A Channel 1 /DIRECT OUT with
a 50Q load.
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Evaluate the Signal

Drag and drop Segment 1 from the Segment Library into the Waveform Layout
window by clicking on the colored box numbered 1. This action will cause the
802.11ad Segment 1 settings list to appear in the Settings Window on the left.

Accept the segment 1 default settings.

On the menu select Generate > Generate and Output, or click the Tool Bar
Generate and Output button.

In the Acquisition Settings window, click the "Basic" button to select the
simpler settings list, then change (if necessary) the settings to,

e Channel Config : 1 Channel (always change this setting first because
it resets the center and span values)

e Center:5.000 000 000 GHz

e Span:2500000 000 GHz

e Points: 102,401

e  Mirror Freq: True

e Main Length : 40.000000000 ps

Mirror frequency is set to True because the signal we are receiving in this
special mode is the lower side-band modulation image around the sampling
clock, which is spectrally inverted.

To enable IEEE 802.11ad demodulation, set Demod On to True in the 802.11ad
Demodulation Settings window.

To see the initial demodulation analysis results, select any of the
Measurement Results windows, right mouse click on the window tab or on
the title of the currently displayed measurement result, and select 802.11ad
Error Summary from the drop-down menu.
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Figure 13. Initial 802.11ad Error Summary for M8190A/N5152A Mode

The signal has been correctly identified as an MCS1 packet and the EVM is
reported as 2.03%. As was discussed in section 4.10, if the EVM is worse
than expected examine the 1Q constellation for clues. A common cause of

poor EVM is symbol clock error.

If we look at the 802.11ad channel frequency response we see that the
generated signal is not quite flat. This can be addressed by using pre-

corrections.
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Figure 14. Raw Channel Response in M8190A/N5152A Special Mode

To pre-correct the non-flatness, in the Final Waveform Settings window
configure the following settings

e (Calibration Mode : Cal On Every Download
e (Calibration Center Frequency : 5.000000 GHz

and click the Generate and Output button. Once the calibration procedure has
generated satisfactory channel response and IQ imbalance results, click the
Yes button to compute and apply the corrections and download the waveform
to the M8190A.

You may find that applying pre-corrections appears to slightly degrade the
EVM (on the test setup, the EVM grew from 2.03% to 2.16%). This can
happen if the pre-corrections filter has had to alter the overall transmitted
power in order to correct the non-flatness. In this case you should re-
autorange the receiver by clicking the autorange button in the top right of the
toolbar.

On the test setup, this improved the measured EVM to 1.93% and the channel
response is now flat to within a few tenths of a dB.

Another point of note is that in this mode, you can see from Figure 15 that the
estimated SNR and the EVM have almost the same magnitude (ignoring the
sign difference) which suggests that in this mode the EVM performance is
noise limited to around 2%.
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Figure 15. Final 802.11ad Error Summary for M8190A/N5152A Mode
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Figure 16. Corrected Channel Response in M8190A/N5152A Special
Mode

b.b Down-Conversion

For intermediate frequencies up to 30 GHz, the signal can be digitized directly
by the appropriate choice of Infiniium oscilloscope.

For signals in the 60 GHz band, the N1999A 60 GHz / 5GHz down-converter
can be used to translate the signal down to a common IF of 5 GHz, which can
be digitized by, for example, a DS090804A oscilloscope.

The local oscillator frequency is determined by the desired center frequency
of the down-converter input according to the equation

FLo = (Fenan — 5 GHz) / 4.0.
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For the standard 60 GHz channelization, the LO frequencies are as listed here,

e Channel 1: Fcuan = 58.32GHz, Fro = 13.33 GHz
e Channel 2 : Fcuan = 60.48GHz, Fio = 13.87 GHz
e Channel 3 : Fcuan = 62.64GHz, Fo = 14.41 GHz
e Channel 4 : Fcuan = 64.80GHz, Fro = 14.95 GHz

In the example configuration, for maximum flexibility, the LO is provided by an
N5183A MXG Analog Signal Generator, however any low phase noise 13 GHz
to 15 GHz source will serve this purpose.

A procedure for configuring the operating point of the N1999A to maximize
signal to noise ratio and minimize signal distortion is described in the N1999A
manual (P/N N1999-90001).
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5.6 Digital IF Generation

Hardware generation If your M8190A includes the digital up-conversion (DUC) option then you can
configure the M8190A to modulate the complex baseband (1Q) waveform data
from 81199A onto an arbitrary IF carrier.

This capability has two key advantages.

1. The modulation is performed digitally in hardware using carrier values
generated by a highly agile hardware synthesizer. The resulting
modulated signal is not only free of the many impairments typically
associated with analog vector modulation, but its amplitude, phase
and frequency can be switched with great precision in real time.

2. The 81199A need only generate waveform samples at the modulation
symbol rate, leaving the M8190A to interpolate the data in hardware
(by the selected factor) prior to digital modulation. This can
significantly reduce the amount of waveform data that needs to be
downloaded, and makes more efficient use of the sample memory.

However, in DUC mode, the DAC rate is limited to a maximum of 7.2 GSa/s
and the minimum interpolation factor (which necessary to avoid aliasing) is 3.
This means that the maximum modulation sample rate supported is 7.2 / 3 =
2.4 GSa/s.

For modulations with sample rates up to 2.4 GSa/s, DUC mode is the best
solution.

When the 81199A software is in Precision or Speed mode, the real part of the
complex waveform is downloaded to M8190A channel 1, and the imaginary
part is downloaded to M8190A channel 2.

When the 81199A software is in one of the DUC modes, the real and
imaginary parts of the complex waveform are time interleaved and
downloaded to M8190A channel 1. The same interleaved data is then also
downloaded to M8190A channel 2 (if it is installed). Since the digitally
generated IF can have a different frequency in each channel it is possible to
output the same signal on two different IFs.

These default behaviours can be modified by altering the Download to...
settings in the Current OQutput Device Settings window.



Hardware Configuration

Software Generation The 81199A software can be configured to offset (from zero) the center
frequency of each track by software modulating the track waveform data.

This capability is intended to permit the creation of a single baseband
waveform that contains multiple narrower-band modulations at different
offset frequencies within the composite waveform’s bandwidth

Software modulation is achieved by setting the Track <n> Offset Frequency in
the Final Waveform Settings window to a non-zero value, subject to the
limitation,

Maximum Offset = (Max Sample Rate / 2.56) — (0.5 x Occupied Bandwidth)

Using an M8190A, even in 12 GHz sampling "Speed Mode", the maximum
recommended offset for a 2 GHz occupied bandwidth modulated signal is
about 3.69 GHz.

Maximum Offset = (12 GHz / 2.56) — (0.5 x 2 GHz) = 3.69 GHz

Also, remember that, signal energy is not only present at Forr. Due to
sampling, there is also signal energy at (Fs + Forr, 2Fs * Forr, and so on).
Normally these sampling images are removed by a low-pass reconstruction
filter but they must be considered when setting offset frequencies to ensure
that no aliasing occurs.

@ The track frequency offset capability is not intended to permit the creation of
a modulated signal that has no spectral content near DC (e.g. so that the |
channel output only could be used directly as an IF signal).

This is because the pre-corrections calibration procedure, which is applied to
the final composite waveform, always corrects the entire baseband
bandwidth. Hence the pre-corrections calibration signal always extends from
—Fs/2 to +Fs/2 and must be applied prior to any conversion to an IF or
aliasing will occur.
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We have already noted that the M8190A hardware DUC modes are unsuitable
for 802.11ad up-conversion, and here we have also determined that track
offsets cannot be used to modulate an 802.11ad signal on to a first IF in
software if pre-corrections are required.

Fortunately, the M8190A output driver provides a special mode which
addresses these concern by forcing a waveform generation sample rate of 3
GHz, applying software up-conversion (after pre-correction filtering) to a fixed
IF of 1.67 GHz then using the M8190A in doublet mode at a sample rate of
6.67 GHz to produce a first IF at 5 GHz (the lower sideband of the 1.67 GHz
images around Fs)

This signal is spectrum inverted and is not image free, however, the N5152A
also contains a spectrum inversion due to a high-side mix and a band-pass
filter which will remove the unwanted images, thus giving the desired signal
in the 60 GHz band
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6.1 Introduction

This chapter describes the functions available via the main 81199A menu.

6.2 File

The file menu allows you to save and open configuration setups, load
recordings, and print measurement result screens.

6.2.1 Save Setup

To save the current 81199A setup select File > Save Setup and enter a name
for the setup save files.

The save setup process creates three files which together constitute the
saved state of the application,

o <filename>.wwcsetup
o <filename>.wwcsetup.89600.settings

e <filename>.wwcsetup.window.settings

In the file dialog you only name the <filename>.wwecsetup file, the other two
are automatically named and created.
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6.2.2 Open Setup

To open and restore a saved 81199A setup, select File > Open Setup and
select the required .wwecsetup file.

The saved setup comprises three files which together constitute the saved
state of the application,

o <filename>.wwcsetup
o <filename>.wwcsetup.89600.settings
e <filename>.wwcsetup.window.settings

In the file dialog you only select the <filename>.wwcsetup file; the other two
are automatically identified.

6.2.3 Preset Setup

To load the preset setup, which returns all the 81199A settings to their
default state, select File > Preset Setup.

6.2.4 Auto-Load Last State

If this menu item has a check mark beside it, then the 81199A software will
save its state when it is closed and will use this saved state when it is next
run, to automatically resume with the same settings.

The check mark can be toggled on and off by selecting File > Auto Load Last
State.

In general, this feature should not be used if you intend to make hardware
configuration changes between runs, as the recalled state may no longer be
appropriate.




Menu

6.2.5 Open Recording

When the 81199A analysis option is enabled (option 002) it is possible to use
the underlying 89601B VSA software to read data from recording files and
analyze them as if they were a live signal.

Recordings are files containing sampled baseband or IF waveform data.

They can be data captured by the same or alternative acquisition hardware, at
an earlier time or different location.

They can be the output of a device simulation in Agilent EESof SystemVue or
MATLAB, or from an 81199A generated waveform file.

Recordings are useful for many purposes. For signal archiving, regression
testing, and in providing debug assistance by permitting remotely located
experts to analyze recordings of problem signals.

To open a recording select File > Open Recording and select the recording
file.

The supported file types are defined by the 89601B VSA software, Currently
the following types are supported,

e (CSV (comma delimited ASCII), *.csv

e [E3238S Time Snapshot, *.cap

e MAT-file (MATLAB), *.mat

e MAT-file (MATLAB Version 4), *.mat

e MATLAB HDF5, *.mat, *.hdf, *.h5

e N5106A Waveform (streaming data), *.bin

e Nb5110A Waveform, *.bin

e SDF (Fast or Export), *.sdf, *.dat

o Text (Tab delimited ASCII), *.txt types of file

Please refer to the topic "Supported File Formats" in the 89601B online help
documentation for more information.
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6.2.6 Print

The printing related menu items are only enabled when the user selects one
of the Measurement Display windows.

Having selected a Measurement Display window the contents can be printed
by selecting File > Print.

Only the contents of the selected Measurement Display window will be
printed.

9 Settings windows and Waveform Generation windows cannot be printed.

6.2.7 Print Preview

Having selected a results window, the image that will be sent to the printer
can be previewed by selecting File > Print Preview.

6.2.8 Page Setup

Select File > Page Setup to configure the paper size, orientation and margins
of the printed image.

6.2.9 Print Setup

Select File > Print Setup to configure the printer settings.
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6.2.10 Exit

Select File > Exit to close the 81199A application. This will also terminate the
associated instance of the 89601B VSA software if it is running.

6.3 View

The View menu allows you to choose whether certain tool and status
information is visible on the 81199A GUI.

6.3.1 Tool Bar

The Tool Bar, if visible, appears at the top of the window, just under the menu
bar. It contains icon buttons to access the most commonly used 81199A
functions.

If this view menu item has a check mark beside it, the main Tool Bar will be
visible.

The check mark can be toggled on and off by selecting View > Tool Bar.

6.3.2 Status Bar

The Status Bar, if visible, appears at the bottom of the window and reports
the status of the remote control ports that the 81199A software can support.

If this menu item has a check mark beside it, then the status bar will be
visible.

The check mark can be toggled on and off by selecting View > Status Bar.
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6.3.3 Performance Information

If this menu item has a check mark beside it, then additional performance
diagnostic information will be visible in the Tool Bar.

The check mark can be toggled on and off by selecting View > Performance
Information.

6.4 Generate

The Generate menu allows you to specify the output device, generate
waveforms and output them to the selected device, and to compute pre-
corrections to compensate for hardware imperfections.

6.4.1 Output Device

Select Generate > Output Device to choose the output device. The supported
output devices are,

e Agilent M8190A AWG — Speed Mode (12 bit, 12 GHz)

e Agilent M8190A AWG — Precision Mode (14 bit, 8 GHz)

e Agilent M8190A/N5152A

e Agilent M8190A AWG — DUC Mode (x3 Interpolation)

e Agilent M8190A AWG — DUC Mode (x12 Interpolation)

e Agilent M8190A AWG — DUC Mode (x24 Interpolation)

e Agilent M8190A AWG — DUC Mode (x48 Interpolation)

o Agilent 81180A AWG

e Agilent 81180B AWG

e File (csv, binary or matlab) (requires 81199A option DFP)

If the software is preset then the default device will be the one that supports
the highest sample rate.
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6.4.2 Generate and Output

Select Generate > Generate and Output to download the waveform to the
selected output device.

For AWG output devices, the download is executed immediately, subject to
the 81199A software being able to communicate with the selected AWG. If
the software is unable to find the AWG, then, after a timeout period, it will
report an error.

For file output, the waveform will be saved to the file specified on the Current
Output Device window under Waveform File Name (overwriting any previous
content). If no filename has been specified in this setting, then a File Save
dialog will open for you to enter a file name.

6.4.3 Generate and OQutput As...

This menu item is only relevant to file output.

Select Generate > Generate and Output As... to save the waveform using the
File Save dialog so that you have the opportunity to rename the waveform
data rather than simply overwriting the previously named file.

6.4.4 Generate User Defined Pre-Corrections

81199A User's Guide

This menu item is intended for expert users who wish to pre-compute
calibration data using the fully configurable version of the pre-corrections
algorithm that is more typically enabled and used via the Calibration Mode
setting in the Final Waveform Settings window.

The user-defined pre-corrections generation procedure is described in section
12.8
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6.5 Measure

The Measure menu controls the 81199A measurement functions.

6.5.1 Start Measurement

Select Measure > Start Measurement to start the measurement processes.

The 81199A software will acquire a time record from the 89601B VSA
software and pass it to each of the active demodulators (there can be more
than one active at the same time) for analysis. Then it will gather the
demodulation results from each of the active demodulators, perform any post
processing required for presentation (such as units conversion) and display
the results.

If measurement is configured for continuous operation, then the software will
repeat this process until instructed to stop.

6.5.2 Stop Measurement

Select Measure > Stop Measurement to stop the measurement processes.

6.5.3 Continuous / Single Measurement

Measurement can be configured for continuous operation (started by
Measure > Start Measurement and stopped by Measure > Stop
Measurement), or for single-shot operation (started by Measure > Start
Measurement and stopping automatically after a single acquisition,
demodulation, post-processing and display cycle).




6.5.4 Auto-Range

Menu

Select Measure > Auto-Range to automatically adjust the oscilloscope input
range setting for maximum sensitivity.

6.6 Windows

The Windows menu allows you to select which tool and document windows
are visible and which window has focus.

The default windows layout can be recovered by selecting File > Preset Setup,
but beware that this will reset everything else as well.

6.6.1 Close All Document Windows

The 81199A Graphical User Interface (GUI) contains two distinct types of
window; tool windows and document windows.

Tool windows cannot be closed because, in general, they contain important
information such as settings (they can, however, be auto-hidden).

Document windows can be closed because, in general, they are used to
present results and you may wish to remove unused result windows. (They
can always be re-instated from this menu).

Select Windows > Close All Document Windows to close all the Document
windows.

Any docking panel containing a tool or document window can be made
permanently visible by clicking on the push-pin icon (on the right of the title
bar) so that it is vertical, or made to auto hide by clicking the push-pin icon so
it is horizontal. Any docking panel containing only document windows can
also be closed, however if the panel contains one or more tool windows it can
only be put into auto-hide mode, it cannot be closed.

81199A User's Guide
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6.6.2 Windows List

The exact list of windows depends on the installed options.

6.7 Help

The Help menu allows you to access various forms of assistance.

6.7.1 User's Guide

Select Help > User Guide to access a PDF version of this User Guide.
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6.7.2 SCPI Command Reference

81199A User's Guide

Select Help > SCPI Command Reference to access an HTML format listing of
the programming syntax for all the SCPI remote control commands recognized
by the 81199A software.

All functions of the 81199A are remotely controllable so that the operation of
this software can be fully automated.

Any programming environment that permits the user to send ASCII strings to
a LAN or USB destination can be used.

Here is a very simple MATLAB script to illustrate the idea,

t = tcpip('localhost', 5025);

fopen(t);

fprintf(t, "*RST");

fprintf(t, '*IDN?");

reply = fscanf(t);

sprintf('You are talking to: %s', reply);
fprintf(t, 'SOUR:TRACK1:SLIS:ADD AD,1');
fprintf(t, 'SOUR:RAD:AD1:MCS 6');
fprintf(t, 'SOUR:RAD:AD1:LEN:NCPH 2000');
fprintf(t, 'SOUR:RAD:AD1:CONT PN23');
fprintf(t, 'OUTP:NOIS:CNR 30DB');
fprintf(t, 'OUTP:NOIS:STAT ON');
fprintf(t, 'OUTP:DEV:SEL M8190AP');
fprintf(t, 'OUTP:M8190AP:ADDR "192.168.1.101"");
fprintf(t, 'OUTP:DEV:RUN"');

fclose(t);
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6.7.3 Show Startup Warnings

If this menu item has a check mark beside it, then startup warnings (if any)
will be shown.

The check mark can be toggled on and off by selecting Help > Show Startup
Warnings.

When 81199A starts up it checks whether certain software is installed
correctly and it will warn you if they are not. If you disable this menu item
these warnings will not be shown.

6.7.4 About

Select Help > About to access the About box. This dialog box has four tabs,

e Detailed Version Information : This tab lists the full version number,
location, date and source of every software module used by the
application. This is mainly intended for support purposes.

e Startup Messages : This tab lists the messages that were posted by the
software during system startup. This is the same list of messages as
appears in the scrolling status window of this splash screen.

e System Information : This tab lists the current value of the system
properties that are important to the software. This is mainly intended for
support purposes.

e Licenses: This tab lists all of the currently valid Agilent software licenses
present on the host computer and their expiry dates. This will also include
licenses for other Agilent products, if present.




Tool Bar

.'o;o°. 7 Tool Bar
-0 0 @ Q@o-.
.‘...

7.1 Introduction

This chapter describes the 81199A Tool Bar.

The Tool Bar contains icon buttons to access the most commonly used
81199A functions. It also provides status information relevant to the
measurement processes.

7.1.1 Action Buttons

| Generate and Cutput This button is equivalent to selecting Generate > Generate and Output on the
menu.

-

| Stark This button is equivalent to selecting Measure > Start Measurement on the
menu.

i
||

b,

(®) 5top This button is equivalent to selecting Measure > Stop Measurement on the
menu.

» > The two states of this toggle button are equivalent to selecting Measure >
L or— . .
Continuous Measurement or Measurement > Single Measurement menu on
the menu.
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7.1.2 Measurement Status

Measurement Funning : demodulating. ..

The measurement status display reports the current status and, where
appropriate, the sub-status, of the analysis cycle. The possible status
messages are tabulated below,

Measurement Running...

Measurement Running : waiting for trigger...
Measurement Running : acquiring data...
Measurement Running : acquisition done.
Measurement Running : reading data...
Measurement Running : no data, reacquiring...
Measurement Running : demodulating...
Measurement Stopping...

Measurement Stopped

Loading Recording...

Recording Loaded

7.1.3 Performance Information

[acg demod post disp] |III.3E- updates)sec
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The 81199A analysis software cycles through up to four states; acquisition,
demodulation, post-processing and display.

The performance information indicators illustrate subjectively how much time
the software is spending in each activity as well as giving an overall
measurement update rate. The indicators are optional and controlled by the
View > Performance Information menu toggle.

@ The 81199A software will use multiple-CPU cores where they are available so
it is possible for more than one of the state indicators to be active
simultaneously.




Tool Bar

7.1.4 Overload Indicator

OVERLOAD (1) This indicator normally shows as a hyphen at the right end of the status
display part of the Tool Bar and changes to the word OVERLOAD! if the
89601B VSA software reports a signal overload condition.

Zoomed:False

The mnemonic OV also appears in the top-right corners of the Main Time and
Spectrum displays to mimic the similar indicator in the underlying 89601B
VSA instance.

oV

To manually adjust the acquisition device for maximum sensitivity, adjust the

input range until the overload indicator comes on and then increase the range
by one or two setting positions from there (so that the indicator remains off).

This is essentially the procedure that the Auto-Range button automates.

@ The overload indicator will only indicate an overload on the acquisition device.
It will not detect overload conditions in the RF or IF stages of any down
conversion hardware that is being used.

7.1.5 Auto-Range Button

fAuto-F.ange This button automatically adjusts the acquisition device (oscilloscope) input
range setting for maximum sensitivity.

7.1.6 Full Screen Button

= Full Screen This is a toggle button that maximizes the available screen space by

- expanding the main window content to occupy the full screen. This has the
effect of temporarily hiding the menu bar, which is why this function is only
available on the Tool Bar and not in the menus.

71.1.7 Help Button

&3 This button is equivalent to selecting Help > User's Guide... on the menu.
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8.1 Introduction

This chapter describes the 81199A Status Bar.

The Status Bar reports the status of the remote control ports that the 81199A
software can support.

8.1.1 Remote Interface States

81199A software can be remotely controlled over GPIB, LAN, or USB
interfaces and the LAN interface can support sockets and telnet sessions.

There is an icon for each of these possibilities in the status bar.

If an icon is greyed out then that interface is not available. If it is not greyed
out then that interface is available. If it is highlighted with a green
background, then that interface is ready and can accept remote control
commands.
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Window Management and
Manipulation

9 Window Management and
Manipulation

9.1 Introduction

This chapter describes the docking panel window system that is used in the
81199A software to provide considerable flexibility in configuring the user
interface and, in particular, organizing the display of measurement results.

9.2 Overview

81199A User's Guide

The 81199A docking panel system allows windows to be arranged in arbitrary
positions within the main window and to be un-docked from the main window
and shown as separate floating windows.

The following description describes the default screen layout for a fully
optioned installation of the 81199A software.

Certain docking panels and windows will be automatically omitted from the
layout if the necessary software option licenses are not available. Also,
screen layouts are remembered as part of a saved setup, so your screen might
look quite different to the defaults described here.

When the software first starts up you should see a window that looks
something like Figure 17.
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Settings Windows

Generate Windows

Measure/Windows

Figure 17. Default screen layout for a fully optioned installation.

Docking Panels

In the default layout (for a fully optioned installation), the main window is
divided into three zones; settings, generate and measure.

Each of these zones contains a number of docking panels.

Docking panels provide a hierarchical mechanism for arranging the content of
the main application window. They are essentially containers for a collection
of windows.

Within a docking panel, windows may be arranged in a stack (with tabs) or
tiled, whichever is more appropriate for the window content.

Individual windows may be dragged and dropped from one docking panel to
another.

Docking panels and individual windows may be switched into floating
windows, separate from the main application window.
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9.3 Settings Values

The Settings Windows contain grouped lists of settings fields.

There are a number of ways to enter a specific numeric value in a settings

field.
Explicit value and The value and units can be entered explicitly. For example, if you want to
units enter a frequency of 9.2 GHz, you can enter “9.2 GHz". If you enter units this

way, they are expected to be correctly cased Sl units. So, for this example, the
units would have to be “GHz" not “gHz" or “ghz".

Abbreviated units If you want to enter engineering values quickly, you can abbreviate the unit
multiplier. For example, entering “9.2g" will be converted to “9.2 GHz"
(assuming the setting is a frequency), and “1.2m" will be converted to “1.2
mV" if the setting is a voltage.

81199A settings fields understand the following abbreviations,

“p"” for pico (10-12)

"n" for nano (10-9)

“u” for micro (10-6)

“m” for milli (10-3) — this must be a lower case m.
“k” for kilo (103)

“M" for Mega (106) — this must be an upper case M.
“G" or “g” for Giga (109)

Default units If you enter a value without any units, it is assumed to be in the “base” unit,
for example, if you are entering a frequency and you simply enter “20", this is
interpreted as “20 Hz" even if the current value is something like “10 MHz".

You can also step most values up and down using the mouse wheel. You can
also reset a value, or set it to its min or max value by right clicking over the
setting name.
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9.4 Settings Windows

B fixed
H auto hide

In the Settings Windows area, there are four docking panels, two of which are
"pinned" and therefore permanently visible, and two are in Auto Hide mode
so they normally only show as tabs at the edge of the main window.

When you move your cursor over the tab of an auto-hidden window it un-
hides and pops out.

Any docking panel can be made permanently visible by clicking on the push-
pin icon (on the right of the title bar) so that the pin is vertical, or made to
auto hide by clicking the push-pin icon so it is horizontal.

The normally auto-hidden docking panels in the Settings Windows zone are
the Window Explorer and the Errors, Warnings and Information panels. We
will focus here on the two visible docking panels.

0Of the two visible docking panels one, in the upper half of the zone, is
intended as a container for waveform generation related settings windows,
and contains three dockable windows,

e <currently selected> Segment Settings,
o Final Waveform Settings,
e  Current Output Device Settings.

The other docking panel, in the lower half of the zone, is intended as a
container for measurement related settings windows and contains two or
more dockable windows from the following list,

e Acquisition Settings,

o 802.11ad Demodulation Settings,
e  WiHD Demodulation Settings,

o Display Settings.
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@ When re-arranging the 81199A user interface, it is useful to know that
windows used for configuration and control (tool windows) cannot be
removed from the user interface, whereas windows used for waveform
generation and measurement results (document windows) can be closed.

The settings windows are tool windows and cannot be closed. They can,
however, be auto-hidden (by clicking the push-pin) so as to maximize the
screen area available for measurement results.

More About Docking A docking panel has 5 docking positions; top, bottom, left, right or
Panels "document".

The first four of these positions enable windows to be tiled within the docking
panel; as we will describe shortly. However, for the settings windows, the
document docking position is more appropriate.

When windows are docked in the document position the windows contained
in the docking panel are conceptually laid on top of each other and accessed
by a row of tabs at the bottom (or top) of the dock pane area. Clicking on a
tab brings the corresponding window to the top of the stack.

Any window in a docking panel can be displayed as a floating window.

To convert a docked window to a floating window, double click on the
window tab in the docking panel. To return the window to its original
position in the docking panel, double click on the title bar of the floating
window.

Any window can be moved from one docking panel to another. Click the
window tab in one docking panel and drag it. A transparent blue overlay will
show you the position of the corresponding floating window and will move
with your cursor.

9 To float or drag a window it must first be pinned (not in Auto-Hide mode.)

As your cursor moves over each docking panel a docking position selector will
appear for that docking panel.
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Figure 18. Dragging a Window

Move your cursor over the intended destination docking panel to get the
correct destination selector, and then move the cursor to the desired docking
position selector hotspot. When you release the mouse button, the window
will be tiled as illustrated by the blue overlay, as shown in Figure 19.
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Figure 19. Possible Docking Panel Window Docking Positions
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9.41 Purpose of Each Window

<current> Segment
Settings

Final Waveform
Settings

Current Output
Device Settings

Acquisition Settings

802.11ad
Demodulation
Settings

WiHD Demodulation
Settings

Display Settings

Window Explorer

Errors, Warnings and
Information

The 81199A software has 10 tool windows in the Settings Windows zone,
some of which will only be added to the user interface if the corresponding
license is valid.

Configure the settings of the waveform segment that is currently selected in
the Waveform Layout window, or the active Segment Library window.

Configure the settings of the final waveform that will be generated.

Configure the settings of the current output device which may be an Arbitrary

Waveform Generator or a File.

Configure the settings of the underlying 89601B VSA software.

Configure the settings of the 802.11ad demodulator.

Note: This window will only be present if you have a valid 81199A option IAD
license installed.

Configure the settings of the WiHD demodulator.

Note: This window will only be present if you have a valid 81199A option
WHD license installed.

Configure the properties of the measurement result displays.

This window provides an overview of all the windows in the application's user
interface. It also allows you to quickly bring a particular window into focus by
clicking on the name.

This tool window collects and displays any error, warning or information
messages issued by the software, either since start up, or since the Clear List
button (in the top right corner of this window) was last clicked. The
information can optionally be grouped by type.
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9.5 Waveform Generation Windows
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In the Generate Windows zone, there are two docking panels. One, in the
upper half, contains a Segment Library window for each currently licensed
format, as well as for the standard segment libraries; Utility and Multi-tone.

A fully optioned 81199A will have tabs for all of the following,
e WiHD LRP Beam Formed

e WiHD LRP Directional
e WiHD LRP Omni

o WiHD HRP
o 802.11ad
o Utility

e  Multi-tone

If Utility and Multi-tone are unexpectedly the only tabs present then there
may be a problem with your software licenses. Check your license status
using the Licenses tab in the Help > About... dialog box.

If you have created your own plug-in waveform class as described in the
Agilent Wideband Waveform Center 81199A — Development Option Guide
(P/N 81199-91030), and correctly installed the DLL in the plug-ins directory
prior to starting the application, then there will also be Segment Library
window tab(s) named according to your class definition(s).

The other docking panel, in the lower half of the Generate Windows zone
contains,

e Waveform Layout window,
e Final Waveform window

These docking panels and windows can be manipulated in exactly the same
way as was described for Settings Windows in section 9.3 However; their
default layout is likely to be the most useful.
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9.5.1 Purpose of Each Window

WiHD LRP Beam
Formed

WiHD LRP
Directional

WiHD LRP Omni
WiHD HRP
802.11ad

Utility
Multi-tone

Waveform Layout

Final Waveform

The 81199A software can have 10 or more document windows in the
Generate Windows zone, some of which will only be added to the user
interface if the corresponding license is valid.

If present, each window provides a library of 8 independently configurable
waveform segments, compliant with the relevant specification, which can be
dragged and dropped into the Waveform Layout window to construct
arbitrarily complex waveform sequences.

This window provides a workspace where segments from the Segment
Library can be sequenced in time, and across up to 4 concurrent tracks (in the
style of an audio mixer) , and where (optionally) a range of impairments and
other post processing can be specified to be applied before being downloaded
to the output device.

This window provides a viewer for the final waveform data, including any
impairments and other post processing, before it is downloaded to the output
device.




Window Management and
Manipulation

9.1 Measurement Result Windows

In the Measurement Windows zone, there are four docking panels arranged in
a 2 x 2 grid which, together, contain 12 Measurement Result windows (3 in
each docking panel).

Each of the Measurement Result windows (numbered 1 to 12), can contain
any measurement result for which the 81199A software has a valid license.

As well as the two primary measurement displays taken directly from the
underlying 89601B VSA software (Main Time and Spectrum), a fully optioned
81199A has a further 40 measurement displays aggregated across the 3
currently available wideband demodulators.

The software will provide a default mapping of measurement displays to
Measurement Result windows depending on the installed options, but it is
important to realize that you can easily re-configure the 12 Measurement
Results windows to show any combination of the available measurement
displays.

As an example, if you only have option IAD (802.11ad) installed the default
mapping is as follows,
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Top left docking panel
Measurement Result window 1 : Main Time
Measurement Result window 5 : 802.11ad Codeword Display
Measurement Result window 9 : 802.11ad 1Q Data
Top right docking panel
Measurement Result window 2 : Spectrum
Measurement Result window 6 : 802.11ad Correlator Output
Measurement Result window 10 802.11ad EVM Spectrum
Bottom left docking panel
Measurement Result window 3 : 802.11ad Error Summary
Measurement Result window 7 : 802.11ad Channel Estimation
Measurement Result window 11 802.11ad EVM Spectrum
Bottom right docking panel
Measurement Result window 4 : 802.11ad Decoded Data

Measurement Result window 8 : 802.11ad Channel Frequency
Response

Measurement Result window 12 802.11ad OFDM EVM .vs. Symbol

9 You can change the displayed result by right mouse clicking either on the
Measurement Result window tab or on the title in the measurement display
and choosing another result from the drop down menu.

9 Each set of three Measurement Result windows is, by default, docked in their
respective docking panels as a stack. However, you can rearrange this to
your preference by dragging and dropping the windows in exactly the same
way as was described for Settings Windows in section 9.3.

For measurement displays, the tiling option is often particularly useful. For
example to tile the magnitude and phase presentations of channel response
in the same panel.

9.1.1 Purpose of Each Window

The 81199A software has up to 12 document windows in the Measure
Windows zone; they are all Measurement Result windows.
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Working with Measurement Displays

'.o;o.'. 10 Working with Measurement Displays
0,0

10.1 Introduction

This chapter describes how to work with the various result displays available
in the 81199A software.

10.2 Selecting Measurements

3:[Spectrum]
i ¢ | (b)start

fain Time
Widig
802.11ad

Wireless HD

Figure 20. Selecting a Measurement Result
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You can select which measurement result is displayed in a particular
Measurement Display window by right-clicking on the title of the currently
displayed measurement result and choosing the measurement you want from
the drop-down menu.

The same menu will appear of you left-double-click or right-click on the tab of
a docked Measurement Display window.

It is possible to have the same result displayed in multiple Measurement
Display Windows, for example, if you want to concurrently display the
magnitude and phase parts of a result.

10.3 Altering Coordinate Ranges, Units Etc.

Mouse over

Mouse click on
numeric

If you hover your mouse over an annotation in a measurement result display
and a dark grey box appears around it, this means that it is adjustable.

If the value is numeric, the easiest way to adjust it is to single click it (the box
should turn a brighter yellow), and you can use your mouse wheel to scroll
the value up and down.

IOWR R ML e & [ PO r g g onop (g

3 : Spectrum

Figure 21 Changing a limit. Figure 22 Selecting a limit
default.

If you want to type in a specific value, double left click or right click the
annotation to open a compound control that allows you to enter a new value,
increment or decrement the current value, or pick a default value as shown in
Figure 21 and Figure 22.



Mouse click on list
item

Working with Measurement Displays

Log
Magnitude

Linear Magnitude

Feal (1

Imadinary (20
Wrapped Phasze
Urvwrapped Phase
|-

Figure 23. Changing Data Fig_ure 24. Changing Displayed
Representation Units.

A double left click or right click on a list item, for example, the Y-axis limit will
open a drop-down menu that allows you to select a different data
representation of the result data. Similarly, clicking on the units opens
another drop-down menu that allows you to select different units, as shown
in Figure 23 and Figure 24.

10.4 Zooming

Quick Zoom

Markers while
zooming

81199A User's Guide

Zooming is enabled by double clicking on the Zoomed status indicator in the
top right of the display. When the Zoomed status is True, a secondary bar
appears at the bottom of the trace with a grey overlay showing how much of
the time record is currently being displayed. Initially the overlay will cover the
entire extent of the time record, but this can be reduced or enlarged using the
mouse wheel and the display will be updated correspondingly.

The position of the partial time record being displayed can be changed in
large time steps by clicking and dragging the grey overlay cursor, or in fine
time steps by clicking and dragging the display itself.

Alternatively, even if your mouse does not have a wheel, you can use the
"Quick Zoom" capability by holding the Control key down then clicking and
holding the left mouse button. Moving the mouse left and right pans the
zoomed display, while moving the mouse up and down zooms in and out.
Releasing the left mouse button returns you to non-zoomed operation.

When a display is zoomed, an information panel appears in the top right of
the display that gives a readout of the X and Y coordinates of the cursor. The
coordinated are expressed in the current X and Y units.

107



10.5 Right-Click Menu in the Display Area

All measurement result displays support a right-mouse-click menu providing
the functions described in this section. Some result displays add result
specific entries to this menu as well. Those are introduced in the relevant
result descriptions.

10.5.1 Copy Data as Text

Selecting this menu item copies the displayed measurement's X and Y-axis
values to the clipboard as text. Only values within the displayed X-axis range
are saved.

The X-axis range is most easily positioned and adjusted using the zoom
function, permitting you to quickly and visually select just the data of interest
from the full measurement, which can have many thousands of data points.

10.5.2 Copy Image

Selecting this menu item copies the measurement result display to the
clipboard as a graphic that can be pasted into other applications.

10.5.3 Auto-Scale Y-Axis

Selecting this menu item sets the measurement result display Y-axis limits to
match the minimum and maximum Y-axis values of the displayed data.

The Y-axis limits can be returned to their default values as described in
section 10.3.
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Working with Measurement Displays

10.6 Display Settings

The Display Settings window provides considerable control over the
appearance of various elements in the measurement result displays.

10.6.1 Constellation Displays

The Constellation Displays settings apply to the I1Q Data (constellation)
measurement result display.

Symbol Shape Set how the measured symbol positions are represented in the I1Q Data
(constellation) display. The choices are,

e QOpen Circles

e Filled Circles

e C(rosses

¢ Diagonal Crosses
e \Vertical Lines

e Horizontal Lines
e Boxes

o Filled Boxes

e Open Diamonds
e Filled Diamonds
e Dots

e None

Dots are the most precise representation, but, subjectively, Crosses (the
default) make the constellation display easier to see, especially if there are
relatively few points mapped.
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Symbol Size

Set the size of the measured symbol representation. The graticule size is
always =1V pk in both axes. Expressing the symbol size in mV ensures that it
maintains the same size relative to the graticule even if the display window is
re-sized so that the constellation's appearance does not change.

Show Graticule

If set to True the 1Q Display will include a graticule.

Show Ideal Symbols

If set to True the 1Q Display will include markers showing the idea symbol
positions for the detected constellation type.

Ideal Symbols Shape

Set how the ideal symbol positions are marked in the 1Q Data (constellation)
display. The choices are the same as for Symbol Shape.

Crosses most precisely mark the target position, but can be obscured by the
measured symbols in a dense constellation. Open circles provide a boundary
around the ideal position and can give a better subjective reference for
evaluating distortions.

Ideal Symbols Size

Set the size of the ideal symbol marker. The graticule size is always 1V pk
in both axes. Expressing the symbol size in mV ensures that it maintains the
same size relative to the graticule even if the display window is re-sized so
that the constellation's appearance does not change.

When using open circles as a marker, the circle can serve as a visual limit line
for subjective assessment of the constellation.

10.6.2 EVM Displays

The EVM Displays settings apply to the OFDM EVM .vs. Symbol and EVM .vs.
Carrier measurement result display.




Working with Measurement Displays

Symbol Shape Set how the measured EVM values are marked in the OFDM EVM displays.
The choices are the same as for |Q Data Symbol Shape.

Symbol Size In the EVM displays the symbol is just a marker, so its size is expressed in
pixels. The default value of 2 is a balance between visibility and clutter.

RMS Plot Only If this is set to True, only the white RMS value trace is included in the display.

10.6.3 General Display Settings

The Constellation Displays settings apply to the 1Q Data (constellation)
measurement result display.

Display Quality Set the level of display quality. On slower computers switching to a lower
quality may improve graphics update performance.

10.6.4 Spectrum/Main Time Displays

The Spectrum / Main Time Displays settings apply to the Spectrum, Main
Time, and other time / frequency domain measurement result displays.

Draw Min/Max Lines If this is set to True, a solid line is drawn that shows the minimum and
maximum values in the trace data.

Fill Min/Max If this is set to True, the region bounded by the maximum and minimum
values is shaded.
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Draw All Points

If this is set to True, every data point in the trace is shown. This can reveal
subtle behaviors in the data, but will lower the graphics update performance.

10.6.5 Sub-Carrier Displays

The Sub-Carrier Displays settings apply to measurement displays that have
sub-carriers as the X-ordinate, for example, OFDM EVM .vs. Subcarrier.

Reverse Sub-Carrier
Axis

Set this to True when displaying results from demodulating a spectrum
reversed signal that have sub-carriers as the X-ordinate.

10.6.6 Text Displays

The Text Displays settings apply to the Error Summary measurement result
display.

Auto Grow Text
Displays

If set to True then the font size of the text in the Error Summary result display
will increase to fill the available space if you stretch the window. This is
particularly useful if you need to read the results from a distance.

Auto Shrink Text
Displays

If set to True then the font size of the text in the Error Summary result display
will reduce to fit the available space if you shrink the window. This is
particularly useful if you want to maximize the information visible on a small
screen.
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Generate

11 Generate

11.1 Introduction

This chapter describes the general operation and layout of the waveform
generation part of the 81199A software.

Waveforms are created by dragging and dropping waveform segments from the
active Segment Library window into the Waveform Layout window.

Once the desired sequence of waveform segments is achieved, the composite
waveform, including any added noise or other impairments, can be reviewed in
the Final Waveform window.

The waveform can then be downloaded to the selected output device by
clicking the Generate and Output button on the Tool Bar or selecting Generate
> Generate and Qutput on the menu.

11.2 Segment Library

81199A User's Guide

In the Generate zone of the user interface (see Figure 17 ) there is a Segment
Library window for each currently licensed format, as well as for the standard
segment libraries; Utility and Multi-tone.

To create a waveform, first select the tab representing the format of interest.

You will see eight numbered containers; each will contain either a small
graphic of the segment currently occupying that position, or the words "Not
built yet" if that segment has not yet been used.
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To use a segment, simply click on the colored numbered box on the left of the
segment container, drag and drop it into the Waveform Layout window.

If the segment had not previously been built, it will immediately build, based on
the default settings for that waveform type. If it has previously been built it
will be re-built based on the most recent setting values.

Each of the eight segments available from the library is independently
configurable.

11.3 Waveform Layout

The Waveform Layout window is similar in concept to an audio track editor.

Start by selecting a segment type in the Segment Library and selecting the
Waveform Layout Window. The Waveform Layout window is initially blank.

WiHD LRP Beam Formed WIHD LRP Directional WIHD LRP Omni WHD HRP 802.11ad I Wiig Uility Multi-tone

| safjef -8 - H - B - |

-7 Waveform Layout Final Waveform

Figure 25. Segment Library and Waveform Layout Windows Ready to
Build a Waveform

Drag and drop segment 1 from the selected 802.11ad library into the layout
window, by clicking and dragging the numbered, colored box at the left side of
the wanted segment in the library.

When dragging a segment, the cursor changes to the form shown in the Figure
26.
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Figure 26. Cursor Shape When Dragging a Segment

When the mouse button is released a copy instance of 802.11ad segment 1 is
drawn in the Waveform Layout window.

WiHD LRP Beam Formed WWIiHD LRP Directional WiHD LRP Orani WiHD HRP 802. llad WiiGig Utiliky: Wulti-tone:
Wavefnrm Laynut Final Waveform

u{_znnm in \annm out | Wiew Tracks -

2802 11ad Segment 1

Figure 27. First Segment Dropped onto the Time Line

Repeat the process to drag a copy instance of 802.11ad segment 2 into the
Waveform Layout window, dropping it to the right of the first segment.

WiHD LRP Beam Formed \WiHD LRP Directional WHD LRP Crani WHD HRP 802. llad Wicig Uiliky Multi-tone

fafieell N § H |

Wavefurm Layuut Final "aveform

u{zoom in x{zoom out | Wiew Tracks -

202.11ad Segment 1 802.11ad Segment &

Figure 28. Second Segment Added to the Time Line
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In this way, one or more segments of waveform can be concatenated to
compose a complete waveform.

Each copy you drop into the Waveform Layout window is really just a reference
back to the library segment, if you select and edit the settings of one copy, all
the other copies will take on the same values.

A segment can be dropped into the Waveform Layout window multiple times
to create heterogeneous segment sequences with relatively few unique
segments.

You can create multiple contiguous repetitions of the same packet by
drag/dropping multiple copies from the segment library, but it is better to use a
single segment and change its Packets in Segment property.

You can re-order segments that have already been placed on the time line by
dragging and dropping them again.

WiHD LRP Beam Formed WIHD LRP Directional WIHD LRP Omni WHD HRP &0z.11ad I Wiig Uility Multi-tone

FE ’2—= m m m ’S_m ’7
-~ Waveform Layout Final Waveform

3.{, zoom in C{zuom ouk | Migw Tracks ~

802.11ad Segment 2 202.11ad Segment 1

Figure 29. Segments Re-Ordered on the Time Line by Drag / Drop

You can delete unwanted segments by right-clicking on the segment title bar
and selecting the menu item Delete the segment instance.

This does not delete the segment from the library, or reset the most recent
settings (because those are actually properties of the library segment).

If you want to re-instate the segment, simply drag and drop another copy from
the Segment Library.
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WWiHD LRP Beam Formed WiHD LRP Directional WHHD LRP Omni \WIHD HRP 802.11ad WiGig Utility Multi-tone

"—E ’2—= m m’ m ’s_m’i
~"Waveform Layout Final Wavefarm

i @ zoomin S zoom out | View Tracks ~

802.11ad Seqment 2

07 1124 r1
Delete this segrient instance.

View I Data

Views O Data

View I and Q Data
View Magnitude

View Phase

Figure 30. Waveform Layout Right-Click Menu

The Waveform Layout window also extends the audio editor metaphor by
providing up to 4 concurrent tracks, so that segments from the Segment
Library can be sequenced in time along multiple tracks to create composite
waveforms.

Section 11.3.1 explains how to enable multiple tracks and sections 11.3.3,
11.3.4, and 11.3.5 illustrate some of the possible uses.

11.3.1 Waveform Layout Tool Bar

At the top of the Waveform Layout window there is a tool bar.

Zoom In and As you build your waveform you many need to zoom in or out on the timeline
Zoom Out displayed in the window.

A good example is given in the example of section 11.3.4, where it is necessary
to zoom in quite far to see the delay segments because they are so much
shorter duration than the 802.11ad segment.

As well as the Zoom In and Zoom Out buttons, you can also use the mouse
wheel to adjust the zoom, and the slider bar to adjust your position in the time
record.
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View Tracks

Clicking this button activates a menu which allows you show or hide additional
waveform layout "tracks".

The Waveform Layout window provides up to 4 concurrent tracks (in the style
of an audio mixer). Segments from the Segment Library can be sequenced in
time along any track, and the tracks are summed together to create the final
waveform.

The amplitude, phase, and Intermediate Frequency of each track can be
individually configured prior to summation, which allows considerable flexibility
in the creation of composite waveforms.

The examples given in Sections 11.3.3, 11.3.4, and 11.3.5 illustrate some of the
possibilities.

The purpose of the View Tracks menu is to save display space by having
visible, only the tracks you are using. If the menu item has a check mark next
to it then the track is visible.

11.3.2 Right-Click Menu

As shown in Figure 30, the Waveform Layout window has a right click menu.

Delete Current
Segment

This menu selection will delete only the segment copy instance on which the
right-click was performed. It does not delete any other copy instances of the
same library segment (even though all the copy instances of that segment will
be highlighted by a brown frame on the Segment Label(s)).

Nor does it delete the segment from the library, or reset the most recent
settings (because those are actually properties of the library segment).

View |, Qorland Q
Data

These menu selections control how the | and Q components of the waveform
data are plotted. The default setting is | and Q so each waveform track has
two traces.




View Magnitude or
Phase

Generate

These menu selections plot the waveform data in magnitude or phase
representation.

11.3.3 Using Tracks to Add a Modulated Interferer

802.11ad segments
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This section describes how the multi-track capability of the 81199A software
can be used to create a signal containing a modulated co-channel interferer.

As an example, we will create a waveform containing an 802.11ad modulated
signal, with a second 802.11ad modulated signal at -30 dBr.

First we configure two 802.11ad segments as follows (only the non-default
values are specified),

802.11ad Segment 1
Modulation and Coding Scheme: 12: SC, Pi/2-QAM16 3/4 LDPC
Length (octets): 10000
Payload Content: PN23
Interpacket Gap: 10 ps
Packets in Waveform : 2
802.11ad Segment 2
Modulation and Coding Scheme: 4: SC, Pi/2-BPSK, 3/4 LDPC
Length (octets): 2000
Payload Content: PN23
Interpacket Gap: 5 ps
Packets in Waveform : 3

Enable tracks 1 and 2, then drag and drop instances of the configured
segments onto the tracks as follows,

Track 1
802.11ad Segment 1

Track 2
802.11ad Segment 2

The resulting waveform should look like
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802.11ad Segment 1

#02.112d Segment 2

Figure 31. Waveform Layout for Modulated Interferer

In the Final Waveform Settings window, set the track Amplitudes to

Track 1
Amplitude : 100.0%,
Track 2
Amplitude : 3.2% (=-30 dBr, computed as 100 x 10(-30/20))

Measuring the result In this case, the MCS 12 signal in track 1 is easily receivable with a reported
EVM of 3.18% and SNR of around 28.7 dB, suggesting that there is some noise
or interference present.

Looking at the EVM Time result shows that the EVM steps up and down over
time suggesting that the interferer is a bursty signal rather than noise.

120



Generate

7 :[802.11ad E¥M Time]
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Linear

Figure 32. EVM Time Display Showing the Effect of a Bursty Interferer

Looking at the Ga128 Correlator Output result we see the correlator spike
"signature" of another 802.11ad signal at a very low level.

T :[802.11ad Correlator Output]
i €€ | (p)start

Figure 33. Gal28 Correlator Output Showing Correlation "Signature"
of an 802.11ad Interferer.
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11.3.4 Using Tracks to Create a Multipath Signal

802.11ad segment

Utility Silence
segments

This section describes how the multi-track capability of the 81199A software
can be used to create a multi-path signal.

As an example, we will create a waveform containing an 802.11ad signal as it
would appear at a receiver if there were three unequal transmit paths.

First we configure one 802.11ad segment and two Utility "Silence" segments
as follows (only the non-default values are specified),

802.11ad Segment 1
Modulation and Coding Scheme: 12: SC, Pi/2-QAM16 3/4 LDPC
Length (octets): 10000
Payload Content: PN23
Interpacket Gap: 10 ps
Packets in Waveform : 2

Utility Segment 1
Length : 10 ns

Utility Segment 2
Length : 14 ns

Enable tracks 1, 2 and 3, then drag and drop instances of the configured
segments onto the tracks as follows,

Track 1
802.11ad Segment 1
Track 2
Utility Segment 1
802.11ad Segment 1
Track 3
Utility Segment 2
802.11ad Segment 1

The resulting waveform (very zoomed in to show the silences) should look like
Figure 34.
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Waveform Layoult

&, zoom in <, zoom out | View Tracks =

Figure 34. Zoomed in Waveform Layout Showing How Silences
Provide Time Delays.

A multi-path waveform should be constructed in this way (with the same
segment in each track) so that only one segment needs be edited to ensure
that there is always the same signal on all three paths.

In the Final Waveform Settings window, set the track Amplitudes and Phases
to,

Track 1
Amplitude : 31.62% (= -10 dBr, computed as 100 x 10(-30/20))
Phase : -58°

Track 2
Amplitude : 100%
Phase : 0°

Track 3
Amplitude : 17.78%.(= -15 dBr, computed as 100 x 10(-30/20))
Phase : -123°

Looking at the Channel Estimation of this simulated multi-path signal we can
see the peaks due to a -10 dBr path, 10 ns before the main path (at 0 dBr, 0
ns), then a delayed path at -15 dBr, 4 ns after the main path.

The Channel Estimation display has been zoomed so we can use the cursor to
get numerical results. The cursor is sitting on the pre-echo peak in Figure 35.
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Figure 35. 802.11ad Channel Estimation (Zoomed)

11.3.5 Using Tracks to Create a Multi-Channel Signal

This section describes how the multi-track capability of the 81199A software
can be used to create a signal containing multiple RF channels.

As an example, we will create a waveform containing a mixture of WirelessHD
and 802.11ad modulated channels.

First we configure five 802.11ad segments and two WirelessHD segments as
follows (only the non-default values are specified),



802.11ad segments

WiHD segments
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802.11ad Segment 1
Modulation and Coding Scheme
Payload Content: PN23
802.11ad Segment 2
Modulation and Coding Scheme
Length (octets): 2000
Interpacket Gap: 10 ps
802.11ad Segment 3
Modulation and Coding Scheme
Length (octets): 10000
Payload Content: PN23
Packets in Waveform: 2
802.11ad Segment 4
Modulation and Coding Scheme
Length (octets): 80
802.11ad Segment 5
Modulation and Coding Scheme
Length (octets): 10000
Payload Content: PN23
Packets in Waveform: 5

WIiHD LRP Directional Segment 1
Header Type: Data
WiHD HRP Segment 1
Packets in Waveform: 3
SP1 Payload: 12000

Generate

: 0: Control, DBPSK, 1/2 LDPC

: 6: SC, Pi/2-QPSK, 1/2 LDPC

:12: SC, Pi/2-QPSK, 1/2 LDPC

: 0: Control, DBPSK, 1/2 LDPC

: 24: SC, Pi/2-QPSK, 1/2 LDPC
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Enable tracks 1 to 4, then drag and drop instances of the configured segments
onto the tracks as follows,

Track 1
802.11ad Segment 2
802.11ad Segment 1
802.11ad Segment 2
Track 2
802.11ad Segment 4
802.11ad Segment b;
Track 3
WiHD HRP Segment 1
WIiHD LRP Directional Segment 1
Track 4
802.11ad Segment 3;
802.11ad Segment 1

The resulting waveform layout should look like Figure 36.

Waveform Layout

|
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802.113d Segment 5
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802.11ad Segment 3

2 zoomin 2 zoom out | View Tracks =

202.11ad Segment 2 802.112d Segment 1 802.112d Segment 2

802.112d Segment 4

802.112d Segment 1

Figure 36. Waveform Layout for 4 RF Channel Mixed Signal Scenario.
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To create an 1Q baseband signal containing the four channel RF scenario, set
the channel offset frequencies to distribute the channels across the available
AWG bandwidth.

In the Final Waveform Settings window, set the track Offset Frequencies to

Track 1

Offset Frequency : -3.24 GHz,
Track 2

Offset Frequency : -1.08 GHz
Track 3

Offset Frequency : 1.08 GHz
Track 4

Offset Frequency : 3.24 GHz

If the resulting 1Q baseband signal is vector modulated onto a nominal carrier
frequency of 61.56 GHz then the four channels will be centered on 58.32 GHz,
60.48 GHz, 62.64 GHz and 64.80 GHz, which are the center frequencies of
Channels 1 through 4 in the ITU approved 60 GHz channel plan.

Of course, this requires vector modulation and up-conversion hardware that is
capable of processing a signal with approximately 8.25 GHz modulation
bandwidth.

However, for demonstration purposes we can simply feed the baseband | and
Q signals into, for example, a DS090804A oscilloscope.
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Computing the Before generating the signal we must also check that the final sample rate is
required sample rate sufficiently high.

e The highest offset present is 3.24 GHz.

e The occupied bandwidth of the 802.11ad signals at those offsets is 2.4
GHz. (Based on the specification -20dB mask points.)

e  Multiply by 2.56 to avoid aliasing effects.

Therefore the minimum sampling rate is,

Required Sample Rate = (Highest Offset + (0.5 x Occupied Bandwidth)) x 2.56
=(3.24 + (0.5x 2.4)) x 2.56 = 11.3664 GHz

The M8190A defaults to its maximum sample rate of 12 GHz in Speed Mode,
so this is sufficient.

Computing the The calculation can, of course, also be worked in the other direction. If, for

maximum IF from the example, you wanted to use the M8190A Precision Mode then the maximum

available sample rate available sampling rate is 8 GHz and so the maximum un-aliased offset
achievable with 802.11ad modulated signals is,

Maximum Offset = (Max Sample Rate / 2.56) — (0.5 x Occupied Bandwidth)
(8.0 / 2.56) — (0.5 x 2.4) = 1.925 GHz

So it would be possible to simulate a 2 channel signal (at £1.08 GHz) in
Precision Mode.

Measuring the Result By setting the span to 12 GHz / 1.28 = 9.375 GHz we can see the spectrum of
all four channels.
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2 : [Spectrum]

Zoomed:False

Figure 37 Baseband IQ waveform with 4 x 2.16 GHz Channels with
802.11ad in channels 1, 2 and 4, and WirelessHD in channel 3.

By setting the span to 2.5 GHz and the center frequency to, for example,

-1.08 GHz we can demodulate and measure individual channels as shown in
Figure 38, Figure 39, and Figure 40.
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11.4 Final Waveform Settings

11.4.1 Calibration

Calibration Mode

81199A User's Guide

The Final Waveform Settings window lists all the settings relating to the
processing and conditioning of the mathematically perfect waveforms in the
Layout Window to create the final composite waveform prior to download to
the output device.

This setting determines how the downloaded signal is pre-corrected for any
impairments present in the signal path. It has four possible values,

e No Cal: No pre-correction filter is applied. This is the setting default.

e Cal On Every Download: Every time you request a waveform
download (by selecting Generate > Generate and Qutput on the
menu, or by clicking the Generate and Output button on the Tool
Bar.), the software will automatically perform a calibration, then
calculate and apply the resulting pre-correction filter before
downloading the signal.

This is the simplest mode of operation. It is intended for use where
the characteristics of the signal path are unknown or known to vary
significantly over time, but it requires that the 89601B VSA software
and associated oscilloscope remain correctly configured for every
calibrate and download sequence.

In this mode the calibration signal always occupies approximately 80% of the
bandwidth implied by the sampling rate and hence may not be appropriate for
all signal path configurations.

Ideally the signal path should be able to accommodate the full bandwidth of
the calibration signal, but if the cumulative signal path bandwidth is
significantly restricted relative to that of the calibration signal then the pre-
correction computation may over-compensate the band edges. In this case
you should consider using the User Defined mode to tailor the calibration
signal to the available path bandwidth.
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o (Cal On Settings Change: This setting is a slightly smarter version of
the On Every Download setting that is intended to shorten download
times by avoiding potentially unnecessary calibration sequences.

When you request a waveform download the software will apply a
pre-correction filter prior to downloading the signal.

If you have changed any of the following settings since the last
calibration,

Waveform final sample rate
Calibration signal center frequency
Receiver mirror spectrum state

0O O O O

Receiver channel configuration

then the software will automatically perform a new calibration, then calculate
and apply the resulting pre-correction filter before downloading the signal.

The pre-correction filter definition will be retained and used to pre-correct any
further waveform downloads with the same key settings until the filter
definition is updated by another calibration.

@ For example, if you download a signal at 8 GHz sample rate for the first time,
an 8 GHz pre-correction filter will be computed and will be applied to all
subsequent 8 GHz sampled waveforms until you download at a different rate,
say, 7 GHz at which time a 7 GHz pre-correction filter will be computed and the
8 GHz filter definition will be discarded. If you return to 8 GHz sampling a new
8 GHz filter will be computed.

@ Note that the settings listed above can be often changed in more than one
way, depending on the precise configuration of the software.

For example, the receiver channel configuration can be changed by the
Calibration Channel Config. Setting in the Final Waveform Settings window
(when option 002 is not present) or by the Channel Config setting in the
Acquisition Settings Window (when option 002 is present).
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o User Defined Cal: Every time the user requests a waveform
download, the 81199A will apply a pre-correction filter prior to
downloading the signal. The pre-correction filter is user-defined by
the filename in the Pre-Correction Filename setting.

This option is intended for expert users who wish to pre-compute
calibration data using the fully configurable version of the pre-
corrections algorithm available through the Generate > User Defined
Pre-Corrections menu pick.

This can be useful if the user wishes to pre-compute corrections for a
variety of signal path configurations, or where the cumulative signal
path bandwidth is significantly restricted relative to the bandwidth
implied by the source sample rate, or any other hardware
configuration that cannot be satisfactorily pre-corrected by the
simpler modes.

Section 6.4.4 describes the process of generating pre-correction files.

Calibration Center  This setting is not available in the User Defined Cal mode.
Frequency.

To perform the pre-corrections calibration, the software transmits a specially
designed calibration signal. To complete the calibration the 89601B VSA must
be told the center frequency of the calibration signal at the other end of the
signal path. This would be 0 Hz (the setting default) for a baseband to
baseband calibration, but could, in principle, be any frequency as a result of
frequency conversion in the signal path.

This setting is not available in the User Defined Cal mode because, in that
mode, it is not needed as no calibration is performed prior to download. In
User Defined Cal mode, pre-correction is achieved by applying a previously
computed filter defined by the named pre-corrections filter coefficients file.
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Calibration Receiver This setting is only available if 81199A option 002 is not installed and the

Mirror Spectrum.

Calibration Mode is set to Cal On Every Download or Cal On Settings.

The signal path to be calibrated may invert or “mirror” the signal spectrum
(due to 10 reversal, high-side mixing etc.). This setting allows the calibration
routine to take this into account when characterizing the signal path by
conjugating the received signal.

If 81199A option 002 is not installed then there is no Acquisition Settings
menu by which to control the receiver configuration. This setting is therefore
added to permit control of this key configuration point during calibration.

Calibration Channel
Config.

This setting is only available if 81199A option 002 is not installed and the
Calibration Mode is set to Cal On Every Download or Cal On Settings.

The calibration test signal as it appears at the end of the signal path to be
calibrated may be an 1Q signal (I and Q baseband inputs) or an IF/RF (1
channel) signal. This setting allows the calibration routine to take this into
account by setting the 89601B / VSA input configuration appropriately.

If 81199A option 002 is not installed then there is no Acquisition Settings
menu by which to control the receiver configuration. This setting is therefore
added to permit control of this key configuration point during calibration.

Apply:

This setting is only available in the User Defined Cal mode.

The calibration procedure generates corrections for both 1Q impairments and
the complex channel response. It can be useful to be able to apply these in full
or to only correct the channel response (e.g. when the IQ modulation is
performed digitally) so this setting offers the following choice,

e All corrections
e Channel Response corrections only
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Pre-Corrections This setting is only available in the User Defined Cal mode.

Filename.
It identifies the path and name of the pre-correction filter that will be applied to
the final waveform every time the user requests a download.

11.4.2 1Q Distortions

1/Q Exponent The | and Q values are raised to this power before being subject to the other
distortions. (Sign is preserved).

Gainon 1/Q Set the linear gain on | and Q.

DC Offset on 1/Q Set the DC offset present on the real and imaginary axes. Expressed as a
fraction of 1.0 = constellation axis magnitude.

LO Quadrature Error Set the deviation from perfect quadrature in the | and Q axis.

10 Conjugation Set whether | and Q will be output normally, or whether the Q values will be
inverted or whether the | and Q values will be swapped.

11.4.3 Noise Settings

Noise On If true, noise is added to the generated waveform file at the specified C/N ratio
as measured in the specified measurement bandwidth.
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Noise Only

When noise generation is enabled and this is true, the waveform file will
contain noise only; at the same power level it would have were the signal also
present.

This allows the user to measure the in-band power level directly.

If "Normalize data" is set true then the noise power level of the "noise only"
waveform file will be increased by normalization. In this case the power level
will not be at the same power level as it would have were the signal also
present.

C/N Ratio

Set the carrier to noise ratio that will be applied to the signal in the specified
measurement bandwidth.

Measurement
Bandwidth

Set the bandwidth in which the carrier to noise ratio is measured. Normally,
this should be set to match the occupied bandwidth of the signal.
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11.4.4 Phase Modulation

Peak Amplitude

This impairment applies sinusoidal phase modulation to the waveform. This
sets the peak phase rotation. So, for example, with the value set to 20°, a
constellation point at 0° will oscillate sinusoidally between +20° and -20°.

Modulation
Frequency

Set the frequency of the sinusoidal phase modulation.

11.4.5 Post Processing

Post Processor
Library

The Post Processor settings are only visible in the window if you have the
81199A option DEV installed.

Custom post processing is explained in the 81199A Development Option Guide
(P/N 81199-91030)

This specifies the post processor library (DLL) that will be used to post process
the generated waveform data. The DLL file is selected using a File Open dialog
that is activated by clicking the button labeled "...", which appears in the right
of field when the setting is selected.

Post Processor Class
Name

This setting selects the class of post processing object that will be used to
post process the waveform data. When you next generate and output a
waveform, the samples will be passed through an instance of your post
processor class.

All the valid post processing object classes found in the library DLL are
presented as a drop-down list. The DLL can contain one or more post
processing classes, but only classes that implement the 81199A post
processor interface will be listed.

81199A User's Guide
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11.4.6 Sample Rate

Sample Rate Mode

This sets how the final output sample rate is determined.

Any band-limited waveform has a lower bound for alias-free signal sampling
and this is often used as the default sample rate for signal generation. For
example IEEE 802.11ad defines a reference sample rate of 2.64 GHz for its
OFDM modulation modes.

The 81199A will initially generate signals at an appropriate, format specific,
minimum sample rate; however the output sample rate will usually be higher
than this. This may be because the signal has been shifted to an offset
frequency, or because it has been mixed with other higher bandwidth signals,
or simply to match output device capabilities. The necessary fractional sample
rate conversions are achieved by arbitrary resampling.

If this setting is set to auto, the final sample rate is primarily determined by the
selected output device's maximum available sample rate, This is done mainly
to move the sampling image as far away from the desired signal as possible
(within the capabilities of the output device), but also to simplify the
generation and application of pre-corrections.

When the output "device" is a data file, the appropriate final sample rate is
determined by the type of signal being generated,

If the mode is set to manual, then the sample rate can be set to any value that
is valid for the chosen output device. For data files, this means the sample
rate can be set to any value, though, of course, excessive oversampling can
result in very large data files.

Sample Rate

This sets the sample rate for the final waveform. If you are specifying the
sample rate manually, the sample rate should be at least,

sample rate = 2.56 * (| max track offset| + 0.5 * max signal bandwidth).

Please see the example in section 11.3.5 for more detail on working with track
frequency offsets.
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11.4.7 Skew

Skew If set to a non-zero value, the real and imaginary parts of the waveform are
generated with a time skew between them. If the skew value is positive, the
real component will lead the imaginary, while a negative value will cause the
real component to lag the imaginary.

Skew is applied on a per-segment basis so if there are discontinuities between
segments, skew can make this more pronounced.

11.4.8 Track 1...4 Settings

Amplitude Set the amplitude scale factor for the track.

Phase Set the phase angle for the track. A phase angle of 180° will cause the
complex value to be negated, that is A + jB will become -A - |B.

Offset Frequency Set the offset frequency (Forr) of the track. A value of zero means that the
signal is a "zero IF" or baseband 1Q signal and no further conversion is done. If
the value is non-zero, then the signal is re-modulated digitally to the specified
frequency offset from zero.

The ability to generate a digital IF in this way is limited by the maximum
sample rate available from the output device.

For a given sample rate, the maximum valid offset will be equal to,

max track offset = £((sample rate / 2.56) — (0.5 * occupied bandwidth))

For example, with a 12 GSa M8190A playing an 802.11ad OFDM waveform, the
maximum track offset is limited to

max track offset = +((12.0 / 2.56) — (0.5 * 2.4)) = £3.4875 GHz.
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It is possible to create a multi-channel signal by specifying different offsets for
different tracks.

The 12 GSa M8190A can directly generate RF "scenarios" up to 5 GHz wide in
this way (and up to 10 GHz if the complex signal can be re-modulated to a
higher IF), as described in section 11.3.5., however in both cases is important
to check that the hardware being driven by such a signal can also handle such
wide bandwidths.

11.4.9 Waveform Generator Corrections

Sin(x)/x Correction
On

Inside the 81199A software, waveforms are represented by a sequence of
instantaneous values, implicitly spaced out in time at the sample rate with zero
signal between each sample. When these instantaneous values are played out
using an AWG, the sample value is held at the AWG output for the sample
period, effectively turning each zero width sample impulse into a finite width
pulse.

This has the effect of multiplying the signal spectrum by the spectrum of a
sample-period wide pulse. The frequency spectrum of such a pulse has a
sin(x)/x shape with the first zero crossing at the sampling frequency. For
signals where the sampling frequency is a relatively low multiple of the signal
bandwidth the resulting sin(x)/x shaped attenuation of the signal in the
frequency domain can be significant (perhaps 1 or 2 dB at the band edge).

81199A can compensate for this droop by applying an appropriate frequency
domain pre-emphasis to the signal before it is downloaded to the AWG.

The sin(x)/x pre-emphasis is optional because it is not appropriate to apply it
when the signal data is being saved to a file.

Sin(x)/x Filter Boost

The sin(x)/x compensation filter can be used to apply more than normal high-
frequency lift as a quick and approximate compensation for real droop in the
baseband response.

A value of 1 gives normal sin(x)/x compensation. A value of n will give n times
the amount of high frequency lift.
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11.5 Current OQutput Device Settings

This window is where you configure all settings relating to the currently
selected output device.

11.5.1 Agilent AWG (81180B and M8190A)

The 81199A supports output to two models of Agilent AWG, the 81180B and
the M8190A.

Instrument Address Sets the IP address of the connected output device. The computer hosting the
81199A software and the output device must both be connected to the same
LAN.

In the case of the M8190A, the IP address will be that of the computer hosting
the M8190A firmware. If the M8190A software resides on the same computer
as the 81199A then the IP address will be 127.0.0.1 (localhost).

Socket Port Number Sets the port number on the output device to which SCPI commands are sent.

In Agilent products, the default port for SCPI commands is port 5025, however
when multiple instances of a device exist at the same IP address (for example,
multiple copies of the M8190A firmware running on a single PC) it can be
necessary to configure a non-standard port number in order to communicate
with the second and subsequent devices.

Time Out Sets the receive timeout for the connection. If the AWG does not respond in
the specified time a download may fail.
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Offset (81180B only) Set the coarse time offset between the two AWG channels. The offset is
expressed in sample points (which translate to time, subject to the prevailing
sample period).

This setting is only available when the 81180B AWG is the current device.

Skew (81180B only) Set the fine time skew between the two AWG channels. The skew is
expressed in seconds.
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Auto Scaling
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Depending on modulation type, filtering, added noise, track summation etc., a
final waveform may end up with a numerical range significantly larger than the
nominal £1.00 of the 1Q constellation dimensions.

Set Auto Scaling True to ensure that under all circumstances, the AWG is not
sent data values that would over-range the DAC and cause distortion due to
clipping or wrapping. If enabled, the waveform will be scaled so as to fit the
maximum AWG output range.

The auto-scaling procedure is,

1. The absolute maximum value across both the | and Q component is
found. So, for example, if the | component ranged from -1.32 to + 1.29
and the Q component ranged from -1.34 to +1.31 then 1.34 would be
taken as the absolute maximum value.

2. The found maximum value prior to scaling is reported in the
Maximum Value setting.

3. Allvalues in the waveform are divided by the found maximum value
so that they will be less than or equal to 1.00.

4. The normalized values are converted to AWG-safe data values by
multiplying them with the AWG range maximum.

This has the side-effect that every waveform is potentially scaled differently
depending on the maximum value present. While this is the safe default, it
may not be what you want because, for given AWG output gain settings,
waveforms with different peak values would be generated with different
average powers due to the auto-scaling.

If you want all waveforms to have the same average power level then you
should set Auto Scale to False and use fixed scaling.

Maximum Value
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When Auto Scaling is set to True, this setting reports the found maximum
value prior to auto scaling. When Auto Scaling is set to False, this setting
determines the maximum value that will be used to scale all waveforms.

This ensures that all waveforms will have the same average power level for a
given AWG output gain setting, but you must ensure that the set maximum
value is not exceeded by any waveform (otherwise distortion due to clipping or
wrapping will occur).
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If Maximum Value is set too high, the average signal power will be
unnecessarily reduced and low crest factor signals will only use a small part of
the AWG DAC range, which will compromise their accuracy and SNR.

You can get a good idea of an appropriate fixed Maximum Value by looking at
the Maximum Values reported for various waveforms in Auto Scale mode.




AWG Granularity

Options
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Some of Agilent's wideband AWGs have memory granularity. That is, the
waveform length has to be an integer multiple of a minimum sample chunk
size. The chunk sizes for some current AWGs are,

e 81180B — 32 samples

o MS8190A Speed Mode — 64 samples

o MB8190A Precision Mode — 48 samples
e MB8190A/N5152A Mode — 48 samples
e MS8190A DUC Modes — 24 samples

If the waveform generation process has resulted in a sample count that is not
a whole number of memory chunks long, then this setting determines how the
AWG granularity requirement is met. The options are,

Repeat: Multiple repetitions of the waveform are downloaded to the AWG
memory until it occupies a whole number of memory chunks. This can
increase download times and AWG memory usage considerably but will ensure
that the best possible signal quality.

Truncate: A few samples are removed from the waveform. This is not
appropriate for signals that are computed to be phase continuous when played
repetitively.

Append Silence : This is the least intrusive for a burst mode signal. A few
extra zero samples are added to the waveform. This has the effect of slightly
increasing the inter-packet gap so it is not appropriate if you want a precise
time between bursts. It is also not appropriate for signals that are computed
to be phase continuous when played repetitively.

Reference Clock
Source

The M8190A can be configured to take its reference clock either from the 100
MHz clock provided by the AXle card cage backplane or from the REF CLK IN
connector on the front panel.

The AXle card cage backplane 100 MHz clock can be phase locked to the 10
MHz CLOCK IN connector on the card cage Embedded System Module (ESM).

81199A User's Guide
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Reference Clock
Frequency

When the M8190A is configured to take its reference clock from the REF CLK
IN connector on the front panel it, by default, assumes that the reference clock
frequency is 100 MHz, but it can be configured to accept other frequencies in
the range 1 MHz to 200 MHz so that it can use, for example, the 10 MHz
reference clock that is commonly available from other equipment, such as
Agilent signal generators.

It is common for specifications to mandate that the center frequency and
symbol clock frequency of a modulated signal are locked to the same
frequency reference. You can ensure you meet this requirement by connecting
a suitable reference clock output from your modulation and up-conversion
hardware to the M8190A or AXle card cage reference clock input.

Play On Download

If this is set true then the AWG will be instructed to play the waveform once it
is downloaded.

11.5.2 Channel 1/2 Settings

Download to Channel If this is set true, waveform data will be downloaded to this channel.

Normally, the real part of a complex signal will be downloaded to channel 1
and the imaginary part of a complex signal will be downloaded to channel 2.

If the final waveform happens to be real valued then the signal can be played
out on a single channel AWG by setting Download to Channel false for channel
2.

This prevents the 81199A software from trying to download the un-needed
(zero valued) complex part to a non-existent channel.
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Output Coupling Set the output coupling for the AWG. The choices are,

e DAC —the AWG DAC outputs are brought directly to the front panel
with no amplification or filtering.

e DC-—the AWG DAC outputs are passed through a DC-coupled

amplifier.
o AC —the AWG DAC outputs are passed through an AC coupled
amplifier.
DAC Amplitude When the Qutput Coupling is set to DAC, this sets the AWG channel maximum
amplitude

Typically, the DAC amplitude has limited range because there is no output
amplifier in circuit.

DAC Offset When the Qutput Coupling is set to DAC, this sets the AWG channel DC offset.

Typically, the DAC DC offset has limited range because there is no output
amplifier in circuit.

DC Amplitude When the Output Coupling is set to DC, this sets the AWG channel maximum
amplitude.

DC Offset When the Qutput Coupling is set to DC, this sets the AWG channel DC offset.

AC Amplitude When the Output Coupling is set to AC, this sets the AWG channel maximum
amplitude.
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Delay (M8190A Only) Set the delay for this channel. Positive and negative skew between the two
AWG channels is achieved by setting a positive delay on channel 1 (1 lags 2)
or channel 2. (2 lags 1)

This setting is only available when the M8190A is the current device.
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11.5.3 Save File Settings

When the current output device is set to File, the Current Output Device
Settings reduces to a set of Save File settings.

Waveform Filename Specify the name of the file that the waveform will be saved to.

The file is selected using the Open File dialog that is activated by selecting the
setting field and then clicking the button with the ellipsis that appears on the
right of the setting field.

The following file types are supported,

e Comma Separated Value (CSV file) : These are plain text files suitable
for general importing to other applications, particularly spreadsheets
such as Microsoft Excel. If the optional 89601B header is present,
then it can also be read back into the 81199A or 89601B VSA software
as a "recording”.

e N5110A Waveforms (BIN file) : These are binary files that store
waveform data as scaled 16-bit integers without any embedded
information about, for example, center frequency or sampling rate.
However, an optional header file containing this information will be
written if the Include 89600 Header setting is set True.

e MATLAB (MAT file): These are MATLAB Level 5 files containing a 1 x
N matrix called Y1 that contains the complex valued waveform data,
and a 1 x 1 matrix called XDelta that contains the sample period in
units of seconds.

The waveform data in the file is not encrypted.

The option to output to a file is only available with 81199A option DFP.
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Include 89600 Header When this is set true and the user generates a CSV or BIN file, the header

information for the 89600 VSA will be saved.

When saving BIN header files the header is saved in a separate file with a .txt
extension.

This allows CSV and BIN files to be immediately read back into the 81199A or
89601B software as a "recording”, which can be very useful for tutorial or
demonstration purposes.

CSV File Style

This determines how the data is organized in the CSV file. The options are,

e (One Channel : The data is written with one Y channel that has a single
column of complex values.

e Two Channel : The data is written with two Y channels, Y1 contains
the real data, while Y2 contains the imaginary data.

o Interleave : The data is written in a single column of interleaved real
then imaginary part values. This format is intended to facilitate
waveform input to Agilent EESof ADS and SystemVue tools. The
waveform data can be read and converted to complex data using the
block sequence,

ReadFile > Distributor2 > RectToCx.

Normalize Data

When this is set to true, the complex data in CSV and MAT files is scaled so
that both the real and imaginary parts lie strictly in the range %1.

The data in BIN files is always normalized to be in the range £32767 but the
scaling factor in the header file is set to scale the data to %1.

If noise has been added to the waveform, the data will be scaled to preserve
the specified C/N ratio, but this will inevitably mean that the signal power is
reduced accordingly.
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12 Pre-Correction

12.1 Introduction
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Figure 41. Principle of Pre-Correction
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The ideal signal on the left of Figure 41 represents the final composite
waveform at the output of the waveform mixer in the 81199A core.

In this context, ideal means that the signal is, mathematically speaking, exactly
the signal that you want to transmit; it does not necessarily mean that the
signal is perfect. For example, you may have deliberately included specified
levels of impairment such as quadrature error, skew or Gaussian noise, or
perhaps summed in an interfering tone.
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In normal operation, illustrated by the upper signal flow in Figure 41, the ideal
signal will be downloaded to the AWG waveform memory and transmitted. It
will then be subject to any imperfections in the channel before arriving at the
DUT input.

Since the "channel" (analog signal path) starts at the digital inputs of the D/A
converters in the AWG, the channel will include the AWG output paths
(amplifiers, filters etc.) and any subsequent vector modulation or up-conversion
necessary to create the test signal required by the DUT.

We would like the signal delivered to the DUT input to be the ideal signal, but
in practice the signal path will be imperfect and the delivered signal will be
distorted as a result. We cannot know in advance what these imperfections
will be because they are entirely dependent on the specific hardware and its
configuration, and this is determined by the user.

We can, however, measure the test setup to determine its channel response
and vector modulation impairments, then use that information to develop a
filter that will pre-compensate the waveform data so that the delivered signal
is as near to the ideal signal as possible.

The signal flow with pre-corrections applied is illustrated by the lower flow in
Figure 41. The ideal waveform data is pre-corrected by applying a filter. As a
result, the signal at the DAC will be non-ideal, but the channel imperfections
will then cancel those of the signal, resulting in the intended signal at the DUT
input.

The channel imperfections are estimated by transmitting a specially designed
test signal, which is then acquired by a calibration receiver at the point in the
diagram labeled as the measurement plane. This should be as close to the
DUT input as possible because this is the point where the signal will be
nominally ideal after pre-correction.

In this simple model, the calibration receiver is assumed to be perfect and to
not add any further impairment to the signal before it is digitized at the
calibration receiver's A/D converters. In practice the calibration receiver
should be independently calibrated to the desired measurement plane.
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Based on the signal data from the calibration receiver, the 81199A pre-
correction algorithm makes an estimate of the complex channel response and
I1Q impairments, then designs a corresponding pre-correction filter. The next
time generation is requested (with pre-correction enabled) the filter is applied
to the ideal waveform data before the signal is downloaded to the AWG.

12.2 Enabling Pre-Correction

The configuration and application of pre-corrections is controlled by the
Calibration settings in the Final Waveform Settings window. All the possible
settings values are documented in section11.4.1, but essentially there are four
calibration modes,

e No Cal

e (Cal on Every Download
e Cal on Settings Change
e User Defined Cal

Each of the above modes applies the same pre-correction calibration algorithm;
the difference is only in when the correction is computed and when it is
applied. The right mode to use depends on your particular hardware
configuration.

12.3 What Can Go Wrong?
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The specially designed calibration test signal mentioned earlier always
occupies approximately 80% of the 1Q bandwidth that is implied by the
sampling rate. This may not be appropriate for all signal path configurations
without adjustment.

Ideally the signal path should be able to accommodate the full bandwidth of
the calibration signal, but if it is severely attenuated by a bandwidth
constricted signal path, then there will be very little higher frequency test
signal energy present at the calibration receiver and as a result the pre-
correction algorithm will not be able to estimate the channel response or
determine 1Q impairments accurately.
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If the algorithm estimates are noisy, then the derived filters can be noisy and
actually degrade rather than improve the signal quality. This effect is illustrated
in Figure 42.

Pre-Correction Filter Channel

) )

Channel
Inverse

Compute Equiv. Filter (. Estimate Channel

Figure 42. Noisy Pre-Correction Due to Band-Limited Test Signal.

If this is the case for your setup, and it is usually easy to identify by the
presence of excessive band-edge noise in the channel response and IQ
impairment graphs, then you should reduce the waveform sample rate by
manually setting a sample rate more tailored to the bandwidth of the signal
you are generating.

We consider an example of this situation in section 12.5.

If you a have been using a high sample rate for waveform generation because
you are concerned about the proximity of sampling images in the generated
signal, then you can use the User Defined Cal mode to perform the calibration
at the reduced (tailored) sample rate, save the pre-corrections filter to a named
file, then return to the higher sample rate for subsequent generation, with the
named pre-corrections file identified in the settings. In this case, the software
will re-sample the pre-corrections filter to the higher rate.

There is more detail in section 12.8.
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12.4 Pre-Correcting a Baseband Connection

Figure 43 illustrates the essential hardware configuration that we are
assuming in this section. We also assume here that you have already
established correct operation with un-corrected signals. See sections 4 and 5
if you need assistance with basic connectivity.

90000A/X Series Oscilloscope

M8190A Channel 1 Channel 2 Channel 1 Channel 3
® ® [ ] ®

SMA

SMA

Figure 43. Essentials of Pre-Correcting at Baseband 1Q

Select the M8190A as the output device using the menu selection Generate >
Output Device > Agilent M8190A — Precision Mode (14 bit, 8 GHz), then
configure its settings using the Qutput Device Settings window.

Compose the waveform you wish to transmit in the Waveform Layout window.

In the Final Waveform Settings window, change the Calibration settings,

e (alibration Mode : Cal On Every Download
o (Calibration Center Frequency : 0.000000 Hz
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In the Acquisition Settings window, click the "Basic" button to select the
simpler settings list, then change (if necessary) the settings to,

e Channel Config : | and Q Baseband Inputs (always change this setting
first because it resets the center and span values)

e Center:0.000 000 000 Hz

e Span:2.500 000 000 GHz

e Points: 102,401

e Mirror Freq: False

e Range : 400 mV (or use autorange)
e Main Length : 40.000000000 ps

Then click the Generate and Output... button in the tool bar.

The software will automatically download and analyze a test signal. On
completion of the calibration phase, graphs of the channel response and 1Q
imbalance are presented for inspection.
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Figure 44 and Figure 45 show measurements typical of the baseband 1Q setup
illustrated in Figure 43.

Pre-Correction Verification

The calibration is complete, do you wish to apply the pre-corrections to the
downloaded waveform?

The calibration completed successfully, please double check the measurement displays below and verify that no
2 unexpected characteristics are present.
. - Estimated Frequency Offset is -1 kHz,

- Estimated Quadrature Error is 0.00093422 degrees.

Mean Channe! Response | |Q imbalance

i you press Yes, the results of this calibration will be used to pre-correct the signal.
if you press No the signal will not be pre-corrected. Yes No Retry
if you wish to adjust your system press Retry to re-run the calibration.

Figure 44. Typical Mean Channel Response for a BBIQ Connection

Features to note that are indicative of a good measurement:

e Both graphs are well behaved across the middle 80% (approximately).
Some attenuation and noise at the graph edges is to be expected as
the calibration test signal is shaped to avoid aliasing errors, so there is
no test stimulus to analyze in this area.

e The graphs indicate physically probable properties. In this example
the magnitude graph reveals credible high-frequency / band-edge roll-
off, and the phase graph reveals broadly linear phase with no
significant discontinuities in the phase progression.

@ Note, however, that if the phase values are close to the 180° / -180° point
then phase wrapping may produce top to bottom jumps in the graph.
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Pre-Correction Verification

The calibration is complete, do you wish to apply the pre-corrections to the
downloaded waveform?

The calibration completed successfully, please double check the measurement displays below and verify that no
7 unexpected characteristics are present.
. - Estimated Frequency Offset is -1 kHz

- Estimated Quadrature Error is 0.00093422 degrees.

Mean Channel Response | 1Q Imbalance

I you press Yes, the results of this calibration will be used to pre-correct the signal.
if you press No the signal will not be pre-corrected. Yes No Retry
if you wish to adjust your systzm press Retry to re-run the calibration.

Figure 45. Typical IQ Imbalance for a BBIQ Connection

The 10 Imbalance graphs each contain three traces. The Dark Blue and Dark
Green traces are separate estimates which are averaged to provide the final
1Q imbalance estimate, traced in Yellow.

Similar goodness criteria apply to the |Q imbalance graph as to the Channel
Response (you should always check both to confirm that the calibration is
good).

Here we see that the | and Q channels are very well matched in magnitude
and phase at lower frequencies, degrading slightly at higher frequencies.
Again the graphs are well behaved, and only become noisy at the highest
frequencies where there is no test signal energy.
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Assuming the calibration has been successful, and you click the Yes button,
the software will calculate an appropriate pre-correction filter based on the
measured responses, then apply the filter to the final waveform and download
it to the M8190A.

The signal present at the oscilloscope inputs should now be a corrected
baseband 1Q signal.

12.5 Pre-Correcting a Digital IF (M8190A) Connection

Figure 46 illustrates the essential hardware configuration that we are
assuming in this section. We also assume here that you have already
established correct operation with un-corrected signals. See sections 4 and 5
if you need assistance with basic connectivity.

90000A/X Series Oscilloscope

M8190A Channel 1
®

Channel 1
®

SMA

Figure 46. Essentials of Pre-Correcting a 5 GHz Digital IF
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Select the M8190A/N5152A as the output device using the menu selection
Generate > Qutput Device > Agilent M8190A/N5152A, then configure its
settings using the Output Device Settings window.

Compose the waveform you wish to transmit in the Waveform Layout window.

In the Final Waveform Settings window, change the Calibration settings,

e (Calibration Mode : Cal On Every Download
e (alibration Center Frequency : 5.000000 GHz
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In the Acquisition Settings window, click the "Basic" button to select the
simpler settings list, then change the settings to,

e Channel Config : 1 Channel (always change this setting first because
it resets the center and span values)

e Center:5.000 000 000 GHz

e Span:2.500 000 000 GHz

e Points: 102,401

e  Mirror Freq: True

e Range: 316 mV (or use autorange)
e Main Length : 40.000000000 ps

Then click the Generate and Output... button in the tool bar.

@ Note that the Mirror Freq setting is True because the M8190A / N5152A
mode introduces a spectrum inversion in the 5 GHz output signal.

The software will automatically download and analyze a test signal. On
completion of the calibration phase, graphs of the channel response and 1Q
imbalance are presented for inspection.

Figure 47 and Figure 48 show measurements typical of the digital IF setup
illustrated in Figure 46.
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The calibration is complete, do you wish to apply the pre-corrections to the
downloaded waveform?

The calibration completed successfully, please double chedk the measurement displays below and venfy that no
unexpected charactenstics are present

- Estimated Fraquency Offsetis -21 kHz

- Estimated Quadrature Error is -0.49577 degrees

Mean Channel Response | |0 Imbalance

If you press Yes, the results of this calibration will be used to pre-correct the signal
if you press Mo the signal will not be pre-corrected ’ Yes ] 1
if you wish to adjust your system press Retry to re-run the calibration.

No || Rew |

Figure 47. Typical Mean Channel Response for a Digital IF Connection

Features to note that are indicative of a good measurement:

e Both graphs are well behaved across the middle 80% (approximately).
Some attenuation and noise at the graph edges is to be expected as
the calibration test signal is band-limited to avoid aliasing errors, so
there is no test stimulus to analyze in this area.

e The graphs display physically probable properties. In this example the
magnitude graph reveals an asymmetric slope across the passband
(suggesting that this non-flatness is imposed after modulation) and
the phase graph reveals broadly linear phase with no significant
discontinuities in the phase progression.
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The calibration is complete, do you wish to apply the pre-corrections to the
downloaded waveform?

The calibration completed successfully, please double chedk the measurement displays below and venfy that no
unexpected charactenstics are present

- Estimated Fraquency Offsetis -21 kHz

- Estimated Quadrature Error is -0.49577 degrees

Mean Channel Respanse | 10 Imbalance

If you press Yes, the results of this calibration will be used to pre-correct the signal
if you press Mo the signal will not be pre-corrected l Yes ] 1

Mo l [ Retry J
if you wish to adjust your system press Retry to re-run the calibration.

Figure 48. Typical IQ Imbalance for a Digital IF Connection

Similar goodness criteria apply to the |Q imbalance graph as to the Channel
Response (you should always check both to confirm that the calibration is
good).

Here we see that the 1Q magnitude and phase are extremely well matched, as
you might expect because, in this case, the | and Q signals are never in
analog form; the 1Q modulation is performed digitally before D/A conversion.
Again the graphs are well behaved, and only become noisy at the highest
frequencies where there is no test signal energy.

Assuming the calibration has been successful, and you click the Yes button,
the software will calculate an appropriate pre-correction filter based on the
measured responses, then apply the filter to the final waveform and download
it to the M8190A.

The signal present at the oscilloscope inputs should now be a corrected
(spectrally inverted) first IF signal at 5 GHz.
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12.6 Pre-Correcting an Analog IF (E8267D) Connection

Figure 49 illustrates the essential hardware configuration that we are
assuming in this section. We also assume here that you have already
established correct operation with un-corrected signals. See sections 4 and 5
if you need assistance with basic connectivity.

90000A/X Series Oscilloscope

MB8190A Channel 1 Channel 2 Channel 1

® ® 9

SMA SMA
[ ] L ]
Wideband Wideband
E8267D I Q
RF Qutput
®

SMA

Figure 49. Essentials of Pre-Correcting an Analog IF
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Select the M8190A as the output device using the menu selection Generate >
Output Device > Agilent M8190A — Precision Mode (14 bit, 8 GHz), then
configure its settings using the Qutput Device Settings window.

Compose the waveform you wish to transmit in the Waveform Layout window.

In the Final Waveform Settings window, change the Calibration settings,

e (alibration Mode : Cal On Every Download
e (alibration Center Frequency : 5.000000 GHz <see note>
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In the Acquisition Settings window, click the "Basic" button to select the
simpler settings list, then change (if necessary) the settings to,

e Channel Config : 1 Channel (always change this setting first because
it resets the center and span values)

e Center:5.000 000 000 GHz <see note>
e Span:2.500 000 000 GHz

e Points: 102,401

e Mirror Freq: False

e Range: 316 mV (or use autorange)

e Main Length : 40.000000000 ps

Then click the Generate and Output... button in the tool bar.

Because of the test equipment'’s flexibility, the center frequency, can, in
principle, be any frequency supported by both the E8267D and the 90000A/X
series oscilloscope. For test purposes we suggest you use 5.0 GHz.

When using the E8267D PSG at 5 GHz, remember to increment the PSG RF
frequency by 1 Hz to 5.000000001 GHz. This causes the PSG firmware to
select the filter band for frequencies > 5 GHz, which has a much flatter
response than the default choice for exactly 5 GHz.

The software will automatically download and analyze a test signal. On
completion of the calibration phase, graphs of the channel response and 1Q
imbalance are presented for inspection.

If you see an extremely noisy channel response such as that illustrated in
Figure 50, you have most likely not set the calibration center frequency
correctly. The calibration center frequency setting is in the Calibration settings
group in the Final Waveform Settings window.



81199A User's Guide

Pre-Correction

Pre-Correction Verification

The calibration is complete, do you wish to apply the pre-corrections to the
downloaded waveform?

The calibration completed with the foll g warnings, the measurement displays below may help diagnose any
problems.
l -the mean channel response seems noisy, the calibration may rot be valid.
o= - the IQ Imbalance response seems noisy, the calibration may not be valid.

Mean Channel Response | |Q imbalance

If you press Yes, the results of this calibration will be usad to pre-correct the signal. [ Y
if you press No the signal will not be pre-corrected. | Yes ] No Retry
if you wish to adjust your system press Retry to re-run the calibration.

Figure 50. The Calibration center frequency has not been set correctly.
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However, assuming that calibration center frequency has been set correctly,
then Figure 51 shows a typical initial channel response result when
calibration is executed on the analog IF setup illustrated in Figure 49 using
the default sample rate of 8 GHz.

Pre-Correction Verification

The calibration is complete, do you wish to apply the pre-corrections to the
downloaded waveform?

The calibration completed with the following warnings, the measurement displays below may help diagnose any
problems.

' -the mean channel response seems noisy, the calibration may not be valid.

- - Estimated Quadrature Error is 036614 degrees.

Mean Channel Response | |Q imbalance

i you press Yes, the results of this calibration will be used to pre-correct the signal. r =
if you press No the signal will not be pre-corrected. Yes No Retry
if you wish to adjust your system press Retry to re-run the calibration. =

Figure 51. Mean Channel Response for an Analog IF Connection with
Default 8 GHz Sample Rate.

In this case, with default settings, the measurement is still problematic, as
indicated by the guidance at the top of the dialog.

Both graphs are still well behaved across the middle 50%, but the response
falls below -10 dB relative to the band center beyond that. It appears that the
test signal has been significantly attenuated by a bandwidth constricted
channel.

An undesirable consequence of this is that a significant portion of the
estimated amplitude and phase response will be noisy (as can be seen
immediately on the phase graph, and can also be seen on the amplitude graph
if you adjust the scale).
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If we were to go ahead and perform the pre-correction computation based on
this noisy estimate of the channel response and 1Q impairments it would
result in a poor (noise impaired) filter design. Figure 52 illustrates the
undesirable effect of applying a noise impaired filter.

2: [802.11ad Channel Frequency Response] =)
< | (»)Start () Stop | Y 4

Figure 52. Result of applying a poor pre-correction filter.

Looking again at the received signal we see that, in this case, the original,
approximately 6.4 GHz wide, test signal has been filtered down to less than 4
GHz wide by the limited analog bandwidth of the wideband I1Q inputs in the
E8267D PSG.

To achieve an accurate calibration, we must adjust the calibration bandwidth
to better match the available channel bandwidth.

By default, the calibration bandwidth is equal to the waveform sample rate
and here it is set to 8 GHz (the auto setting for an M8190A in precision
mode).

This is significantly larger than both the available channel bandwidth and the
signal bandwidth, and so can safely be reduced (in this case) to 4 GHz, to
better match the available channel bandwidth.
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To set the waveform sample rate manually, select the Final Waveform
Settings tab, change the Sample Rate Mode setting from Auto to Manual,
then change the Sample Rate setting to 4 GHz.

Re-run the calibration with the new sample rate.

Figure 53 and Figure 54 show typical improved measurements resulting from
calibrating the analog IF setup illustrated in Figure 49 at a tailored sample rate
of 4 GHz.

Pre-Correction Verification

The calibration is complete, do you wish to apply the pre-corrections to the
downloaded waveform?

The calibration completed successfully, please double check the measurement displays below and verify that no
2 unexpected characteristics are present.
H - Estimated Frequency Offset is 2 kHz.

- Estimated Quadrature Error is 0.50401 degrees.

Mean Channe! Response | |Q imbalance

T

seny n ™

i you press Yes, the results of this calibration will be used to pre-correct the signal.
if you press No the signal will not be pre-corrected. Yes No Retry
if you wish to adjust your system press Retry to re-run the calibration.

Figure 53. Typical Mean Channel Response for an Analog IF
Connection with Tailored 4 GHz Sample Rate.
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Pre-Correction Verification

The calibration is complete, do you wish to apply the pre-corrections to the
downloaded waveform?

The calibration completed successfully, please double check the measurement displays below and verify that no
7 unexpected characteristics are present.
. - Estimated Frequency Offset is 2 kHz.

- Estimated Quadrature Error is -0.50401 degrees.

Mean Channel Response | 1Q Imbalance

I you press Yes, the results of this calibration will be used to pre-correct the signal.
if you press No the signal will not be pre-corrected. Yes No Retry
if you wish to adjust your systzm press Retry to re-run the calibration.

Figure 54. Typical IQ Imbalance for an Analog IF Connection with
Tailored 4 GHz Sample Rate.

The revised calibration results exhibit the goodness criteria discussed earlier
so we click the Yes button. The software will calculate an appropriate pre-
correction filter based on the measured responses, then apply the filter to the
final waveform and download it to the M8190A.

The signal present at the oscilloscope inputs should now be a corrected first IF
signal.
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12.7 Pre-Correcting an RF (N5152A) Connection

The N5152A up-converter can be driven by an IF signal generated digitally, as
described in section 12.5, or in analog as described in section 12.6.

Figure 55 illustrates the essential hardware configuration for a digitally
generated IF, while Figure 56 illustrates the configuration for an analog
generated IF.

We assume here that you have already established correct operation with un-
corrected signals. See sections 4 and 5 if you need assistance with basic
connectivity.

90000A/X Series Oscilloscope

[ ]

M8190A Channel 1 Clock Out Channel 1

L 4 ®
LO not shown SMA LO not shown SMA

o ¢ ¢ ¢
10 MHzIn  LO Input  IF Input LO Input  IF Output
RF Qutput RF Input

[ ] N1999A ®

N5152A

Waveguide Attenuator or
Over-the-Air

Figure 55. Essentials of Pre-Correcting a 60 GHz RF Link (Digital IF)
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For this configuration, pre-corrections calibration proceeds as described in
section 12.5.
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Since the pre-corrections algorithm is based on an “end-to-end” measurement,
the measurement plane is still at the input to the oscilloscope. The N1999A
down-converter is considered to be part of the channel and will also be
compensated by the pre-correction filter, so that the signal present at the
oscilloscope inputs is the corrected signal.

Of course, we would like the RF signal at the output of the N5152A to be the
ideal signal. To achieve this, the calibration receiver must be re-defined as the
combination of the N1999A and the oscilloscope, and to do that, the ensemble
must be separately calibrated to compensate for down-converter performance,
thus moving the measurement plane to the 60 GHz interface.

The technique and equipment required to calibrate the N1999A/oscilloscope
ensemble to achieve this is documented separately.

1m7m



90000A/X Series Oscilloscope
M8190A Channel 1 Channel 2 Clcgk In Channel 1
[ ] ' ®
SMA SMA
® o ‘
10 MHz Wideband Wideband
Out ' Q RF Output
@ 5 GHz
E8267D ®
LO not shown SMA LO not shown SMA
1 I
] [ ] ®
10 MHzIn LOInput  IF Input LO Input  IF Output
RF Output RF Input
N5152A L4 N1999A [ 4

Waveguide Attenuator or
Over-the-Air

Figure 56. Essentials of Pre-Correcting a 60 GHz RF Link (Analog IF)

For this configuration, pre-corrections calibration proceeds as described in
section12.6.

As with the digitally generated IF, the signal present at the oscilloscope inputs
is, by default, the corrected signal. To move the measurement plane to the 60
GHz interface we must first calibrate the N1999A/oscilloscope ensemble as
documented separately.
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12.8 User Defined Pre-Corrections

User-defined pre-corrections can be useful if the user wishes to pre-compute
corrections for a variety of signal path configurations, or where the
cumulative signal path bandwidth is significantly restricted relative to the
bandwidth implied by the source sample rate (but we need a high source
sample rate for other reasons); or any other hardware configuration that
cannot be satisfactorily pre-corrected by the typical means.

To compute a pre-correction filter, first configure your hardware to implement
the signal path you wish to calibrate and ensure that the VSA / oscilloscope
are correctly configured to receive the calibration test signal.

Select Generate > Generate User Defined Pre-Corrections. This will bring up
the Pre-Correction Generation dialog box.

.| Pre-Correction Generation for Agilent MEL90A AWG - Precision Mode (14 bit, 8 GHz) =S =

Downkoad Calbeation Signal Before you start.
Before running the calibration routine, you should firit check that the output dewice settings and acquisition
settings reflect your hardware setup. When this is done you should download the calibration signal to your output
device

Output Sefings | Acquistion Sefings Message Log | Mean Channel Response | IG imbalance

+ Agilent MB190A
Instrument Address  156.141.115.178
Socket Port Number 5025
Auto Scalng True
M Viahse 1.4700

« Calibration
Calbration Sample R 8.0000000 GH:

Instrument Address
This is host name or IP address of the AWG.

Figure 57. Pre-Corrections Generation Dialog
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You should follow the on-screen guidance, but the flow is,

1. Click Download Calibration Signal — wait until the message log says
"done".

2. Click Auto-Level Calibration Receiver — wait until the message log
says "done". This step is optional if you are confident that the
calibration receiver has the correct gain setting.

3. Click Calibrate — wait until the message log says "done"

At this point you should look at the computed pre-corrections to confirm that
a good result has been obtained. Review the guidance in sections 12.4 thru
12.6 to help make this judgment.

Figure 58 and Figure 59 show examples of the Mean Channel Response and
I1Q Imbalance for a bhaseband connection. Relatively little adjustment is
required in this baseband case, but IF and RF connections will typically
require significantly more correction.

Message Log | Miean Drarrel Resporas | K inbsiance

Figure 58 Mean Channel Figure 59 1Q Imbalance
Response

4. Click Save Pre-Corrections and save the file. For simplicity we accept
the default name precorr.csv.

5. Click Close.
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To apply the computed pre-corrections, in the Final Waveform Settings
window configure the following settings

e (alibration Mode : User Defined Cal
e Apply : All Pre-Corrections
o Pre-Corrections Coefficients File : <path/filename>

The pre-corrections filename is entered by selecting the setting then clicking
on the small button that appears at the right side of the text box, to bring up a
file picker dialog. Select a previously saved pre-corrections filter.

Then click the Generate and Output button. The selected pre-correction filter
is applied and the signal is downloaded.

By separating the generation and application of pre-corrections the user has
the opportunity to alter the calibration algorithm settings and to create a
library of pre-correction filters if required.

175



[This Page Intentionally Blank]

176



Supported Formats (Generate)

B :'.o;..': N 13 Supported Formats (Generate)
.0.0.

13.1 Introduction

This chapter describes the modulation and coding options supported by the
waveform generation part of the 81199A software.

Each supported waveform type is represented by one or more entries in the
Segment Library. If the 81199A software finds a valid license for a licensed
waveform plugin, or any license-free waveform plugins, then the corresponding
tabs will appear in the Segment Library.

In addition to the licensed waveform types, there are two standard entries in
the Segment Library; Multi-tone and Utility.

If you create your own waveform plugins by following the process described in
the Agilent Wideband Waveform Center 81199A — Development Option Guide
(P/N 81199-91030), and correctly installed the DLL in the plug-ins directory
prior to starting the application, then there will also be Segment Library
window tab(s) named according to your class definition(s).

The 81199A software currently supports the following licensed plugins,

e Option IAD — IEEE 802.11ad
o Option WHD — WirelessHD 1.0b
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13.2 Multi-Tone

Multi-tone is a standard, license-free, plug-in that enables you to create single
tone, two tone and multi-tone signals. The single and two tone waveforms can
also be vector modulated to create GMSK, PSK and QAM signals.

13.2.1 Segment Settings

Each of the eight segments in the Multi-tone library has its own settings. The
settings for the segment currently selected in the Waveform Layout window
are presented in the <current> Segment Settings window.

Tone Type Set the type of tone-based signal to be generated. the possibilities are,

¢ Single Tone : This creates a single tone at the specified frequency.

e Two Tone : This creates two tones, at plus and minus the specified
frequency.

e Multi Tone : This creates a multi-tone signal centered at 0 Hz.

Number of Tones Set the number of tones appearing on each side of the center tone (Fc) at
0 Hz.

There is always a tone at Fc (which may be suppressed). So, setting this
setting to, for example, 90 will cause a 90 + 1 (at Fc) + 90 = 181 tone comb to
be generated.

Occupied Bandwidth Set the frequency delta from the most negative multi-tone frequency to the
most positive. The default values of 90 for the Number of Tones and 1.8 GHz
for the Occupied Bandwidth give a come of tones at 10 MHz spacing (with the
tone at FC suppressed).
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Suppressed Tones  Set the number of center tones to be suppressed.

It is common in OFDM modulation for the tone at Fc, or the three tones at Fc
and Fcz1 to be unused and suppressed because of the negative impact on
these tones from any DC components in the modulation. This setting allows
you to create multi-tone signals with similarly suppressed center tone(s).

Single Sided Setting this true will suppress all the negative frequency tones.

The tone frequencies are still determined by the number of tones and occupied
bandwidth values as if they were present.

0 A single-sided multi-tone signal is a very useful diagnostic signal for setting up
a wideband system as the common impairments of LO leakage, quadrature
error / gain imbalance, intermodulation distortion, skew and phase noise all
have visibly different effects on the spectrum of this signal.

Frequency Set the tone frequency Frone.

In Single Tone mode, this will generate a zero IF signal with a single sideband
modulation at +Frone. Mathematically speaking, there is no signal energy at
-Frone, however when the single tone waveform is played on practical hardware
there may be a vestigial signal at -Frone due to imperfect cancellation of the
negative frequency component.

In Two Tone mode, this will generate a zero IF signal with a double sideband
modulation at +Frone.

Modulation Symbol Set the symbol rate of the vector modulation that can optionally be applied to
Rate the tone(s).
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Modulation Type

Set the type of vector modulation that is applied to the tone(s). The choices
are,

e No Modulation

o GMSK

e 1/2-BPSK
e (QPSK

e PSK

e 16 QAM

e 64 QAM

For all the modulated signals, the modulation data is a 223-1 PRBS and the
mapping to phase/amplitude states is fixed.

Filter Type

Sets the filtering that is applied to the tone modulation. The choices are,

e Gaussian
o Root Raised Cosine
e Raised Cosine

Filter BT / Shape

Sets the shape of the filter applied to the tone modulation. If the Gaussian
Filter Type is selected then this number determines the Bandwidth-Time (BT)
product. If either of the Cosine Filter Types is selected then this number
determines the shape factor (excess bandwidth) of the filter.

Minimum Length

Sets the minimum length of the tone segment in samples.

Simple tone modulations can often be completely represented by just a few
samples which can result in very short waveform segments. But in some
situations (such as generating pseudo "recordings” for the 81199A / 89601B
VSA software) it is useful to have a longer time record to work with (even if
the extra data is mathematically redundant). This setting instructs to software
to generate at least a certain amount of sample data. The actual segment
length will be determined by the periodicity of the signal as well as other
factors such as the sample chunk size of the output device.
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13.3 IEEE 802.11ad

Published by the Institute of Electrical and Electronic Engineers (IEEE) in
December 2012; the IEEE 802.11ad specification defines a 60 GHz MAC/PHY
extension to the Wireless LAN standard IEEE 802.11-2012.

The 11ad specification was based on a contribution of earlier work by the
Wireless Gigabit Alliance (WGA), under the brand name “WiGig”, to develop a
60 GHz MAC/PHY specification.

The draft WiGig and 11ad specifications were subsequently independently
taken to completion (mainly for legal reasons) but WGA and IEEE members
worked closely to ensure that, as the two specifications were finalized, they
remained in exact technical alignment.

In this User's Guide we will refer only to IEEE 802.11ad, but the signal
generation and analysis capability is equally applicable to WiGig 1.2
deployments.

13.3.1 Segment Settings

Each segment in the library has its own settings. The settings shown in the
Segment Settings window are those of the currently selected segment.

A segment is selected by clicking on either the original in the Segment Library
window or one of the copies in the Waveform Layout window.

Modulation and Sets the modulation and coding scheme for all the packets in the selected
Coding Scheme segment. The MCS value is also encoded into the packet header(s).
(MCS)
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Length

The definition of this field changes depending on the selected MCS.

If MCSO (CPHY) is selected, this sets the CPHY PSDU length in octets.

If any MCS other than MCS0 (CPHY) is selected, this sets the non-CPHY PSDU
in octets.

In both cases, this is the number of data octets in the payload; it does not
include any "stuffing" zero octets that may be added by the encoding process
to fill out a whole number of modulation symbols.

Although only one value is displayed (depending on the MCS), the CPHY and
non-CPHY length values are remembered separately.

Scrambler
Initialization

The definition of this field changes depending on the selected MCS.

If MCSO0 (CPHY) is selected, this sets the scrambler initialization pattern for the
CPHY packet(s) in this segment. In CPHY packets only 4 bits are used as a
seed, so the range is 0 to 0x07.

If any MCS other than MCS0 (CPHY) is selected, this sets the scrambler
initialization pattern for the non-CPHY packet(s) in this segment. In non-CPHY
packets 7 bits are used as a seed, so the range is 0 to 0x7f.

Although only one value is displayed (depending on the MCS), the CPHY and
non-CPHY seed values are remembered separately.

Additional PPDU

@

Sets the Additional PPDU bit in the header of the packet in this segment.

To generate an Additional PPDU packet, set this bit in the first packet segment,
and then add a second segment which has Preamble On set to False and
Interpacket Gap set to 0.

The two segments taken together constitute an Additional PPDU packet.




Packet Type

Supported Formats (Generate)

Sets the training packet type in the header of all packets in the segment. The
choices are TRN-R and TRN-T.

Training Length

Sets the number of pattern repetitions and therefore the length of the training
field. If the value is zero, no Beamforming Training Field is appended to the
packet.

Aggregation

Sets the state of the Aggregation bit in the header of all packets in the
segment.

Beam Tracking

Sets the state of the Beam Tracking Request bit in the header of all packets in
the segment.

Tone Pairing Type

Sets the Tone Pairing Type in the header of all packets in the segment. The
choices are STP and DTP.

For signal generation, if the DTP bit is set, then the tone pairing defined in the
DTP Group Pair Index tab is used to generate the signal. However, this is
strictly intended for static verification of DTP decoding in the DUT. It is only
"dynamic" in the sense that it is non-standard and user defined. It cannot be
changed except by re-defining the segment (or by switching to a differently
configured segment). The user defined assignment must be separately
communicated to the receiving DUT for correct decoding.

If you attempt to analyze an OFDM signal that is using DTP, measurements
based on demodulation such as correlation, channel estimation and 1Q Data
constellation will be correct, but results that depend on decoding the signal
(e.g. the MCS number and the EVM calculations) will be invalid.

This is because the demodulator cannot follow a dynamic mapping in real time
and the (assumed) static tone mapping will result in incorrect header and
payload decoding. If an OFDM signal has an apparently clean constellation yet
has an unstable MCS number and / or reports a very large EVM value, check
the Tone Pairing Type of the signal under test.
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DTP Indicator

Sets the state of the DTP indicator bit in the header of all packets in the
segment.

Last RSSI

Sets the state of the Received Signal Strength Indicator (RSSI) bit in the
header of all packets in the segment.

Turnaround

Sets the state of the Turnaround bit in the header of all packets in the
segment.

SC Shaping Filter

Select the spectrum shaping filter applied to all Single Carrier (SC) and Low
Power Single Carrier (LPSC) modulated packets.

Specifically, MCS 0 to 12 and MCS 25 to 31 inclusive.

The 802.11ad specification calls for spectral shaping of the single carrier
modulations, but, to afford the transmitter designer some flexibility, does not
specify the shaping filter. The 81199A software therefore provides a choice.

The filter shaping choices are,

¢ None,

e (aussian,

o Raised-Cosine,

¢ Root-Raised-Cosine

These filter shapes are further parameterized by the BT/Shape factor (excess
bandwidth).

If another filter shape is required then you can select none and apply a custom
filter using the post processing plug-in capability described in Agilent
Wideband Waveform Center 81199A — Development Option Guide (81199-
91030).




Supported Formats (Generate)

Shaping Filter BT /  Set the Bandwidth / Time (BT) product for Gaussian filtering or the shape
Shape factor (excess bandwidth) for RC/RRC filtering.

Symbol Clock Offset Set the symbol clock offset from its nominal value expressed in parts per
million (ppm).

Payload Content Set the payload content for all packets in this segment.

The choices available are,

e PN23: The payload data comprises octets drawn, LSB first, from a
223-1 length PRBS sequence generator as defined in ITU REC 0.150
section 5.6. The PN generator is seeded, at the beginning of the first
packet in the segment, with a 1 in the first stage and a 0 in all other
stages.

e All 1's: The payload data comprises octets, each with value 0xff.
o All0's: The payload data comprises octets, each with value 0x00.

e 8-bit Count : The payload data comprises octets with an incrementing
or "counting" value, reset to 0 at the beginning of every packet in the
segment. The count is modulo 256.

e 32-bit Count : The payload data comprises little-endian 4-octet chunks
with an incrementing or "counting" value, reset to 0 at the beginning
of every packet in the segment. The count is modulo 32768.

o From File : The payload data is drawn from the file specified by the
Payload Content File setting.
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Payload Content File Set the name of the file from which the payload data is drawn if the Payload

Content setting is From File.

The file should be a text file containing 1's and 0's. Any other characters such
as spaces or carriage returns will be ignored. The data is read out of the file
character by character and if the end of file is reached, reading will start at the
beginning again (that is, when the payload length is longer than the amount of
data in the file). The payload length is determined by the setting of the Length
(octets) setting.

For example, if the file looks like this;

10111111
10100001

and the payload is set to b octets long, the payload will be

1011111110100001101111111010000110111111

and the data in the above example is used in left to right order. (left most bit
written out first)

If the payload file contains more data than needed the remainder is ignored.

If the segment has more than one packet, the data runs over from packet to
packet (similar to the PN23 data).

Each of the eight segments in the library can have a different payload file.

If the file does not exist or cannot be read, the payload will be all zeros.

Interpacket Gap

Set the Interpacket Gap.

This value determines the duration of the zero signal energy period preceding
each packet. The value is limited to 0 to 200 ps. The default value is 2 ps.

Longer silences (up to 3 ms) can be created using a Utility segment.




Supported Formats (Generate)

Packets in Waveform Set how many packets are generated in the segment.

If the segment is specified to contain more than one packet and the payload is
specified as PN data, then the PN sequence runs on through each packet in
the segment.

The advantage of specifying more than one packet in the segment (assuming a
pseudo-random payload) is that the RF spectrum will be more random. The
disadvantage is that the resulting output file will take longer to generate and
will be larger.

Preamble On Set this to False, to suppress the preamble.

This is used in conjunction with the Additional PPDU bit in the header of the
packet to create Additional PPDU packets.

To generate an Additional PPDU packet, set the Additional PPDU bit in the first
packet segment, and then add a second segment which has Preamble On set
to False and Interpacket Gap set to 0.

The two segments taken together constitute an Additional PPDU packet.

13.3.2 DTP Group Pair Index

The DTP Group Pair Index tab is used to define the tone pairing to be used
when generating a signal with dynamic tone pairing.

The tab contains a list of 42 numbers. By default these are the numbers 0 to 41
in ascending order. They are also implicitly indexed in the order 0 to 41. So
the default mapping is N to N.
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If the DTP bit is set in the header, then the defined tone pairing is used to
generate the signal. However, this is strictly intended for static verification of
DTP decoding in the DUT. Itis only "dynamic" in the sense that it is non-
standard and user defined. It cannot be changed except by re-defining the
segment (or by switching to a differently configured segment). The user
defined assignment must be separately communicated to the receiving DUT for
correct decoding.

The Tool Bar at the top of the DTP Group Pair Index tab provides icon buttons
to cut and paste different mappings, to reset to the default mapping, and to
create a random mapping.

The randomize button is intended to make it easy to create a random yet valid
mapping (one in which each number from 0 to 41 appears exactly once).
When pasting a mapping, it is the user's responsibility to make sure that it is a
valid mapping.

If you attempt to analyze an OFDM signal that is using DTP, measurements
based on demodulation such as correlation, channel estimation and 1Q Data
constellation will be correct, but results that depend on decoding the signal
(e.g. the MCS number and the EVM calculations) will be invalid.

This is because the demodulator cannot follow a dynamic mapping in real time
and the (assumed) static tone mapping will result in incorrect header and
payload decoding. If an OFDM signal has an apparently clean constellation yet
has an unstable MCS number and / or reports a very large EVM value, check
the Tone Pairing Type of the signal under test.
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13.4 Wireless HD (WiHD)

The WirelessHD specification (often abbreviated to WiHD) defines an
architecture and technology for short-range (10m) wireless interchange of
high-definition multimedia data between audio-visual devices over an ad-hoc
network in the 60GHz unlicensed band.

Version 1.0 of the WirelessHD specification was published in January 2008,
followed by version 1.1 in April 2010.

The multimedia optimized protocol is underpinned by a physical layer capable
of high speed data transmission; originally (v1.0) at rates up to 3.81Gbps,
latterly (v1.1) at rates up to 7.138 Gbps, and, in principle, up to 4 x 7.138 =
28.552 Gbps if using 4 x 4 spatial multiplexing (MIMO) .

The ad-hoc network is established and managed through bi-directional
protocol exchanges over the Low Rate PHY (LRP) while bulk data transfer
takes place over the unidirectional Medium Rate PHY (MRP) or High Rate PHY
(HRP). All three PHYs employ beam-steering techniques for Non Line Of Sight
(NLOS) operation.

LRP, MRP and HRP transmissions share a common frequency channel using
Time Division Multiple Access (TDMA) techniques managed by the protocol
layer. LRP, MRP and HRP are all RF burst transmissions starting with a
synchronization preamble followed by packet-structured OFDM modulated
data.

The 81199A option WHD currently only supports WirelessHD v1.0b features.
In particular, it does not include support for the Medium Rate PHY (MRP).

13.4.1 Segment Settings (HRP)
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Whenever a WirelessHD High Rate PHY (HRP) segment is dropped into the
Waveform Layout window, a settings table for that segment type is displayed
in the Segment Settings window. The following sub-sections briefly describe
the purpose of each entry in the HRP settings table.
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UEP Mapping Bit

This provides control over the UEP mapping bit in the HRP Header. It also
controls the constellation amplitude skew of the payload modulation.

When UEP Mapping Bit is set to True, the UEP Mapping Bit is set to 1 in the
HRP Header and UEP Mapping is enabled. This means that the axis carrying
the MSB data in the QPSK/QAM constellation of the OFDM data carrier
modulation is power boosted by a factor of 1.25.

Power boosting is only applied to the data payload symbols, not the HRP
header symbols. Furthermore UEP Mapping is only applied to the EEP Coded
transmit modes, 0, 1 and 2.

This is the definition of UEP operation that is consistent with the text of
WirelessHD v1.0b. However, since UEP mapping was not implemented in any
v1.0 compliant devices, the definition was revised in WirelessHD v1.1.

Beam Tracking Bit

This only controls the beam tracking bit in the HRP Header. When true, the
beam tracking bit is set, but no other changes are made. This revision of
option WHD software does not append a beam tracking postamble to the
HRPDU.

Payload Scrambler
Seed

This specifies the payload scrambler seed.

The transmitted data is scrambled. The header fields are always scrambled
with a default initialization of 0 because the header contains the initialization
value for the data payload scrambling. This field allows the user to set the
scrambler initialization for the data payload part of the packet.

Content Protection
Bit

When this is true, the Content Protection bit is set in the MAC Header.

The octet value in the Content Protection Header field determines the value of
the CP Header Field in the MAC Header.

CP Sub-packet Header Fields are added to each sub-packet, with the Field
value determined by the sub-packet CP values.
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Destination Station Sets the Destination Station ID in the HRP MAC header. Valid values are 0x00
ID to 0x3F.

Source Station ID Sets the Source Station ID in the HRP MAC header. Valid values are 0x00 to
0x3F.

WVAN ID Sets the Wireless Video Area Network ID in the HRP MAC header. Valid
values are 0x00 to OxFF.

Content Protection  Sets the Content Protection field the HRP MAC header. This setting is only

Header used when Content Protection Bit field is true.
Time Preamble This determines the power of the time-domain preamble relative to the
Power Boost frequency-domain preamble.

The value is expressed in decibels and is range limited to £6 dB. A positive
value corresponds to the time-domain preamble power being larger than the
frequency-domain preamble power. The default value is 3.01 dB in accordance
with the WirelessHD Specification Version 1.0b.

Packets in Waveform This controls how many packets are generated in the segment.

If the segment is specified to contain more than one packet and the payload is
specified as PN data, then the PN sequence runs on through each packet in
the segment.

The advantage of specifying more than one packet in the segment (assuming a
pseudo-random payload) is that the RF spectrum will be more random. The
disadvantage is that the resulting output file will take longer to generate and
will be larger.
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Interpacket Gap

The Interpacket gap value determines the duration of the zero signal energy
period preceding each packet. The value is limited to 0 to 200 ps. The default
value is 2 ps.

Longer silences (up to 3 ms) can be created using a Utility segment.

13.4.2 Payload Settings (HRP)

The HRP payload is structured as a sequence of up to 7 sub-packets each of
which can be configured to use a different transmit mode, with a different
payload length and (optionally) content protection value.

To facilitate the description of the required payload, a tabular setting entry is
provided. This is accessed by clicking "Configure the Payload" at the top of
the Segment Settings window.

The columns of the table are described in the following sub-sections.

Subpacket Enable

If the Enable checkbox is ticked then the sub-packet described by the Payload
Data and Payload (Octets) fields will be generated and appended to the output
waveform. The sub-packets are generated in the order they are listed, skipping
any for which the Enable checkbox is not ticked.

The software only writes information to the HRP header for the enabled sub-
packets. This has the effect of packing the header information so if, for
example, only SP4 and SP7 were enabled in the GUI, the information for SP4
would be encoded in the sub-packet 1 field of the header, and the information
for SP7 would be encoded in the sub-packet 2 field of the header.

This has two benefits. Most importantly it ensures that the header properly
describes the transmitted signal but, secondly, it also allows the user to switch
payloads quickly, by using the sub-packets as a list of alternatives and simply
enabling / disabling them as required.
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Subpacket Transmit Set the transmit mode for each subpacket.

Mode

The choices available are,

Tx Mode 0 (QPSK, 1/3, EEP)

Tx Mode 1 (QPSK, 2/3, EEP)

Tx Mode 2 (16-QAM, 2/3, EEP)

Tx Mode 3 (QPSK, 4/7, 4/5, UEP)
Tx Mode 4 (16-QAM, 4/7, 4/5, UEP)
Tx Mode 5 (QPSK, 1/3, MSB-only)
Tx Mode 6 (QPSK, 2/3, MSB-only)

Subpacket Content

Set the payload content for each subpacket.

The choices available are,

PN23 : The payload data comprises octets drawn, LSB first, from a
223-1 length PRBS sequence generator as defined in ITU REC 0.150
section 5.6. The PN generator is seeded, at the beginning of the first
packet in the segment, with a 1 in the first stage and a 0 in all other
stages.

All 1's : The payload data comprises octets, each with value 0xff.

All 0's : The payload data comprises octets, each with value 0x00.
Count : The payload data comprises octets with an incrementing or
"counting” value, reset to 0 at the beginning of every packet in the
segment. The count is modulo 256.

Subpacket Payload
Length

The Payload (Octets) field allows you to set the number of data octets in the
sub-packet.

A Payload Check Sequence is automatically calculated and added to the data
octets so the length of the sub-packet as reported in the HRP header will
always be greater (by 8; the length of the PCS in octets) than the number
entered in this field, which means that the maximum permissible value in this
field is 8 less than 220-1, or 1048567.
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Subpacket Content
Protection Field

The 16-bit hex value in the Content Protection (CP) field is active and can be
edited when the sub-packet is enabled AND the Content Protection Bit is set
in the MAC Header.

When CP is enabled, two additional octets are added to the sub-packet (before
the data payload) and their value is set in little-endian order by the value in this
field. These two octets, plus the 8 octets required for the PCS means that the
total length of the sub-packet (in octets) will be 10 more than the value in the
Payload (octets) box.

When CP is not enabled, this field is ignored, no CP octets are added to the
sub-packet, so the total length of the sub-packet (in octets) will be 8 more than
the value in the Payload (octets) box due to the PCS.

13.4.3 Segment Settings (LRP Omni)

Whenever a WirelessHD Low Rate Omni-Directional PHY (LRP Omni) segment
is dropped into the Waveform Layout window, a settings table for that
segment type is displayed in the Segment Settings window. The following
sub-sections briefly describe the purpose of each entry in the LRP Omni
settings table.

Destination Station
ID

Sets the Destination Station ID in the LRP Omni MAC header. Valid values are
0x00 to Ox3F.

Source Station ID

Sets the Source Station ID in the LRP Omni MAC header. Valid values are
0x00 to Ox3F.

WVAN ID

Sets the Wireless Video Area Network ID in the LRP Omni MAC header. Valid
values are 0x00 to OxFF.
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Payload Scrambler  Sets the payload scrambler seed.

The transmitted data is scrambled. The header fields are always scrambled
with a default initialization of 0 because the header contains the initialization
value for the data payload scrambling. This field allows the user to set the
scrambler initialization for the data payload part of the packet.

Transmit Mode Sets the transmit mode for the MAC Header, HCS and Payload fields of the
Omni-directional LRPDU.

The choices available are,

e Tx Mode 0 (BPSK, 1/3, 8x Repeat)
e Tx Mode 1 (BPSK, 1/2, 8x Repeat)
e Tx Mode 2 (BPSK, 2/3, 8x Repeat)
e Tx Mode 3 (BPSK, 2/3. 4x Repeat)

Payload Content Sets the payload content.

The choices available are,

e PN23: The payload data comprises octets drawn, LSB first, from a
223-1 length PRBS sequence generator as defined in ITU REC 0.150
section 5.6. The PN generator is seeded, at the beginning of the
payload, with a 1 in the first stage and a 0 in all other stages.

e All 1's: The payload data comprises octets, each with value 0xff.
o All0's: The payload data comprises octets, each with value 0x00.
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Payload Length

Sets the number of data octets in the packet.

The contents of the length field in the LRP Header is determined by the length
of the LRP MAC Header (fixed, in this tool, at 8 octets), plus the length of the
HCS (4 octets), plus the user selected Payload length from this field, plus the
length of the PCS (4 octets) that is automatically calculated and added to the
data octets.

This means that the value in the LRP Header length field reported by decoding
the header will always be 8 + 4 + 4 = 16 octets more than the value entered in
the Payload (octets) field by the user, which means that the maximum
permissible value in this field is 16 less than 220-1, or 1048559."

Preamble Type

Sets the Omni LRP Preamble which may be Long or Short.

The Long preamble is 56.00us long, comprising 38.25us of QPSK or Offset
QPSK modulated training sequences, followed by 17.75us of OFDM training
sequences.

The Short preamble is 42.41pus long, comprising 24.66us of QPSK or Offset
QPSK modulated training sequences, followed by the same 17.75us of OFDM
training sequences.

The choice of preamble length has no effect on the structure of the remainder
of the packet which remains the same for both options (LRP Header, MAC
Header, HCS and Packet Body).

QPSK/0FDM
Relative Power

Sets the QPSK/0OFDM Relative Power value, which determines the power of
the QPSK modulated part of the preamble relative to the OFDM modulated part
of the preamble.

The value is expressed in decibels and is range limited to £3 dB. A positive
value corresponds to the QPSK modulation power being larger than the OFDM
power.
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Use Offset QPSK The preamble on LRP Omni packets may be QPSK mapped or (optionally)
Offset QPSK mapped. This setting defaults to Offset QPSK because this was
the design choice favored by the first implementations of WirelessHD.

9 In the LRP preamble, the same data is applied to both axes (I and Q) of the
QPSK / 0QPSK modulator. This has the effect that the QPSK option effectively
produces a w/4-rotated BPSK mapped modulation. The specification text in
v1.0b was updated from "QPSK" to "rt/4-rotated BPSK" to reflect this.

Preamble Filter ShapeThe time-domain part of the preamble is QPSK (or Offset QPSK) modulated.
Factor

The specification requires that this modulation is "filtered to comply with the
LRP TX mask" but gives no other guidance on the filter type or roll-off.

For low EVM demodulation of the preamble is it useful to know the applied
filter shaping.

This software applies Raised Cosine filtering with the user selected shape
factor (excess bandwidth).

The range is 0.05 to 0.99.The default shape factor (excess bandwidth) is 0.99.",

Packets in Waveform Sets the number of packets in the segment.

If the segment is specified to contain more than one packet and the payload is
specified as PN data, then the PN sequence runs on through each packet in
the segment.

The advantage of specifying more than one packet in the segment (assuming a
pseudo-random payload) is that the RF spectrum will be more random. The
disadvantage is that the resulting output file will take longer to generate and
will be larger.
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Interpacket Gap

The Interpacket gap value determines the duration of the zero signal energy
period preceding each packet. The value is limited to 0 to 200 ps. The default
value is 2 ps.

Longer silences (up to 3 ms) can be created using a Utility segment.

13.4.4 Antenna Switching (LRP Omni)

Antenna 0..7

In LRP Omni packets the data patterns that constitute the preamble and
header fields are repeated 8 times. The payload data patterns may be repeated
8 or 4 times depending on transmit mode.

In a live system each repeat is typically transmitted using a different antenna
configuration to achieve quasi-omni-directional operation. When receiving
these packets with a single antenna the power level will step up and down
depending on the signal strength of each path between transmitter and
receiver.

These settings allow you to emulate this effect by creating an LRP Omni signal
that steps in amplitude and phase in a manner similar to what you will see
from a single antenna receiving a quasi-omni transmitter that is switching its
beam direction.

Set up to eight magnitude / phase value pairs, expressed in dB relative to the

Magnitude and Phasenormal signal magnitude, and degrees relative to the normal signal phase.

The waveform generator will sequence through the eight value pairs when
generating 8 repetition sections of the LRP Omni packet, and will sequence
through the first 4 value pairs when generating 4 repetition sections of the LRP
Omni packet.

A real system may have fewer than 8 distinct antenna configurations. To
emulate a 4, 2 or 1 antenna system, simply duplicate the magnitude / phase
settings to create a shorter sequence.
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13.4.5 Segment Settings (LRP Directional)

Whenever a WirelessHD Low Rate Directional PHY (LRP Directional) segment
is dropped into the Waveform Layout window, a settings table for that
segment type is displayed in the Segment Settings window. The following
sub-sections briefly describe the purpose of each entry in the LRP Directional
settings table.

Header Type

Sets the type of the LRP Directional packet header. If set to Ack then the first
bit of the header is set to 0 and the packet is structured as an LRP Directional
Ack packet. If it is set to Data then the first bit of the header is set to 1 and
the packet is structured as an LRP Directional packet with a payload.

ADT

This setting controls the Antenna Direction Tracking (ADT) header bit in the
Data header type and is only applicable to Data packets.

BS Request

This setting controls the BS Request bit in the Ack header type and is only
applicable to Ack packets.

ACKO...4

These five settings control the five ACK bits in the Ack header type and are
only applicable to Ack packets.

Destination Station
ID

Sets the Destination Station ID in the LRP Directional MAC header. Valid
values are 0x00 to 0x3F.

Source Station ID

Sets the Source Station ID in the LRP Directional MAC header. Valid values
are 0x00 to 0x3F.

WVAN ID
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Sets the Wireless Video Area Network ID in the LRP Directional MAC header.
Valid values are 0x00 to OxFF.
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Transmit Mode

If Header Type is set to Data then this determines the transmit mode for the
MAC Header, HCS and Payload fields of the Directional LRPDU. The choices
available are,

o 5 Mbps (BPSK, 2/3 8x Repeat)
e 10 Mbps (BPSK, 2/3, 4x Repeat)

When Header Type is Ack there is no data payload, so this setting does not
apply.

Payload Content

Set the payload content.

The choices available are,

e PN23: The payload data comprises octets drawn, LSB first, from a
223-1 length PRBS sequence generator as defined in ITU REC 0.150
section 5.6. The PN generator is seeded, at the beginning of the
payload, with a 1 in the first stage and a 0 in all other stages.

e All 1's: The payload data comprises octets, each with value 0xff.
e All0's: The payload data comprises octets, each with value 0x00.

When Header Type is Ack there is no data payload, so this setting does not
apply.

Payload Length

The Directional LRPDU payload is of very limited size as the length field in the
header has only 4 bits. In order to allow 16 data octets, the value recorded in
the header is actually length — 1 and does not include any stuffing octets that
may be required to create a whole number of modulation symbols.

There is no Payload Check Sequence (PCS) appended to Directional LRP
Payload data.

When Header Type is Ack there is no data payload, so this setting does not
apply.
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Packets in Waveform Sets the number of packets in the segment.

If the segment is specified to contain more than one packet and the payload is
specified as PN data, then the PN sequence runs on through each packet in
the segment.

Interpacket Gap

The Interpacket gap value determines the duration of the zero signal energy
period preceding each packet. The value is limited to 0 to 200 ps. The default
value is 2 ps.

Longer silences (up to 3 ms) can be created using a Utility segment.

13.4.6 Segment Settings (LRP Beam Formed)

Whenever a WirelessHD Low Rate Beam Formed PHY (LRP Beam Formed)
segment is dropped into the Waveform Layout window, a settings table for
that segment type is displayed in the Segment Settings window. The following
sub-sections briefly describe the purpose of each entry in the LRP Beam
Formed settings table.

Payload Scrambler

Sets the payload scrambler seed.

The transmitted data is scrambled. The header fields are always scrambled
with a default initialization of 0 because the header contains the initialization
value for the data payload scrambling. This field allows the user to set the
scrambler initialization for the data payload part of the packet.

Destination Station
ID

Sets the Destination Station ID in the LRP Beam Formed MAC header. Valid
values are 0x00 to 0x3F.
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Source Station ID Sets the Source Station ID in the LRP Beam Formed MAC header. Valid values
are 0x00 to 0x3F

WVAN ID Sets the Wireless Video Area Network ID in the LRP Beam Formed MAC
header. Valid values are 0x00 to 0xFF.

Transmit Mode Sets the transmit mode for the MAC Header, HCS and Payload fields of the
Beam Formed LRPDU.

The choices available are,
e Tx Mode 0 (BPSK, 1/3, No Repeat)

e Tx Mode 1 (BPSK, 1/2, No Repeat)
e Tx Mode 2 (BPSK, 2/3, No Repeat)

Payload Content Sets the payload content.

The choices available are,

e PN23: The payload data comprises octets drawn, LSB first, from a
223-1 length PRBS sequence generator as defined in ITU REC 0.150
section 5.6. The PN generator is seeded, at the beginning of the
payload, with a 1 in the first stage and a 0 in all other stages.

e All 1's: The payload data comprises octets, each with value 0xff.
o All0's: The payload data comprises octets, each with value 0x00.
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Payload Length Sets the number of data octets in the packet.

The contents of the length field in the LRP Header is determined by the length
of the LRP MAC Header (fixed, in this tool, at 8 octets), plus the length of the
HCS (4 octets), plus the user selected Payload length from this field, plus the
length of the PCS (4 octets) that is automatically calculated and added to the
data octets.

This means that the value in the LRP Header length field reported by decoding
the header will always be 8 + 4 + 4 = 16 octets more than the value entered in
the Payload (octets) field by the user, which means that the maximum
permissible value in this field is 16 less than 220-1, or 1048559."

QPSK/OFDM Relative Sets the QPSK/OFDM Relative Power value, which determines the power of
Power the QPSK modulated part of the preamble relative to the OFDM modulated part
of the preamble.

The value is expressed in decibels and is range limited to £3 dB. A positive
value corresponds to the QPSK modulation power being larger than the OFDM
power.

Use Offset QPSK The preamble on LRP Beam Formed packets may be QPSK mapped or
(optionally) Offset QPSK mapped. This setting defaults to Offset QPSK
because this was the design choice favored by the first implementations of
WirelessHD.

9 In the LRP preamble, the same data is applied to both axes (I and Q) of the
QPSK / 0QPSK modulator. This has the effect that the QPSK option effectively
produces a w/4-rotated BPSK mapped modulation. The specification text in
v1.0b was updated from "QPSK" to "rnt/4-rotated BPSK" to reflect this.
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Preamble Filter ShapeThe time-domain part of the preamble is QPSK (or Offset QPSK) modulated.
Factor

The specification requires that this modulation is "filtered to comply with the
LRP TX mask" but gives no other guidance on the filter type or roll-off.

For low EVM demodulation of the preamble is it useful to know the applied
filter shaping.

This software applies Raised Cosine filtering with the user selected shape
factor (excess bandwidth).

Packets in Waveform Sets the number of packets in the segment.

If the segment is specified to contain more than one packet and the payload is
specified as PN data, then the PN sequence runs on through each packet in
the segment.

Interpacket Gap The Interpacket gap value determines the duration of the zero signal energy
period preceding each packet. The value is limited to 0 to 200 ps. The default
value is 2 ps.

Longer silences (up to 3 ms) can be created using a Utility segment.
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13.5 Utility
The utility segment library contains a miscellany of potentially useful segment
types.
Waveform Type Set the type of waveform generated by this segment. The choices are,

e From CSV file : Import waveform data from a CSV file.

e From HDF file : Import waveform data from an HDF5 file (e.g. a
MATLAB 7.3 file)

e Square Wave : Generate a configurable square wave.

o Silence : Generate a zero valued segment of a defined duration. This
can be useful as time padding in advanced waveform layouts.

13.5.1 Segment Settings (From CSV or HDF)

Waveform Filename Set the filename of the CSV or HDF file.

To select the file, select the setting input field then click on the button marked
... that appears in the right of the field to activate the Open File dialog.

Frequency Multiplier Set a multiplier that will be used to scale the frequency specified in the file.

Amplitude Multiplier Set a multiplier that will be used to scale the amplitude of the data in the file.
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13.5.2 Creating Waveforms for Utility Segments

MATLAB HDFb5 File

The process of creating waveform files for use in a Utility Segment is
illustrated by the following very simple examples.

You are assumed to have MATLAB (7.3 or above) installed and running.

Write a script to generate the desired complex waveform and save it to a file.

The following script generates a file containing 100,000 random complex
numbers.

Y =rand(1,100000) + 1i*rand(1,100000);
XDelta = 1/3.52¢9;
save('ydata.mat’, 'Y', 'XDelta', '-v7.3");

The variable Y contains the complex waveform data and the variable XDelta
contains the sample period. The variables must be given these names and
they are case sensitive.

Run the script and note where the file is saved.

In the 81199A software, drag a Utility segment to the Waveform Layout
Window. A small blank segment will appear. (The default Utility Segment is
"Silence")

Change the segment's Waveform Type setting to "From HDF File".

Set the segment's Waveform File Name setting to specify your saved
waveform file.

The waveform file will be loaded and the waveform displayed in the segment
preview (and hence in the Final Waveform window).



CSV File
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The maximum waveform length that can be loaded using this method is
dependent on the free memory available.

If you select a file that isn't an HDF5 file, or you select an HDF file that does
not have an XDelta value, or you selects an HDF file that does not have
waveform data saved a Y, the 81199A software will report an error.

To make raw CSV waveform data understandable to 81199A you must preface
it with a declaration of the XDelta value, then the letter Y, indicating that the
waveform data follows on subsequent lines.

Here are the first few lines of an example file.

XDelta,2.840909091E-10

Y,
0.424309916,0.160213492
0.074028167,-0.032745291
-0.276156476,-0.572602034
0.146932835,-0.047312666
0.3981...

You must have a comma between XDelta and its value, and between the real

and imaginary parts of the waveform samples. The comma following the Y is

optional (but if you generate your CSV file using Microsoft Excel you will get a
comma here).

13.5.3 Segment Settings (Square Wave)

Amplitude
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Set the peak-to-peak amplitude of the square wave.

This value does not translate directly to the magnitude of the output signal
because, as for all waveforms generated by 81199A, that depends on the
cumulative effect of several factors.

The amplitude is a relative quantity, where 1 is equivalent to the nominal RMS
magnitude of the vector modulations produced by other libraries.
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Frequency Set the frequency of the square wave.

1/Q Phase Difference Set the phase offset between the | and Q components of the segment.

Number of Cycles  Set the number of cycles of square wave in the segment.

13.5.4 Segment Settings (Silence)

Length Set the time duration of a silence. During a silence, the segment samples will
be zero valued unless an impairment has been added, for example, noise.

13.6 Custom

You can create your own waveform creation plug-ins by following the process
described in the Agilent Wideband Waveform Center 81199A — Development
Option Guide (P/N 81199-91030).
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14 Measure

14.1 Introduction

81199A User's Guide

This chapter describes the modulation analysis part of the 81199A software.

The 81199A modulation analysis capability is built upon the signal acquisition
capability of the 89601B VSA.

For modulation analysis of formats supported directly by the 81199A software,
an instance of the 89601B VSA software is spawned to acquire calibrated time
records which are then post-processed by the overlay 81199A software to
perform the standards compliant analysis and results presentation.

For analysis of general purpose signals such as those generated by the Multi-
tone segment library, the 89601B VSA software should be invoked directly.

An additional advantage of delegating signal acquisition to the VSA is that the
81199A can immediately take advantage of the wide range of hardware
platforms supported by the 89601B VSA.
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Basic and Advanced To ensure that the 81199A software maintains a consistent understanding of

Menus

the 89601B VSA state, all of the 89601B acquisition settings can be configured
from the 81199A Acquisitions Settings window.

However, the 89601B VSA software is a very configurable general purpose
tool, with a correspondingly large list of settings, most of which you are
unlikely to need to alter from their default values when working with 802.11ad
or WirelessHD signals.

So at the top of the Acquisition Settings window there are two buttons, Basic
and Advanced, to select between a simplified and full settings list.

The basic acquisition settings list presents only the most commonly needed
settings, while the advanced menu simply lists all of the 89601B VSA
acquisition settings.

14.2 Acquisition Settings (Basic)

Click the Basic button to get the short list of settings most relevant to
802.11ad or WirelessHD acquisition.

14.2.1 Basic Settings

89600 Connection
String

This read-only field reports the VISA connection string for the acquisition
hardware that the 89601B VSA is currently connected to.

Center

Set the measurement center frequency.

For baseband 1Q inputs, this will normally be 0 Hz. For IF analysis this will be
the IF frequency of your DUT; specifically, 5 GHz if you are taking the IF from
an N1999A 60 GHz / 5 GHz Down-Converter.




Span

Measure

Set the measurement frequency span.

A setting of 2.25 GHz or more is suggested. Wider spans will affect the
amount of integrated noise in the measurement. Excess noise can affect
synchronization and equalization

Points

Set the number of un-aliased frequency points to display.

The suggested starting value is 102,401.

Setting large numbers of points or long Main Length values can cause the
demodulator to report an Out of Memory exception.

Mirror Frequency

Set whether the measurement data is mirrored around the center frequency.

Set this to True if your RF chain includes a spectrum inversion, perhaps due to
swapped | and Q components, an inverted Q component or a high-side mix.

The Agilent N5152A 5 GHz / 60 GHz Up-Converter includes a spectrum
inversion due to a high-side mix.

Range

This setting controls the oscilloscope input range setting. If you are using the
"l and Q Baseband Inputs" channel configuration, the range of Inputs 1 and 2
are locked together, so you only ever need to change Input 1.

The optimum range for the signal being received can be automatically found by
clicking the Auto-Range button on the Tool Bar.

81199A User's Guide
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Channel Config

@

This setting offers all the possible channel configurations available from the
underlying 89601B VSA software. However, you will generally use one of two
possibilities.

If you are connecting to the DUT at | and Q baseband (typically with |
connected to oscilloscope channel 1 and Q connected to oscilloscope channel
3) then you should choose "l and Q Baseband Inputs”.

If you are connecting to the DUT at an IF (typically with the IF signal connected
to 'scope channel 1) then you should choose "Input Channel 1",

You should always set this setting first as it will change other acquisition
settings to maintain compatibility with the chosen channel configuration.

Continuous
Measurement

This setting performs the same function as the Measure > Continuous
Measurement and Measure > Single Measurement menu entries.

Main Length

X

Set the length of the un-aliased time record to display (and process in the
demodulator).

Setting large numbers of points or long Main Length values can cause the
demodulator to report an Out of Memory exception.

14.3 Acquisition Settings (Advanced)

The advanced settings list provides control of all of the underlying 89601B
VSA's acquisition settings.

The most likely reasons you will want to access advanced settings are to make
the 89601B GUI visible, to configure triggering, or to switch the data source
between hardware and recordings.

Some guidance on these commonly used advanced capabilities is provided
below, but for a full description of all the settings please consult the 89601B
VSA documentation.
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14.3.1 Accessing the 89601B GUI

89600 State

This sets whether the graphical user interface (GUI) of the underlying 89601B
VSA instance is visible or hidden.

Normally the 89601B GUI is hidden because it is under the control of the
81199A software. Changes to the 89601B configuration should be made
through the 81199A GUI to ensure state consistency.

However, there are occasions when you will want to access the additional
analysis capabilities of 89601B VSA. This is best done by stopping 81199A
measurements temporarily and making the 89601B VSA visible.

14.3.2 Triggering

Triggering Example
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The 81199A software can operate satisfactorily in free running mode as long
as the Main Length (the duration of the Main Time record) is set long enough
that there is high probability of capturing at least the preamble of one or more
packets.

If packets are too infrequent or too long to capture consistently then you may
need to configure triggering.

Triggering on noise-like modulation is never particularly easy to configure but
here is an example use case that should help.

In this example, the signal being received is an 802.11ad MCS1.

When you start the measurement you should see the segment being randomly
captured by the oscilloscope.

1. Set the number of frequency points (or Main Length) to capture to a
little more than one packet.

Set the input level of the scope to maximize the sensitivity.

Configure a Measurement display to display Main Time, Real data and
Auto Scale the Y Axis (right mouse button).
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Stop

Figure 60. Free Running MCS1

4. Change the Hardware Trigger type to Channel
5. Set the Level to about half of the waveform height (e.g. 100mV)
6. Set the Holdoff Style to Below.

When applying these settings the measurement may pause because the
(partial) trigger conditions are not being met - when this happens, a "Data
Acquisition, waiting for trigger..." message can be seen in the Errors, Warning
and Information display.

7. Set Hold Off to Tus
8. Set Delay to -1us.

In this example, the acquisition will trigger and looks like this.



Delay

Holdoff

Level

Input Range
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Points:65,536

Figure 61. Triggered MCS1

When using Channel triggering and Below holdoff with different signals and
settings, the key settings behave as follows.

This is the simplest setting. It simply shifts the triggering "left and right". A
negative delay value is usually appropriate as it lets you acquire a small
amount of the signal that precedes the burst, which can help the demodulator.
If the oscilloscope is not triggering, changing this usually does not help.

This time relates to length of the gap between bursts, and it should be set to
less than the interpacket gap (about 50% of the typical interpacket gap size is
often a good choice). Basically, in Below holdoff mode, we are asking to
trigger on the silence between bursts, that is, if the signal is below the Level
setting, for the Holdoff time it will trigger.

This is the hardest setting to get right. It needs to be greater than the noise
level between bursts, but less than the height of the packet. Starting at zero
and increasing slowly is a good approach.

Though not a Trigger setting, Input Range, plays a very important part. If the
signal is not ranged correctly to start with, the oscilloscope may never trigger.
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14.3.3 Data Source

Data From By default, when the 81199A software starts it will set its data source for
modulation analysis as hardware (specifically, whatever hardware is currently
configured as the default hardware source in the underlying 89601B VSA).

If you subsequently load a recording into the 81199A software (in practice this
means loading a recording into the 89601B software) then the data source will
be automatically changed from Hardware to Recording and the recording
filename will be remembered.

This will also happen if you have paused the 81199A software and used the
89601B software to make a recording of a live signal for later analysis.

To return to live signal acquisition, change this setting back to Hardware.
Recording File Name This setting holds the path to the most recently loaded recording file.

Reload Recording When this setting is set to True, the recording will be re-loaded if the recording
File if Changed file on disk is updated.

14.3.4 Logging to HDF5 File

Results Logging This turns IEEE 802.11ad results logging on and off. This feature is currently
not supported by the WirelessHD demodulator.

The setting defaults to off because results log files save all measurement data
and so can become large quite quickly. This capability should therefore be
used prudently.

A new log file is created each time the measurement restarts and is closed off
when the measurement stops. So, for example, if you are in continuous mode
and you press Start, let the demodulator perform 10 demodulation cycles then
press Stop, you will get one file with 10 measurements in it.

When you press Start again, a new file will be opened.
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Logging Directory

HDF File Format

Log File Structure

Measure

This specifies the directory on the host PC where log files will be saved.

The automatically generated file names will look similar to,

WWC_log_20120608_160537.hd5

where the embedded numbers are date and time stamps.

The files are written in the Hierarchical Data Format (HDF) proposed by the
HDF Group (www.hdfgroup.org).

HDF files can be read and edited with HDFView, which is an open source utility
available from the HDF group.

http://www.hdfgroup.org/hdf-java-html/hdfview/

The HDF files created by 81199A contain two top level HDF groups.

The first is called "All Results" and it contains a group for every measurement
taken.

Each "measurement" group contains a sub-set of 11ad demodulation results
and time and spectrum data.

Even if no packets are found, or if packets are incomplete or the 11ad
demodulator is turned off, a measurement group is still created for each
measurement.

The second group is called "Protocol” and it contains groups for every
complete 11ad packet found (complete means that the number decoded octets
equals or exceeds the number specified in the header).

Each packet group contains decoded data and the packet start time. It also
contains a link to the measurement group for more information. Note that
there's nothing in the Protocol group that isn't in the Measurement group, the
Protocol group's purpose is to make it easy to see if any complete packets
were found.

81199A User's Guide
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15 Supported Formats (Measure)

15.1 Introduction

This chapter describes the functionality of the measuring demodulators
currently supported by 89601B VSA time-capture post-processing in the
81199A software. These new demodulators address specific emerging
technologies in the 60 GHz unlicensed band. For other, more established
formats, and for general purpose demodulation, the underlying 89601B VSA
demodulation capability should be used directly.

15.2 Using the VSA directly

To access the
89601B VSA
software.

If you are working with signals that comply with the specifications supported
by the 81199A software, specifically 802.11ad or WirelessHD signals, then you
should have option(s) IAD and / or WHD installed and use the modulation
analysis capabilities described in sections 15.3 and 15.4.

If you are working with multi-tone signals, or custom signals (whether by
means of Utility segments or custom plug-ins) then you will need to use the
underlying 89601B VSA software directly.

Stop 81199A measurements (if they are running) by clicking the Stop button in
the Tool Bar or selecting Measure > Stop Measurement from the menu, then
in the Acquisition Settings menu select Advanced and set 89600 State to
Visible.

Refer to the 89601B VSA on-line help (Help > User's Guide...) for full
information on using the VSA analysis capabilities.
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15.3 IEEE 802.11ad

This section introduces the 802.11ad demodulator.

To keep the explanations short, we have not detailed all the display
configuration options available in each measurement result. Please refer to
Chapter 10 for guidance.

15.3.1 Demodulator Settings

Demod On

De-Rotate
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The 802.11ad demodulator is designed to be as automated as possible, so
there are relatively few settings, and those are largely optional.

Simply setting Demod On to True should be sufficient to get started.

If set to True then the acquired time data records will be sent to the 802.11ad
demodulator for analysis. If false no data will be sent.

If more than one demodulator is enabled (for example 802.11ad and
WirelessHD) then the time data will be sent to all of them in parallel and the
measurement results will be gathered and displayed. This can prove useful
when analyzing an unknown or mixed signal.

802.11ad specifies that /2 rotation is applied to all its single carrier
modulations (BPSK, QPSK and 16QAM). The constellation displays for these
modulations are, by default, shown as they are received, without de-rotation.

This setting allows you to display the constellations after de-rotation. The
most obvious effect of this is to return the BPSK modulation to a two state
constellation. (1t/2-BPSK normally looks like QPSK because of the rotation).

The reason for defaulting to the de-rotated constellation is that any [/Q
distortions remain separated onto the | and Q axes, which is helpful for
problem identification, whereas in the de-rotated constellation, any 1/Q
distortions are smeared equally onto all constellation points.
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Packet Search
Mode

Set the packet search mode. This determines how the demodulator will select
which packet to demodulate if multiple packets are present in the time record.

"Largest Packet" means that the packet with the largest preamble correlation
will be selected.

"First Packet" means that the first packet in the time record that exceeds the
correlation threshold specified in the Search Threshold setting will be selected.

Search Threshold

Set the correlation search threshold to be used by "First Packet" search mode.

Symbol Clock
Compensation

Mode

The 802.11ad demodulator always estimates the symbol clock error as part of
the measurement set reported in the Error Summary.

This setting controls whether the demodulator will offset its symbol clock from
the nominal value using the estimated symbol clock error (auto) or the fixed
value supplied by the user in the the Symbol Clock Offset setting (manual).

Auto mode is slower than manual mode because it requires some additional
pre-processing of the signal data to estimate the symbol clock error before full
demodulation. It can also have difficulties if the DUT symbol clock is unstable
during the preamble. In general, the additional flexibility offered by manual
mode is advantageous for DUT debug.

Symbol Clock Offset

If the transmitter clock's understanding of frequency is slightly different from
that of the test equipment (based on the 90000A/X oscilloscope's reference
clock), then the demodulator's understanding of symbol clock frequency will
be similarly in error relative to the transmitter and this will degrade the
accuracy of the demodulation. This setting permits the demodulator's symbol
clock to be adjusted to match the transmitter symbol clock.

Symbol clock errors of a few parts per million can make a large difference to
the received constellation.

The appropriate value for this setting can be determined from the Symbol Clock
Error value reported in the Error Summary measurement results.




Control PHY Carrier
Tracking
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The 802.11ad Control PHY (MCS0) uses DBPSK and therefore does not need to
maintain an absolute phase reference to demodulate the signal. In other
words, it does not require carrier tracking to be implemented. However, MCS1
and above use BPSK, QPSK etc. and therefore do require carrier tracking.

Because there is this freedom to dispense with carrier tracking in MCS0, this
setting is provided (for MCS0 only) so the user can see what the constellation
looks like with and without tracking for system evaluation purposes.

If the DUT implements carrier tracking in all modes, then set this to True, if it
does not use carrier tracking in MCSQ0, then set it to False. That way, the
802.11ad demodulator "sees" the MCS0 signal the same way the DUT receiver
will "see" it.

With Control PHY Carrier Tracking set to False, EVM is usually degraded due to
phase wander over the duration of the burst.

The definition of EVM in 802.11ad specifies that the receiver should perform
“carrier lock" when measuring EVM on both CPHY and SCPHY signals, so
Control PHY Carrier Tracking should be set to True to make an EVM
measurement for comparison with the specified values.

SC PHY Amplitude
Tracking

This setting is provided as an aid to DUT debugging.

Normally the 11ad demodulator will track the signal amplitude of all Single
Carrier modulations (MCS1 to MCS12, MCS25 to MCS31), however it can be
instructive to disable this correction in order to explore the raw DUT
performance.

SC PHY Phase
Tracking

This setting is provided as an aid to DUT debugging. (See the description of
SC PHY Amplitude Tracking for more information on the purpose of these
settings).

81199A User's Guide
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OFDM PHY
Amplitude Tracking

This setting is provided as an aid to DUT debugging.

Normally the 11ad demodulator will track the signal amplitude of all OFDM
modulations (MCS13 to MCS24), however it can be instructive to disable this
correction in order to explore the raw DUT performance.

OFDM PHY Phase
Tracking

This setting is provided as an aid to DUT debugging. (See the description of
OFDM PHY Amplitude Tracking for more information on the purpose of these
settings).

OFDM PHY Timing
Tracking

This setting is provided as an aid to DUT debugging. (See the description of
OFDM PHY Amplitude Tracking for more information on the purpose of these
settings).




1Q Generation
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This setting informs the 802.11ad demodulator whether the transmitter under
test implements its vector modulation on-axis, or offset by 45° to enable
correct attribution of gain and quadrature errors.

Specifications typically illustrate constellations either on-axis (a diamond) or
offset by 45° (a box), but in practice, as long as the specified relative phasing
of the constellations of different parts of the signal is maintained, the absolute
phase is unimportant. Indeed there is no absolute phase reference at the
receiver, because the signal phase is entirely dependent on the transmission
delay.

Radio designers are essentially free to choose an on-axis or 45-degree offset
implementation depending on which is a better fit for their design constraints,
and for normal operation this is of little consequence. However to correctly
attribute the impairments of gain error and quadrature error in a measuring
demodulator it is important to know which transmitter design choice was
made.

Quadrature error in an on-axis transmitter is indistinguishable from gain error
in a 45° offset transmitter, both give a rectangular constellation. The reverse is
also true; gain error in an on-axis transmitter is indistinguishable from
quadrature error in a 45° offset transmitter, both give a rhomboid constellation.

To separate these errors, the 802.11ad demodulator assumes by default that
the transmitter has implemented the constellations as they are illustrated in
the specification, but this switch is provided for users who know that their
DUT has chosen the other possibility, so that the gain and quadrature errors
can be correctly attributed.

15.3.2 Measurements

In addition to the two primary measurement displays taken directly from the
underlying 89601B VSA software (Main Time and Spectrum), the 802.11ad
demodulator adds a further 14 measurement displays, several of which contain
multiple measurement results.

In this section we consider each measurement display in detail.

81199A User's Guide
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Main Time

1 : [Main Time]

Zoomed:False

Log
Magnitude

Points 82,671

Figure 62. Main Time Display of an 802.11ad Signal

The main time measurement result is independent of the 802.11ad
demodulator and is discussed generally in section 4.6.

When working with 802.11ad signals the time display is useful for some simple
checks before attempting to demodulate the signal.

e What is the approximate signal to noise ratio? Because 802.11ad is a
burst mode signal you can estimate the received SNR by looking at the
ratio of the power in the burst and in the gap. Because of the close
relationship between SNR and EVM this will give you guide to the best
EVM you can hope to achieve with a given signal.

e Does the signal look clipped or compressed? Especially in a QAM or
OFDM signal we expect the header and payload fields to have significantly
higher peaks than the constant amplitude preamble.

o Are there any transient effects? Amplifier issues such as slow power
ramping or ringing may be visible.

When the 802.11ad demodulator is enabled, the detected packet is highlighted
as shown in Figure 63. This is the packet in the time record that was selected
by the demodulator for demodulation to give the results in the Error Summary
and other measurement displays. The demodulator's packet search criteria are
programmable.
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: [Main Time]

Figure 63. Main Time Display of an 802.11ad Signal with Selected
Packet Highlighting.

2: [Spectrum]
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Figure 64. Spectrum Display of an 802.11ad Signal With Significant
Non-Flatness Across the Channel.
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The spectrum measurement result is independent of the 802.11ad demodulator
and is discussed generally in section 4.6.

When working with 802.11ad signals the spectrum display is useful for some
simple checks before attempting to demodulate the signal.

o [s the spectrum the right sort of shape? If it's SCPHY, does it have the
Gaussian / Cosine / custom shape you expect? If itis OFDMPHY is it
the usual “sand castle” shape?

e Are there any big dips or peaks? Some non-flatness is expected and
will be equalized out, but extreme changes can defeat an equalizer and
hence be problematic.

o |s the bandwidth about right? That is, about 1.8 GHz?

e Are there any spurs or adjacent channel spectral regrowth? In band
spurs will degrade EVM. An elevated noise floor on either side of the
expected signal may indicate intermodulation products due to non-
linearities such as gain compression.
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4 : [802.11ad Error Summary]

IS

0.93616
OFDM
MCS24

SymbaolCl
Estimated
=

TESE hex
TESE hex

I Length
ved Bits
bler Initialization

Additional PPDU
Aggreg

Beam T ing Request
DTPIndicator
TonePairing Type

Figure 65. 802.11ad Error Summary for MCS24 (OFDM)

All of the following results are presented on the Error Summary display.

This is the ratio of the mean of the peak powers at the output of the Ga128 and
Gb128 Golay correlators to the mean power in the signal, both computed over
the preamble (STF + CEF). It has a range of zero to one, where one indicates a
perfect signal with only the expected Golay sequences present.

Rho is only computed over the preamble. It is an Agilent created measurement
definition intended to provide a correlation based figure of merit for the
preamble.

Rho is a common measure of normalized correlated power in other
communication systems (such as CDMA).
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Detected MCS Type

Frequency Error

As mentioned a Rho of 1.00 indicates a “perfect” preamble, however the
preambles on OFDMPHY packets are, by definition, imperfect due to the
specified resampling necessary to match the single carrier preamble to the
OFDM reference sample rate.

This has the effect that the best achievable Rho for an OFDM signal is around
0.94.

The 802.11ad PHY supports three distinct modulation methods:

Spread spectrum modulation; the Control PHY.

2. Single carrier (SC) modulation; the Single Carrier PHY (including the
Low Power Single Carrier PHY).

3. Orthogonal Frequency Division Multiplex (OFDM) modulation; the
OFDM PHY.

The CPHY is distinguished from the other PHYs by its use of a repeating Gb128
sequence in its preamble short training field. The other PHYs use a repeating
Ga128 sequence.

The single carrier (CPHY, SCPHY and LPSCPHY) PHYs are distinguished from
the OFDM PHY by the ordering of the Golay sequences in the preamble
channel estimation field.

These simple, correlator based checks on the received signal enable the
802.11ad demodulator to determine whether the incoming packet is a Control,
Single Carrier or OFDM PHY, and this result reports the demodulator's
decision.

Both SCPHY and LPSCPHY are detected as Single Carrier MCS types.

This is the estimated frequency error in the received carrier frequency (subject
to the accuracy of the measuring hardware's own sampling clock.)

This is a signal-based estimate so there is usually a few hundred Hz of “noise”
on this measurement, but significant offsets (10’s of kHz) are accurately
reported.
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This is the estimated frequency error in the received symbol clock (subject to
the accuracy of the measuring hardware's own sampling clock.)

The demodulator can accurately measure symbol clock errors well in excess of
the £20 ppm permitted by the 802.11ad specification. Any symbol clock error
present can be compensated for by adjusting the demodulator's Symbol Clock
Offset setting.

An unstable Symbol Clock Error result may indicate that the symbol clock itself
is unstable.

This is the estimated random content (variance) of the received signal (additive
noise and phase noise, for example).

Its main value is as a comparison with EVM. [f the two numbers are similar
magnitude (ignoring the sign difference due to how the measurements are
defined) then you can assume that random noise is the dominant component
of the EVM result. If there is a significant difference then there are likely other
impairments present. At very low SNRs this estimate can become inaccurate.

This is the estimated Error Vector Magnitude (EVM) of the signal. It is
reported in dB and percent.

A complex modulation is constantly varying in amplitude and phase (versus
time). lts complex value is sampled periodically (at the symbol rate) and, at
those sampling instants, a perfect signal would be found to be exactly at one
of a finite number of pre-defined positions in the complex plane, which can
then be uniquely mapped back to an equivalent data pattern.

In practice a real signal will rarely be at exactly the ideal value. We hope it will
be sufficiently close to the ideal that it can be unambiguously decoded, but its
measured position will differ from the ideal by an error vector. If we compute
the average magnitude of these error vectors (EVM) we obtain an objective
measure of the signal perturbation.

In a real system, this perturbation is an aggregation of many effects; some,
such as noise, phase jitter, inter-symbol interference, timing skew, and symbol
clock frequency error will smear or diffuse the received sample values relative
to the ideal in very distinctive ways, cumulatively creating the familiar “cloud
of flies” around each ideal position.
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Error Summary EVM
(DC Compensated)

| & @ DC Offset

Other impairments such as 1Q gain imbalance, quadrature error, 1Q DC offset,
and gain compression will, in single carrier modulations, distort the geometry
of the received signal so that even a best fit to the ideal constellation
necessarily leaves some points “off target”. In OFDM modulation these
impairments will cause structured clusters of points (often looking like
miniature constellations) around the ideal positions. In either case degrading
the EVM.

Objective summation of the error vectors to give a single EVM result is a useful
benchmark, but subjective assessment of an impaired constellation based on
an understanding of the error mechanisms can often provide greater insight to
fault-finding the root cause of problems.

This result is available for SCPHY and LPSCPHY only, and is reported in dB and
in percent.

DC offsets on the | and Q signals will often be removed by the DUT receiver, so
it is useful to also compute EVM without this contribution, to give a more
accurate assessment of the signal quality as it will be seen by the DUT.

The DC compensated EVM may still be slightly higher than the EVM of a signal
without DC as DC can also negatively impact the performance of the equalizer.

The DC content of the signal. In an OFDM signal DC offset only affects the
central carrier (if present). The OFDM modulation used in 802.11ad suppresses
the central carrier and, indeed the carrier either side of that too.
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1Q Amplitude The estimated 10 Amplitude Imbalance indicates the gain matching of the | and
Imbalance Q channels.

For single carrier modulations, gain mismatch will result in a distorted
constellation which the receiver will not be able to fit exactly to the expected
square shape, resulting in degraded EVM.

LO Quadrature Error has similar distorting effects to 10 Amplitude Imbalance
and it is not always possible to unambiguously attribute the measured
distortion without some additional information about the transmitter.

See the description of the IQ Generation setting in section 15.3.1.

For OFDM modulation, gain mismatch causes inter-carrier interference causes
the constellation points to separate into structured clusters of points (often
looking like miniature constellations) around the ideal positions.

LO Quadrature Error The estimated LO Quadrature Error indicates how close to exactly 90° phase
difference there is between the | and Q axes.

For single carrier modulations, LO Quadrature Error will result in a distorted
constellation which the receiver will not be able to fit exactly to the expected
square shape, resulting in degraded EVM.

I1Q Amplitude Imbalance has similar distorting effects to LO Quadrature Error
and it is not always possible to unambiguously attribute the measured
distortion without some additional information about the transmitter.

See the description of the 1Q Generation setting in section 15.3.1.

For OFDM modulation, quadrature causes inter-carrier interference causes the
constellation points to separate into structured clusters of points (often
looking like miniature constellations) around the ideal positions.

81199A User's Guide 231



Header Information The header information results listed below are simply reported by the
802.11ad demodulator as they are decoded from the packet header.

e MCS — The number of the Modulation and Coding Scheme decoded
from the header. This value is also used by the demodulator to
determine how to decode the payload.

o HCS Status — Flag indicating whether the HCS from the header
matches the HCS recomputed by the demodulator from the decoded
header bits.

o Computed HCS — The checksum decoded from the header.

o Received HCS — The checksum recomputed by the demodulator from
the decoded header bits.

o Packet Type - Decoded from the header.
e PSDU Length - Decoded from the header.

e Scrambler Initialization - Decoded from the header. This value also
seeds the descrambler in the demodulator.

e Training Length - Decoded from the header.

o Last RSSI - Decoded from the header. (Not CPHY)

e Turnaround - Decoded from the header.

e Additional PPDU - Decoded from the header. (Not CPHY)

e Aggregation - Decoded from the header. (Not CPHY)

o Beam Tracking Request - Decoded from the header. (Not CPHY)
e DTP Indicator - Decoded from the header. (OFDMPHY only)

e Tone Pairing Type - Decoded from the header. (OFDMPHY only)
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Figure 66. 802.11ad Big EVM Display

This display simply provides an alternative large format display of the EVM
value in dB and %. This is the same value as is displayed under EVM in the
Error Summary.

It is intended as a convenience feature to facilitate monitoring EVM from a
distance, for example, while adjusting DUT settings to optimize EVM.
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Decoded Data

8 : [802.11ad Decoded Data]
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Figure 67. 802.11ad Decoded Data

This display shows the result of fully decoding the received 802.11ad packet to
recover the original payload data.

In order to extract the parametric results, the 81199A software has to
implement a more or less complete demodulator, including the error correction
algorithms to recover, as far as possible, the original transmitted data for
reference purposes, so the 802.11ad demodulator also implements the
descrambling, de-stuffing etc., to recover the original payload data.

The labels on the left of this display are active and can be changed by clicking
on them.

The display mode can be in octets or hinary. The distinction between these
representations is that the binary display shows the data bits in the little
endian order they are transmitted, whereas the octet display shows the same
bit pattern interpreted as octets.

The information at the top of the display reports how many octets have been
decoded and the sub-set being displayed. The starting position and the
number of octets displayed are both configurable.
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Codeword Dlsplay 4 : [802.11ad Codeword Display]
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Figure 68. 802.11ad Codeword Display

This display shows the result of error correction decoding the 802.11ad packet.

Depending on the MCS, this display will show the result of Low Density Parity
Check (LDPC) decoding (MCS0 to MCS24) or Reed-Solomon (RS) decoding
(MCS25 to MCS31).

In both cases the information at the top of the display reports how many
codewords have been decoded (158 in the case illustrated).

Following that, there is a grid of letters each representing a received codeword.
If the letter is a green P then the codeword passed parity checking, if it's a red
F then it failed.

For LDPC codewords this means the decoding algorithm failed to converge
within the iteration limit. For RS codewords this means the decoding algorithm
failed to find unambiguous roots of the error locator and magnitude
polynomials.
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The labels on the left of this display are active and can be changed by clicking
on them.

The code word index controls which codeword data is displayed. The current
selection is also highlighted by the inverse video cursor on the Pass / Fail
display. If a codeword decoded successfully the display shows the corrected
data. If decoding failed the original uncorrected data is displayed.

LDPC codewords contain 672 bits. RS codewords contain 24 or 224 octets
depending on whether the codeword belongs to the header or payload
respectively.

The display mode can be in octets or binary. The distinction between these
representations is that the binary display shows the data bits in the little
endian order they are transmitted, whereas the octet display shows the same
bit pattern interpreted as octets.

In general, bits is the most suitable mode for LDPC codewords, while octets is
better for RS codewords.
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Figure 69. 802.11ad Correlator Outputs for Gal28 and Gb128

This measurement result shows the output from a selected Golay sequence
correlator. In Figure 69 we are looking at two instances of this result, showing
the Ga128 and Gb128 correlator outputs zoomed in on the preamble of a very
clean single carrier signal.

Which correlator output to display is selected by right clicking on the X-axis
label and choosing from the drop-down list.

Only the correlators applicable to the detected MCS type (CPHY, SCPHY or
OFDMPHY) are provided.

Figure 69 illustrates how you can use the tiling capability of the docking panels
to put two (or more) related displays together into one window.

In this case we have tiled Measurement Display windows 2 and 8 into a single
window, set both displays to show the Correlator Outputs result, but then
selected the Ga128 correlator in the upper window and the Gb128 correlator in
the lower window.
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Golay Sequences

The correlator output is reported as a complex number. Nominally it is real
valued, but phase noise and other impairments can cause spreading in the
complex plane resulting in an imaginary component as well.

The default Y-axis data is Real, but by right clicking on the Y-axis label other
representations can be selected.

The most useful representations, after Real, are I-Q which is particularly
helpful in revealing any phase modulation present, and Log Magnitude which
can uncover unintended variations in signal level.

The amplitude of the Real part may fluctuate when the transmitter has drifting
phase. In this case, use the Linear Magnitude representation.

1:[802.11ad Correlator Dutput]
< st (Dstop |13 S

Figure 70. Example of Gal28 Correlator Output, represented in I-Q
mode, to Reveal Approximately 20° Phase Modulation

Golay complementary sequences are pairs of sequences of bipolar symbols
(x1) that have been mathematically constructed to have very specific
autocorrelation properties. They are used extensively in 802.11ad for a variety
of purposes.

In a receiver, correlators are used to detect which sequence was transmitted.

The nomenclature of Golay sequences is G for "Golay" followed by an 'a' or 'b’
to indicate which sequence in the pair, followed by the sequence length.

IEEE 802.11ad uses Ga32, Ga64, Ga128 and Gb128 sequences.




Ga32, Gbh32

Ga32, Gb32

81199A User's Guide

Supported Formats (Measure)

2:[802.11ad

Figure 71 Ga32 Correlator Output (Zoomed)

The first two choices in the drop-down list are Ga32 and Gb32.

Ga32 is used as the data spreading sequence in MCS0 (CPHY) to provide
coding gain.

Selecting Ga32 when in MCS0 should display a densely packed sequence of
correlation spikes corresponding to the header and payload parts of the packet.
As illustrated in Figure 71.

Each spike on this display corresponds to a spread modulation symbol, with a
positive spike representing +1 and a negative spike representing -1. The chip
rate is 1.76 GHz and the spreading factor is 32, so the correlation spikes should
occur ata 1.76 GHz / 32 = 55 MHz repetition rate.

The Gb32 sequence is not used by 802.11ad, but the 81199A software provides
the data in case the wrong sequence has been used in the DUT.

The Ga32 / Gb32 correlator traces are only active when receiving an MCS0
signal.
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Ga64, Gb64

Figure 72 Ga64 Correlator Output (Zoomed)

The next two choices in the drop-down list are Ga64 and Gh64.

Gab4 is used as a Guard Interval (GI) in all the Single Carrier modulated modes
to provide a periodic known symbol sequence for gain and phase tracking.

Gab4 is also used to construct the AGC part of the optional Beam Refinement
Field which may be present at the end of the packet.

Selecting Ga64 when in MCS1 to MCS12, or MCS25 to MCS 31, should display
a comb of correlation spikes corresponding to the Gl in the header and payload
parts of the packet. As illustrated in Figure 72.

Each spike on this display corresponds to the occurrence of a 64 symbol guard
interval marking the start of a modulation symbol block. The symbol rate is
1.76 GHz and the symbol blocks are 512 long, so the correlation spikes should
occur at a 1.76 GHz / 512 = 3.4375 MHz repetition rate.

In any MCS (0 through to 31) There may also be a burst of Ga64 correlation
spikes at the end of the packet, if there is a Beam Refinement Field present.

The Gb64 sequence is not used by 802.11ad, but the 81199A software provides
the data in case the wrong sequence has been used in the DUT.
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Figure 73. Gal28 Correlator Output Showing the Preamble and Two
BRP Training Fields at the End of the Packet.

Ga128, Gb128 The last two choices in the drop-down list are Ga128 (the default setting) and
Gb128.

Ga128 is used in the Short Training Field of all MCS preambles except MCS0
for clock synchronization, and AGC adjustments. Gb128 is used for the same
purpose in MCS0 packets. The MCS0 (CPHY) is distinguished from the other
MCS by means of this coding difference.

Ga128 and Gb128 are used together in the Channel Estimation Field as a
stimulus that can be processed to compute an estimate of the channel
response. They are also used for a similar purpose in constructing the optional
Beam Refinement Field which may be present at the end of the packet.
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As illustrated in Figure 69, selecting Ga128 when in any MCS (except MCS0),
should display a comb of correlation spikes at the beginning of the packet
corresponding to the Short Training Field in the preamble of the packet.

Each spike in this part of the display corresponds to the occurrence of a Ga128
sequence. The preamble symbol rate is 1.76 GHz and the sequences are 128
long, so the correlation spikes should occur at a 1.76 GHz / 128 = 13.75 MHz
repetition rate.

Selecting Gb128 in MCSO0 should display a similar progression of correlation
spikes.

Following the STF, there should be a sequence of correlation spikes on the
Ga128 and Gb128 outputs corresponding to the Channel Estimation Field.

In any MCS (0 through to 31) There may also be a burst of Ga128 and Gb128
correlation spikes at the end of the packet, if there is a Beam Refinement Field
present.
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Channel Estimation

Channel Estimation Type
CEFA+B

Figure 74. Channel Estimation Showing Some Multipath

This measurement result shows a channel estimation based on the received
channel estimation field. In 802.11ad, the channel estimation field provides
two independent channel estimation opportunities which are referred to in the
81199A software as CEF A and CEF B.

The software can display CEF A, CEF B or their summation (CEF A + CEF B).

Which to display is selected by right clicking on the X-axis label and choosing
from the drop-down list.

The channel estimation output is reported as a complex number. The default
Y-axis data is Log Magnitude, but by right clicking on the Y-axis label other
representations can be selected.

However, Log Magnitude is usually the most useful representation.
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Channel Estimation
Theory

Key Principle

Peaks in the channel estimation display correspond to different paths from
transmitter to receiver. The X-ordinate is time so you can determine the
spread of path delays.

The exact amplitude and delay values are easily determined by using the
cursor annotation in Zoomed mode. See section 10.4.

In Figure 74 we have contrived to have three clearly distinct paths for
illustrative purposes (-10 ns at -10 dB, 0 ns at 0 dB, and +4 ns at -15 dB), but it
is more common for there to be a smear of delayed responses in the 0 to 20ns
range.

The Ga128 and Gb128 sequences in the channel estimation field are grouped
into blocks of four. Each block provides the stimulus signals required to make
a single channel estimation. So each channel estimation field contains two
channel estimation opportunities.

Channel estimation is based on sequentially passing the two sequences in a
Golay complementary pair through the channel and combining the results.

Within each block the Ga128 and Gb128 sequences have been arranged to
form a complementary pair of 256-long sequences.

Channel estimation depends on the key property of complementary Golay
sequences, specifically that when you add the autocorrelation functions of the
'a' and 'b' sequences together all the false correlation peaks cancel exactly to
give a perfect autocorrelation response.

We have two time sequences, a and b. If we pass sequence a through the
channel H, we convolve the sequence and the channel impulse response, h(t).

If we pass the received signal through a Golay correlator for the known input
sequence then we get the autocorrelation of sequence a convolved with the
channel impulse response.

If sequence b is processed similarly, we get the autocorrelation of sequence b
convolved with the same channel impulse response.

If we add the two results together then, because sequences a and b are Golay
complementary sequences, the sum of their autocorrelations is an impulse
response and we are left with the channel response, h(t).
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CEF A With this option selected, the display shows the channel estimation based on
the first four Ga128/Gb128 sequences in the CEF.

CEF B With this option selected, the display shows the channel estimation based on
the second four Ga128/Gb128 sequences in the CEF.

CEF A+B With this option selected, the display shows the sum of the two channel
estimations.

Channel Frequency
Response

Figure 75. Channel Frequency Response (Magnitude and Phase)

This measurement result shows the estimated channel frequency response
based on the estimated channel impulse response. In Figure 75 we are looking
at two instances of this result so that we can see both magnitude and phase
responses.
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Tiling Example

Figure 75 illustrates how you can use the tiling capability of the docking panels
to put two (or more) related displays together into one window.

In this case we have tiled Measurement Display windows 6 and 4 into a single
window, set both displays to show the Channel Frequency Response result,
but then selected the Y axis representation as Log Magnitude in the upper
window and Wrapped Phase in the lower window.

The channel impulse and frequency response results include the transmitter
shaping filter response because the Golay codes used to create the estimates
pass through both the transmit filter and the channel.
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Figure 76. MCS12 16-QAM SC Figure 77. MCS24 64-QAM OFDM

This measurement result is the so called "constellation display”. It shows the
position of the vector modulation in the complex plane at the symbol decision
instants.

The colored dots indicate the measured values. Different colors represent
different parts of the waveform.

o Data Symbols : Yellow
e Guard Symbols : Red
o Header Symbols : Cyan
o Pilot Symbols : White

The different symbol types can be turned on and off to enable you to inspect
the different parts of the constellation. In the 1Q Data measurement result the
normal right-mouse-click menu is augmented with four additional choices
which toggle the different symbols on and off.

Copy Daka as Text
Copy Image

Auko Scale ¥ Axis

Show Data Svmbols
Show Guard Symbols
Show Header Symbals
Show Pilat Symbols

NN

Figure 78. 1Q Data Right-Mouse-Click Menu
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What to look for

As mentioned in the description of the EVM result, subjective assessment of
an impaired constellation based on an understanding of vector modulation
error mechanisms can often provide great fault finding insight.

To learn more about vector modulation analysis in general, please refer to the
following Agilent documents,

o Vector Signal Analysis Basics (Literature No. 5990-7451EN)

e Vector Modulation Analysis in Digital RF Communications Systems
(Literature No. 5091-8687E)
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EVM Time 8 :[802.11ad E¥M Time]

Figure 79 EVM Time Showing a 2 ppm Symbol Clock Error

This measurement result shows the constellation error vector versus time.

Constellation error vectors can be summed to give a single EVM result, but
each error vector value can also legitimately be considered as a sample of the
continuous error signal that represents the difference between the ideal and
actual signals. As such, this time-sequence of error values contains
information about the time and frequency domain properties of the error signal.

In showing how the error vector varies over time, this result can often quickly
identify drift or instability in a signal. It can also identify amplitude dependent
effects such as if the EVM degrades when switching from a QPSK header to a
QAM16 payload, suggesting that perhaps there is a gain non-linearity.

The example shown in Figure 79 illustrates the effect on EVM of an
uncorrected 2 ppm error between the transmit and receive symbol clock
reference frequencies. The error gets progressively worse as the burst
progresses as the symbol timing discrepancy grows from the initially low value
for phase lock at the start of the burst.
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EVM Spectrum

7 :[802.11ad E¥M Spectrum]
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Figure 80. EVM Spectrum Showing an In-Band Interferer at 450 MHz

This measurement result shows the EVM spectrum which is the Fourier
Transform of the error vector versus time.

If there are any dominant frequency components in the error signal they will
show as increased energy at those frequencies in the spectrum plot.

The example shown in Figure 80 illustrates two distortions.

The first is an in-band interferer at 450 MHz, this is buried (approx. 35 dB
down) and would be invisible in the normal Spectrum result, but becomes very
obvious in the EVM spectrum.

The second is revealed by the way that the error increases at the band edges
indicating that the actual spectrum shaping is different from the 0.25 RRC
assumed by the 802.11ad demodulator. In this example the transmit spectrum
shaping was actually 0.5 RRC.
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Figure 81. EVM .vs. Symbol

This measurement result displays, for each symbol over time, the spread of
error vector values across the modulated carriers in the OFDM symbol.

This is essentially a variation of the EVM time measurement result adapted for
OFDM modulation.

Each vertical strip of dots represents the data for one OFDM symbol. The dots
are color coded as for the 1Q Data display. So cyan dots (in the left-most
vertical strip) represent the error vector values for the modulated carriers in the
header symbol, while the yellow dots in the remaining strips represent the
error vector values for the modulated carriers in the data symbols.

So in a data symbol strip there are 336 yellow dots representing the data
bearing carriers in the OFDM symbol and 16 white dots representing the error
vector values of the pilot carriers.

It is evident that there are some carriers with relatively high error vector values
(and we can look at EVM .vs. Subcarrier to see if there is any trend there), but
the average error value, represented by the white trace, is below 10 %. In this
example trace there does not appear to be any significant variation in EVM
over time.
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Figure 82. OFDM EVM .vs. Subcarrier

This measurement result displays, for each of the modulated carriers in each
OFDM symbol, the spread of error vector values over time.

This is essentially a variation of the EVM spectrum measurement result
adapted for OFDM modulation.

Each vertical strip of dots represents the data for the same OFDM carrier in
each symbol. The dots are color coded as for the 1Q Data display, and you can
see the position of the static pilot tones as the periodic white lines in the
otherwise predominantly yellow spectrum.

In this example we can see by the elevated error in some of the carriers that
there is a modulated in-band interferer present, (it happens to be a WirelessHD
LRP burst at Fc + 159.625 MHz at about 25 dB down.), but again the average
error value, represented by the white trace, is generally well below 10 %.
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Figure 83. Carrier Tracking a 1 MHz Phase Modulation

This measurement result displays the carrier tracking that is being applied by
the 802.11ad demodulator's carrier tracking loop.

Practical receivers will include carrier tracking loops to remove frequency
instability from the received signal, however it is still good practice to minimize
this impairments in the DUT where possible.

In a measuring demodulator it is useful to display the carrier tracking error
versus time to help quantify the nature of the perturbation; in particular
whether there is any coherent content in the error signal.

In the example we see a carrier tracking plot revealing that it is subject to
phase modulation at 1 MHz with peak amplitude of 20°.

Each data point in this result represents the location of a Gl symbol.
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Figure 84. Residual Phase Error (20 MHz Modulation)

This measurement result displays the residual phase error between the
measured and reference signals after the measured signal has been fully
compensated for amplitude, timing, channel, carrier frequency and phase, etc.

In a measuring demodulator, as for carrier tracking, it is useful to display the
phase error versus time to help quantify the nature of the perturbation.

In the example we see a phase error plot revealing that it is subject to phase
modulation at 20 MHz with peak amplitude of 20°.
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Figure 85. Power .vs. Time

This measurement result displays the power versus time plot of the packet
from the current time record that was selected by the demodulator

Unlike the Main Time result, which just shows the acquired time domain signal
and may include several packets and partial packets, this result is locked to the
packet that was demodulated to give the current set of measurement results.
As such, this display will vary in X-axis duration and position depending on the
packet received.

255



256

15.4 WirelessHD

This section introduces the WirelessHD demodulator.

WirelessHD v1.0 has two quite distinct physical layer (PHY) definitions, the
High Rate PHY (HRP) and the Low Rate PHY (LRP). In addition, the LRP may
employ any of three sub-configurations; LRP Omni, LRP Directional and LRP
Beam Formed, depending (as their naming suggests) on the antenna mode of
operation.

WirelessHD v1.1 adds a third physical layer definition, the Medium Rate PHY
(MRP), but this version of the 81199A software does not support the MRP; it is
compliant with version 1.0b of the specification.

15.4.1 Demodulator Settings

Demod On

@

The WirelessHD demodulator does not automatically detect which PHY is
being received, that must be configured appropriately using the Analysis Mode
and LRP Type settings. However, with those set correctly, the default values
for the remaining settings should be sufficient to get started.

If true then the acquired time data records will be sent to the WirelessHD
demodulator for analysis. If false no data will be sent.

If more than one demodulator is enabled, the time data will be sent to all of
them in parallel and the measurement results will be gathered and displayed.
This can prove useful when analyzing an unknown signal.
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Analysis Mode This specifies the analysis mode.
If it is set to HRP, then the received signal is analyzed as an HRP signal.

If it is set to LRP, then the received signal is analyzed as an LRP signal, subject
to qualification by the LRP Type setting.

If it is set to DUT/RTU Relative Timings then the received signal is analyzed as
a mixture of HRP and LRP Directional Ack packets, but only for the purpose of
making the specified HRP/LRP Relative Frequency Error and Relative Symbol
Clock Error measurements.

Auto Coupling This is an "ease of use" setting. If set to true then some other settings are
automatically set based on the Analysis Mode and cannot be set manually.

The following settings are affected,
e Equalizer Training
e Track Amplitude
e Track Phase
o Track Timing
e Pulse Search

LRP Type If the Analysis Mode is set to LRP then this sets the LRP Type. The choices
are,

e Omni-long

e  Omni-Short

e Directional

e Beam Formed

I1Q Imbalance If this is set to True, then any IQ gain imbalance in the constellation is
Compensation compensated before the EVM is calculated. If it is set to False then any 1Q
gain imbalance present will degrade the computed EVM.
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Equalizer Training

If this is set to True than the equalizer will be updated by information derived
from the reference signals (pilots) after the initial estimate based on the
preamble. If set to False, then the equalizer setting is based on the preamble
only and is not updated.

Symbol Timing
Adjust

1

In principle, when demodulating an OFDM symbol, the guard interval is omitted
and a Fourier Transform is performed on the last portion of the symbol time.
However, this would result in the transform including the transition region
between this symbol and the next, which has been shaped to minimize the
symbol-to-symbol phase discontinuity inherent in OFDM modulation.

To avoid this small period where the signal is intentionally distorted and so
prevent it from inappropriately degrading the measured EVM, the analysis
window (the time record that is Fourier transformed) is backed off from the end
of the symbol period (and so uses a part of the guard interval).

The value must be between zero (meaning no back off) and -x%, where x% is
the size of the guard interval as a percentage of the Fourier Transform period.
So, for example, if the guard interval replicated 12.5% of the symbol period, the
range would be 0% to -12.5%.

The value is negative because the Fourier Transform start time is moved
backwards by this setting.

Mirror Frequency
Spectrum

If this is set to True then the frequency spectrum of the input signal is flipped
horizontally.

HRP UEP Mapping

>

If this is set to true then the demodulator expects the constellation in HRP
modes 0, 1 and 2 to be rectangular with an aspect ratio of 1.25: 1. This setting
has no effect in modes 3, 4, 5 or 6.

This interpretation of UEP mapping is based on the text of the WirelessHD v1.0
specification and is not compatible with WirelessHD v1.1.
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Decode HRP Payload If this is set to true then the demodulator will decode the HRP payload back to

the original payload octets. If it is set false it will not. This setting defaults to
false because the processing time to decode the very large payloads common
in live WirelessHD traffic can degrade the measurement cycle time, which is
inconvenient if you are not interested in the payload content.

Displayed
sub-packet ID

HRP payloads can contain up to 7 sub-packets, this setting determines which
sub-packet is displayed in the HRP Decoded Data measurement result.

Displayed Octets
Length

This sets the number of payload octets that will be displayed in the HRP
Decoded Data measurement result.

Displayed Octets
Offset

This sets the offset, from the start of the specified sub-packet, of the payload
octets that will be displayed in the HRP Decoded Data measurement result.

LRP Preamble Type

The preamble on LRP Omni and LRP Beam Formed packets may be QPSK
mapped or (optionally) 0QPSK mapped. This setting defaults to 0QPSK
because this was the design choice favored by the first implementations of
WirelessHD.

In the LRP preamble, the same data is applied to both axes (I and Q) of the
QPSK / 0QPSK modulator. This has the effect that the QPSK option effectively
produces a w/4-rotated BPSK mapped modulation. The specification text in
v1.0b was updated from "QPSK" to "rnt/4-rotated BPSK" to reflect this.

LRP Preamble Filter
Alpha

Set this to match the shape factor (excess bandwidth) of the Raised Cosine
filter that is used to shape the spectrum of LRP Omni and LRP Beam Formed
packets.
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Combine Repetitions When set to True, all repetitions in the LRP Omni packet are combined in order

to improve the available SNR. If it is set to False then only every eighth (or
fourth) repetition of the symbol is used. The preamble repetition that is used,
is selected on the basis of payload transmit mode and the received power of
each repeat.

In LRP Omni packets the data patterns that constitute the preamble and
header fields are repeated 8 times. The payload data patterns may be repeated
8 or 4 times depending on transmit mode.

In a live system each repeat is typically transmitted using a different antenna
configuration to achieve quasi-omni-directional operation. When receiving
these packets with a single antenna the power level will step up and down
depending on the signal strength of each path between transmitter and
receiver. Since each is a repetition of the same signal, they can be summed
(taking account of phase differences) to improve the received signal to noise
ratio.

LRP Mode Index

Set the expected mode index of the received LRP packet.

Track Amplitude

If set to True, the demodulator will track the pilot signal amplitudes from
symbol to symbol in the packet. Amplitude tracking is not always beneficial,
but can correct for amplitude droop on longer pulses.

Track Phase

If set to True, the demodulator will track the pilot signal phases from symbol to
symbol in the packet. Phase tracking is always beneficial, but it can be useful
to be able to turn it off temporarily when fault finding.

Track Timing

If set to True, the demodulator will track the pilot timing from symbol to symbol
in the packet. This can be beneficial in removing a constant symbol clock error.
On very clean signals, where it is effectively unnecessary, timing tracking can
degrade EVM slightly.

260



Supported Formats (Measure)

Measurement This is a legacy setting; it should always be set equal to Result Length —
Interval Measurement Offset.

Measurement Offset This sets the offset in the Result Length to the first symbol that will be
measured. The Measurement Interval, starting at the Measurement Offset
cannot extend past the Result Length.

The Measurement Offset allows you to focus on measuring just specific parts
of the WirelessHD signal, such as individual payload sub packets.

Result Length This sets the maximum number of OFDM symbols that will be processed by
the WiHD demodulator. If the packet being demodulated does not contain this
many symbols between the Measurement Offset position and the end of the
packet then processing will be limited to the number of symbols available,
regardless of this setting.

Pulse Search If this is set to True then the demodulator will use the packet start as the
starting point for the correlation search and initial timing acquisition. If itis
set False then correlation search will start from the beginning of the time
record.

If the received signal is continuous then this setting should be set False to
avoid looking for a non-existent pulse.

Pulse Threshold Auto If this is set to True then the pulse search trigger threshold is computed
Compute automatically based on the signal.

Pulse Threshold When Pulse Threshold Auto Compute is disabled, this sets the size of
amplitude step considered to mark the start of a pulse.

Time Scale Factor  This setting can be used to adjust the receiver sampling rate.
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15.4.2 Measurements

Main Time

In addition to the two primary measurement displays taken directly from the
underlying 89601B VSA software (Main Time and Spectrum), the WirelessHD
demodulator adds a further 12 measurement displays, some of which contain
multiple measurement results.

In this section we consider each measurement display in detail.

1 : [Main Time]
i 4€ | (0)start (@)Stop | [

1: Main Time Zoomed:False

Log
Magnitude

dBm

Points:
Input Ghannel 1

Figure 86. WirelessHD Main Time

The main time measurement result is independent of the WirelessHD
demodulator and is discussed generally in section 4.6.

When working with WirelessHD signals the time display is useful for some
simple checks before attempting to demodulate the signal.
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What is the approximate signal to noise ratio? Because WirelessHD is
a burst mode signal you can estimate the received SNR by looking at
the ratio of the power in the burst and in the gap. Because of the
close relationship between SNR and EVM this will give you guide to
the best EVM you can hope to achieve with a given signal.

Does the signal look clipped or compressed? In WirelessHD the time
domain preamble is transmitted at 3 dB higher power than the rest of
the signal, and the payload can be 16-QAM OFDM which has a visibly
higher peak-to-average ratio than the QPSK OFDM of the header. If
the expected step up/down in packet signal level is not present at the
start of the packet, there may be a gain compression problem.

Are there any transient effects? Amplifier issues such as slow power
ramping or ringing may be visible.
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1 : [Spectrum]

Spectrum

Figure 87. WirelessHD Spectrum

The spectrum measurement result is independent of the WirelessHD
demodulator and is discussed generally in section 4.6.

When working with WirelessHD signals the spectrum display is useful for
some simple checks before attempting to demodulate the signal.

o |s the spectrum the right sort of shape? Does it have the usual “sand
castle” shape of the OFDM modulation used in the frequency domain
preamble, header and payload, occasionally flipping to the Raised
Cosine shape due to the time domain preamble? Does it have the
notch in the center due to the suppressed carriers at FC and FC£1?

e Are there any big dips or peaks? Some non-flatness is expected and
will be equalized out, but extreme changes can defeat an equalizer and
hence be problematic.

e |[s the occupied bandwidth about right? That is, about 1.76 GHz?

o Are there any spurs or adjacent channel spectral regrowth? In band
spurs will degrade EVM. An elevated noise floor on either side of the
expected signal may indicate intermodulation products due to non-
linearities such as gain compression.
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10 Data 7 : [WiHD I Data]
i €€ | (»)start (W)stop | 3 S

7 WiHD 1Q Data
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Figure 88. WirelessHD IQ Data

This measurement result is the so called "constellation display”. It shows the
position of the vector modulation in the complex plane for each carrier in the
OFDM symbol at the decision instants.

The colored dots indicate the measured values. Different colors represent
different types of carrier in the OFDM signal.

o Payload Symbol Data Carriers : Yellow
e Suppressed Carriers : Red

e Header Symbol Data Carriers : Blue

o Pilot Carriers : White
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In Figure 88 you can see the blue QPSK modulated header data, the yellow 16-
QAM modulated payload data, the white BPSK modulated pilots and the red
un-modulated, suppressed or "DC" carriers. You can also see that the only
significant impairment on this signal is noise.

@ The small cluster of red dots to the left and down from the origin in Figure 88
is due to an un-cancelled DC feedthrough in the signal. This unwanted DC
term can be cancelled easily by adjusting DC offsets in the transmitter or
receiver until all the red dots are at the origin. In this example, a 9 mV offset
on | and a 7 mV offset on Q corrected the error.

What to look for Constellation displays are usually more distorted than this example and
subjective assessment of an impaired constellation based on an understanding
of vector modulation error mechanisms can often provide great fault finding
insight.

To learn more about vector modulation analysis in general, please refer to the
following Agilent documents,

o Vector Signal Analysis Basics (Literature No. 5990-7451EN)

o Vector Modulation Analysis in Digital RF Communications Systems
(Literature No. 5091-8687E)
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iHD E¥M Spectrum]
§ <€ | (0 start ()stop | (3 |

31 WiHD EVM

-1 77
sub carrier sub carrier

Figure 89. WirelessHD EVM Spectrum

This measurement result shows the EVM spectrum which is the Fourier
Transform of the error vector versus time for each symbol in the measurement
interval.

If there are any dominant frequency components in the error signal they will
show as increased energy at those frequencies in the spectrum plot.

Each vertical strip of dots represents the data for the same OFDM carrier in
each symbol. The dots are color coded as for the 1Q Data display. The pilot
carriers are not easy to identify because their position changes on a symbol-
by-symbol basis. The average error value is represented by the white trace.

The example shown in Figure 89 illustrates two distortions.

The first is the spike at the center frequency indicating that there is an
uncompensated DC offset present in the received signal. In this example the
spike is due to 7mV DC on | and 9mV DC on Q.

The second is revealed by the way that the error ramps up as we move away
from the center frequency. This is V-shaped growth in the EVM is typically due
to 1Q timing skew. In this example there is 50 ps of skew between the | and Q
components.

81199A User's Guide

267



OFDM EVM
.vs.Symbol

Linear

Figure 90. WirelessHD EVM .vs. Symbol

This measurement result displays, for each symbol over time, the spread of
error vector values across the modulated carriers in the OFDM symbol.

Each vertical strip of dots represents the data for one OFDM symbol. The dots
are color coded as for the 1Q Data display. So blue dots (in the four left-most
vertical strips) represent the error vector values for the modulated carriers in
the header symbols, while the yellow dots in the remaining strips represent the
error vector values for the modulated carriers in the data symbols.

So in a data symbol strip there are 336 yellow dots representing the data
bearing carriers in the OFDM symbol and 16 white dots representing the error
vector values of the pilot carriers.
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OFDM EVM .vs.
Subcarrier
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sub carrier sub carrier

Figure 91. WirelessHD EVM .vs. Subcarrier

This measurement result displays, for each of the modulated carriers the error
vector values averaged over the OFDM symbols in the measurement interval.

This is essentially a variation of the EVM spectrum measurement result
adapted for OFDM modulation.

This example display shows the same V-shaped growth in the EVM as was
shown in the example EVM Spectrum Display ( Figure 89 ). As it was for that
display, this is due to 50 ps of skew between the | and Q components.

Unlike the EVM Spectrum Display, this display does not include the spike due
to DC leakage because the carriers at Fc and Fcx1 are suppressed.
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Channel Frequency
Response

Tiling Example

1 : [WiHD Channel Frequency Response (Magnitude)]

(»)start (W)stop | (A & |

7T
sub carrier

Figure 92. WirelessHD Channel Frequency Response

This measurement result shows the estimated channel frequency response
derived from the demodulator equalizer. In Figure 92 we are looking at both
the magnitude and phase displays.

Figure 92 illustrates how you can use the tiling capability of the docking panels
to put two (or more) related displays together into one window.

In this case we have tiled Measurement Display windows 1 and 4 into a single
window, set window 1 to show the Channel Frequency Response (Magnitude)
result, and set window 2 to show the Channel Frequency Response (Phase)
result.
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Common Tracking
Error

~ommon Tracking Error Magnitude

1¢wwwww
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Figure 93. WirelessHD Common Tracking Error

This measurement result shows the Common Tracking Error. In Figure 93 we
are looking at both the magnitude and phase displays.

The WiHD demodulator estimates an average magnitude and phase value for
the measurement interval from the known pilot carriers in the OFDM symbols,
then the Common Tracking Error graphs variations about this average.

This result can be useful in revealing unwanted AM and PM, as well as symbol
clock frequency errors (which show as a phase slope).

Figure 93 illustrates the presence of a 1 MHz phase modulation. This low
frequency perturbation is compensated by the demodulator and so does not
significantly affect the 10 data constellation display.
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Cross Correlation

Coefficient

In HRP Mode

In LRP Mode

4 : [WiHD Cross Correlation Coefficient]

Linear

Figure 94. WirelessHD Cross Correlation Coefficient

This measurement result is only available in HRP mode. It shows the
correlation coefficients for the eight symbol periods that make up the
WirelessHD HRP preamble.

The WirelessHD preamble starts with a fixed time-domain (TD) preamble that
is 907.8 ns long (the same duration as 4 OFDM symbols). The TD preamble is
followed by a fixed frequency domain (FD) preamble that comprises four OFDM
symbols. These preambles are intended to be used for timing and channel
estimation respectively.

This representation of the correlation for each of the 8 preamble symbol
periods is intended to reveal any temporal variation in the preamble
correlation, perhaps due to transient problems near the start of the burst.

The example result in Figure 94 was contrived by creating a signal that had a
high level noise burst exactly coincident with the TD preamble. We can see
that, as a result, the correlation of the first four symbols is significantly
degraded. This degradation would also be reflected in the TD Preamble
Correlation result on the Error Summary display.

This measurement result is not available in LRP mode. Instead, the cross-
correlation coefficients of all the fields in the preamble are tabulated in the
Error Summary result because the preamble structure is different for each LRP
packet type.
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Error Summary 3 : [WiHD Error Summary]
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Figure 95. WirelessHD Error Summary for an HRP Packet

All of the following results are presented on the Error Summary display.

EVM This is the estimated Error Vector Magnitude (EVM) of the signal. It is
reported in dB and percent.

A complex modulation is constantly varying in amplitude and phase (versus
time). Its complex value is sampled periodically (at the symbol rate) and, at
those sampling instants, a perfect signal would be found to be exactly at one
of a finite number of pre-defined positions in the complex plane, which can
then be uniquely mapped back to an equivalent data pattern.
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Peak EVM
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In practice a real signal will rarely be at exactly the ideal value. We hope it will
be sufficiently close to the ideal that it can be unambiguously decoded, but its
measured position will differ from the ideal by an error vector. If we compute
the average magnitude of these error vectors (EVM) we obtain an objective
measure of the signal perturbation.

In a real system, this perturbation is an aggregation of many effects; some,
such as noise, phase jitter, inter-symbol interference, timing skew, and symbol
clock frequency error will smear or diffuse the received sample values relative
to the ideal in very distinctive ways, cumulatively creating the familiar “cloud
of flies” around each ideal position.

Other impairments such as 1Q gain imbalance, quadrature error, 1Q DC offset,
and gain compression will distort the geometry of the received signal so that
even a best fit to the ideal constellation necessarily leaves some points “off
target”, again degrading EVM.

Objective summation of the error vectors to give a single EVM result is a useful
benchmark, but subjective assessment of an impaired constellation based on
an understanding of these error mechanisms can often provide greater insight
to fault-finding the root cause of problems.

EVM is an average (RMS) measurement; however it is sometimes useful to
also know the peak EVM. It is reported in dB and percent.

This reports the symbol within the measurement interval in which the peak
EVM occurred.

This can help diagnose the source of EVM problems, for example, if the peak
EVM is consistently in an early symbol it might indicate a settling problem
whereas if the EVM is consistently in later symbols it might indicate a symbol
clock drift problem.

This reports the index of the carrier within the symbol identified by the Peak
EVM Symbol Index in which the peak EVM occurred.

This can help diagnose the source of EVM problems, for example, if the peak
EVM is consistently on or around a specific carrier it might indicate the
presence of an interferer whereas if the EVM is consistently in outer carriers it
might indicate a filter match problem.
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Data EVM
Pilot EVM

QPSK EVM (HRP
only)

160QAM EVM (HRP
only)

@

Frequency Error
Symbol Clock Error
1Q Timing Skew

LO Quadrature Error

| & Q DC Offset

This is the estimated Error Vector Magnitude (EVM) of the OFDM data carriers
only. Itis reported in dB and percent.

This is the estimated Error Vector Magnitude (EVM) of the OFDM pilot carriers
only. It is reported in dB and percent.

This is the estimated Error Vector Magnitude (EVM) of the QPSK modulated
data carriers only. It is reported in dB and percent.

This result is only available for HRP packets.

This is the estimated Error Vector Magnitude (EVM) of the 16QAM modulated
data carriers only. It is reported in dB and percent.

This result is only available for HRP packets.

If the 1T60AM EVM is degraded relative to the QPSK EVM this may indicate
gain compression or non-linearity. Look at the 1Q Data display for off-grid
points, particularly the outer corners of the QAM16 constellation.

This is the estimated frequency error in the received carrier frequency (subject
to the accuracy of the measuring hardware's own sampling clock.)

This is the estimated frequency error in the received symbol clock (subject to
the accuracy of the measuring hardware's own sampling clock.)

This is the estimated timing skew between the | and Q components of the
complex modulation.

The estimated LO Quadrature Error indicates how close to exactly 90° phase
difference there is between the | and Q axes.

LO Quadrature Error will result in a distorted constellation which the receiver
will not be able to fit exactly to the expected square shape, resulting in
degraded EVM.

I1Q Amplitude Imbalance has similar distorting effects to LO Quadrature Error
and it is not always possible to unambiguously attribute the measured
distortion without some additional information about the transmitter.

The DC content of the signal.
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The estimated 10 Amplitude Imbalance indicates the gain matching of the | and
Q channels.

Gain mismatch will result in a distorted constellation which the receiver will
not be able to fit exactly to the expected square shape, resulting in degraded
EVM.

LO Quadrature Error has similar distorting effects to 10 Amplitude Imbalance
and it is not always possible to unambiguously attribute the measured
distortion without some additional information about the transmitter.

The WiHD demodulator estimates an average magnitude and phase value for
the measurement interval from the known pilot carriers in the OFDM symbols.

This is the average common tracking magnitude error across the measurement
interval.

This is the measured power level of the Time Domain (TD) Preamble at the
oscilloscope's 50Q) terminated input.

This is the measured power level of the Frequency Domain (FD) Preamble at
the oscilloscope's 50Q) terminated input.

This is the relative power of the TD to FD preamble. The WirelessHD
specification requires this ratio to be 3 dB.

This is the power of the OFDM pilots relative to the power of the whole OFDM
signal.

This result is only available for HRP packets.

This is the average correlation of the Time Domain (TD) preamble.

A display of preamble correlations versus time is presented in the Cross
Correlation Coefficient result.

This result is only available for HRP packets.
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FD Preamble This is the average correlation of the Frequency Domain (FD) preamble.
Correlation (HRP

only) A display of preamble correlations versus time is presented in the Cross
Correlation Coefficient result.

This result is only available for HRP packets.

Preamble Field Cross BRGNS 0 #t1kmd |
Correlations (LRP i '
only)
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Figure 96. WirelessHD Error Summary For an LRP Omni Long Packet

Figure 96 illustrates how the Error Summary changes for LRP packets.
Specifically, the TD and FD correlation results are replaced by a field-by-field
listing of the cross correlations in the preamble.
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The preamble structure of the LRP packets is quite different from the HRP and
also varies according to the LRP packet type. This result reports the relevant

cross-correlations for the configured LRP packet type.

Channel Estimation

Correlation Result Omni Omni Beam Formed
(Long) (Short)

AGC and Signal Detect v

AGC1 v

AGC2 v

Signal Detect v

Coarse FOE v

Fine FOE v

Rx Diversity v v

AGC v

AGC 2 v

Packet Sync and AGC v
v v v

This result is only available for Omni and Beam Formed LRP packets.
Preamble correlation for LRP Directional packets is not reported.

The Error Summary variants for Omni-short and Beam Formed packets are
shown in Figure 97 and Figure 98 respectively.

.C'-Irmn nelEstimation

Figure 97. WirelessHD Preamble Field Cross Correlations for an LRP

Omni Short Packet.
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AGC
Channel Estimation

Figure 98. WirelessHD Preamble Field Cross Correlations for an LRP

Beam Formed Packet

HRP Header
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Figure 99. WirelessHD HRP Header Information

The header information results listed below are simply reported by the WiHD
demodulator as they are decoded from the HRP packet header.
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Subpacket Lengths and Tx-Mode Indices - This is the reported length
and transmit mode for each sub-packet in the payload. The length will
always be exactly 8 or 10 more than the expected number of data
octets because this count includes the 8 octets required for the
Payload Check Sum (PCS). If Content Protection (CP) is enabled, then
a further two octets are added to the sub-packet (before the data
octets) to contain the CP codeword, giving a total of 10 extra octets.
HCS Check — This reports the status of the Header Check Sum (HCS).
A Pass indicates that the content of the HCS field matches the
checksum re-computed by the demodulator from received header data.
If HCS reports Fail, then all the other values on this display may be
invalid.

Beam Tracking — This reports the binary state of the Beam Tracking
bit.

UEP Mapping — This reports the hinary state of the UEP Mapping bit.
S3-S0 — The bits S3...S0 comprise the payload scrambler seed value.
Their state is reported in binary and the equivalent decimal value.
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LRP Header

4 : [WiHD Header Information]
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7 : [WiHD Header Information]

Figure 100. WirelessHD Alternative Presentations of LRP Header
Information Depending on LRP Packet type.

The header information results listed below are simply reported by the WiHD
demodulator as they are decoded from the LRP packet header.
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Omni Headers o HCS Status — This reports the status of the Header Check Sum (HCS).
for LRP Omni packets. A Pass indicates that the content of the HCS
field matches the checksum re-computed by the demodulator from
received header data. If HCS reports Fail, then all the other values on
this display may be invalid.

e PCS Status — This reports the status of the Payload Check Sum (PCS).
for LRP Omni packets. A Pass indicates that the content of the PCS
field matches the checksum re-computed by the demodulator from
received payload data. If PCS reports Fail, this may be due to data
errors or it may be due to not having demodulated the whole packet.

o LRP Mode Index - This reports the status of the Transmit Mode Index.
for LRP Omni packets.

o LRP Length — This reports the value in the payload length field. for LRP
Omni packets. The length will always be exactly 16 more than the
expected number of data octets because this count includes the 16
octet LRP Payload Check Sum (PCS).

o LRP Scrambler Init — This reports the value in the LRP payload
scrambler seed field.

Directional Headers SCS Check — This reports the status of the Short Check Sum (SCS). for

LRP Directional packets. A Pass indicates that the content of the SCS

field matches the checksum re-computed by the demodulator from

received header data. If SCS reports Fail, then all the other values on

this display may be invalid.

o Type — This reports whether the packet is an LRP Directional Ack or
LRP Directional Data packet.

e Mode — This reports the status of the Transmit Mode bit for LRP
Directional Data packets.

o ADT - This reports the status of the Antenna Tracking bit for LRP
Directional Data packets.

o Payload Length - This reports the value in the Payload Length field for
LRP Directional Data packets.

e BS Request — This reports the status of the BS Request bit in LRP
Directional Ack packets.

o ACK1..5 - These 5 results report the status of the 5 ACK bits in LRP
Directional Ack packets.
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Figure 101. WirelessHD HRP Decoded Data

This display shows the result of fully decoding the received WirelessHD packet
to recover the original payload data.

In order to extract the parametric results, the 81199A software has to
implement a more or less complete demodulator, so the WirelessHD
demodulator also includes the FEC and decoding processes to recover the
original payload data.

The information at the top of the display reports the Payload Check Sum (PCS)
status for each sub packet present in the received packet payload.

The specific sub packet and octets to display are selected by the settings
Displayed sub-packet ID, Displayed Octets Length and Displayed Octets Offset.




Supported Formats (Measure)

15.4.3 DUT/RTU Relative Timings

The DUT/RTU Relative Timings mode is a special demodulation mode
designed specifically to measure the relative frequency and symbol clock
errors between the Device Under Test (DUT) and the RF Test Unit (RTU).

The measurement is performed between an LRP Directional Ack packet and an
HRP packet captured in the same time record.

3 : [WiHD Error Summary]

equency Error
ymbal Clock Error

Figure 102. WirelessHD DUT/RTU Relative Timings

Relative Frequency This is the relative error between the DUT and RTU center frequencies.
Error

Relative Symbol This is the relative error between the DUT and RTU symbol clock frequencies.
Clock Error
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"ee0e® 16 FAQ

16.1 Introduction

This chapter provides answers to frequently asked questions about the 81199A

software.

16.2 FAQ

The Frequently Asked Questions (FAQ) section of this User's Guide is updated
more often than the installation package that includes it. If your question is
not answered in this revision, check for a more recent version of this User's

Guide.

16.2.1 The EVM of a 5 GHz IF from an M8190A in its special N5152A mode seems
to have similar performance to an IF from an E8267D PSG, why would |

choose one over the other?

The measured EVM of the PSG-based solution is perhaps 0.3 ~ 0.4% better
than just using the M8190A directly. However there are other factors to

consider.
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The M8190A output is not image suppressed. In addition to the wanted signal
energy at 5 GHz, there is significant image energy at 1.67 GHz, and 8.33 GHz,
and sample clock energy at 6.67 GHz. If you wish to use the 5 GHz IF directly
you will want to pass the signal through a band pass filter to remove the
unwanted images. The N5152A includes a band pass filter. The E8267D
output is image-free.

The M8190A as an IF source is essentially fixed at 5 GHz. If you need an IF
signal at a higher frequency, say 10 or 15 GHz, then the E8267D has that
flexibility.

The M8190A output power is limited, if you need a higher power IF, then the
E8267D has that capability.

If you only need to generate test signals at RF, then the M8190A/N5152A
mode provides a lower cost solution because it eliminates the E8267D PSG and
requires only a single channel M8190A.

If you need baseband 1Q generation, then you will require a two channel
MB8190A, and if you also require flexible IF signal generation then the E8267D
PSG will be necessary.

16.2.2 How can | read the EVM value from the 802.11ad Error Summary?

Use the SCPI command "FETCH:AD:METRICS?". This returns all the results in
the Error Summary window as a comma separated list, e.g.

9.9592E-01,1.0157E+03,7.6260E+00,9.91E+37,6.9537E+00,9.91E+37,9.91E+37,
1.9451E+03,-4.5E+00,1.9451E+03,-3.0087E+01,1.7164E-01,3.2507E-03,9.91E+37,
10122,1,10122,0,0,0,0,10,0,100,0,66,0,0,0,0

The EVM value is the third item and is expressed in percent. The SCPI
Command Reference lists each response and its units.
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16.2.3 How can | synchronize the acquisition and demodulation step in the
software, in order to update the Error Summary metrics packet by packet?

You can synchronize measurement result fetches by checking the value of
STAT:0PER:COND?

e If a measurement is running bit 4 (value 16) will be set.
e If a waveform is being generated or downloaded bit 8 (value 256) will

be set.

The following MATLAB example shows how to do this.

function[] = SendTo81180A()

% open a socket to 81199A
function[] = Connect /()
t = tcpip('localhost', 5025);
% t = visa('agilent', 'TCPIPO::localhost::inst0::INSTR') ;
t.Timeout = 240;
fopen (t) ;
idn = query(t, '*IDN?');
disp(['You are talking to ' strtrim(idn)]);
ReadSystErrorQ () ;
end

function[] = ReadSystErrorQ()
instrumentError = strtrim(query(t,':SYST:ERR?'"));
while ~isequal (instrumentError, '0, "No error"')
disp([' syt:err : ' instrumentError]) ;
instrumentError = strtrim(query(t,':SYST:ERR?'));
end
end

% poll STAT:OPER:COND until the measuring bit is zero
function[] = WaitForMeas ()
measBit = 1;
while measBit
pause (0.5) ;
statOper = strtrim(query(t,':STAT:0PER:COND?')) ;
disp([' stat:oper:cond : ' statOperl]);
measBit = bitget (str2num(statOper),5);
end
end

% poll STAT:OPER:COND until the generation bit is zero
function[] = WaitForGeneration ()

genBit = 1;

while genBit

pause(0.5) ;
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statOper = strtrim(query(t,':STAT:0PER:COND?')) ;

disp([' stat:oper:cond : ' statOperl]);
genBit = bitget (str2num(statOper),9) ;
end
end
Connect () ;
ReadSystErrorQ () ;

[}

% clear track 1, add a single AD segment and configure it and add noise
disp('building a waveform') ;

fprintf (t, 'SOUR:TRACK1:SLIS:CLEAR'") ;

fprintf (t, 'SOUR:TRACK1:SLIS:ADD AD,1');

(
fprintf (t, 'SOUR:RAD:AD1:MCS 6') ;
fprintf (t, 'SOUR:RAD:AD1:LEN:NCPH 2000') ;
fprintf (t, 'SOUR:RAD:AD1:CONT PN23'") ;
fprintf (t, 'OUTP:NOIS:CNR 20DB') ;

fprintf (t, 'OUTP:NOIS:STAT ON') ;

% it's a good idea to wait here while the waveform finishes being built
WaitForGeneration() ;

[}

% check what output devices are available

fprintf ('available devices : %$s\n', strtrim(query(t, 'OUTP:DEV:CAT?')));
% select the 81180A and configure its address

fprintf (t, 'OUTP:DEV:SEL AGT81180A") ;

fprintf (t, 'OUTP:A81180A:ADDR "156.141.115.79"");

[}

% ask the 81199A to generate and download the waveform
disp('downloading a waveform') ;

fprintf (t, 'OUTP:DEV:RUN") ;

% wait for the download to finish, and print the messages it returned
WaitForGeneration() ;

ReadSystErrorQ () ;

% configure the measurement acquisition and turn the demod on
fprintf (t, ' :INPut:DATA:FEED HARDWARE') ;

fprintf (t, ' :INPut:CHANnel:CONFigure IQ') ;
fprintf (t, ' :SENSE:FREQ:SPAN 3e9') ;
$fprintf (t, ' : SENSe:TIME:LENgth 1le-6") ;

$fprintf (t, ' : INPut : RANGe :AUTO') ;

fprintf (t, ' : SENSe:TIME:LENgth 30e-6"');

fprintf (t, 'SENSe:DEModulation:AD ON') ;

o°

here we put the measurement into continuous mode and just query results
every few seconds - this is easy but we don't know if we are getting old
or new data - this is unsynchronized

fprintf (t, "INIT:CONT ON') ;

for i=1:10

o\

o\

pause (2) ;
metrics = eval( [ '[', query(t, 'FETCH:AD?'), 'I' 1 );
disp(['rho : ' num2str(metrics(l),6) ', evm = ' num2str(metrics(3),6)]);
beep;
end
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ReadSystErrorQ () ;

o\°

o\°

here we put the measurement into single step mode and trigger each
measurement one at a time - this ensures new data each time

fprintf (t, "INIT:CONT OFF') ;

for

end

i=1:10

fprintf (t, "INIT:IMM') ;

WaitForMeas () ;

metrics = eval( [ '[', query(t, 'FETCH:AD?'), 'I' 1 );

disp(['rho : ' num2str(metrics(l),6) ', evm = ' num2str (metrics(3),6)]);
beep;

ReadSystErrorQ () ;

fclose (t) ;

end

16.2.4 How can | read the properties of built library segments, such as length?

When composing a multi-track composite waveform programmatically, it is
often useful to know the time duration and other properties of the various
segments once they have been built (since these depend upon the settings
values used to build the segment).

The following SCPI commands

[:SOURce]:RADio:AD{1:8}:DATA:AMAX?
[:SOURce]:RADio:AD{1:8}:DATA:LENGth?
[:SOURce]:RADio:AD{1:8}:DATA:NSAMples?
[:SOURce]:RADio:AD{1:8}:DATA:SRATe?

return the absolute max value, length (in seconds), number of samples and
sample rate of the selected 802.11ad segment in the 81199A segment library.
There are similar commands for the other segment libraries.
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16.2.5 How can | control 81199A via SCPI when the M8190A firmware is hosted
on the same computer?

There are three distinct 81199A / M8190A remote control cases:

1. If the remote user is SCPI controlling the M8190A directly, the user
expects to find the M8190A on the default SCPI control port 5025.

2. If the remote user of the M8190A is actually the 81199A software
(which, in turn, is being manually operated), the 81199A expects to
find the M8190A on the default SCPI control port 5025.

3. If the remote user is controlling the 81199A software (which is, in turn,
controlling the M8190A), the remote user expects to find the 8§1199A
on the default SCPI control port 5025.

It is the third case that is the root cause of this frequently asked question.

In this case, the programmable entity from the user's point of view is the
81199A (it is, in a sense, of no interest to the user that the 81199A is "wrapped
around" the M8190A). For consistency, the control link between the 81199A
and the M8190A has to move onto another port, so that port 5025 is available
for the SCPI remote control of the 81199A.

This is done by configuring the 81199A / M8190A to use, for example, port
5026, which is achieved by changing a command line switch on M8190A and
the Port parameter in the 81199A Qutput Device menu.

For example add /s 5026 to the M8190A target field as shown in Figure 103.

In the second case (the most common situation) where the 81199A is being
operated manually and the 81199A / M8190A link uses port 5025, the 81199A
software cannot acquire port 5025 and therefore cannot itself be remotely
controlled, but since the user is operating manually, that does not matter. The
status indicators in the bottom left of the 81199A screen simply indicate that
LAN control is not available.

Incidentally, this is also why the user must start the M8190A firmware before
the 81199A software. If the 81199A software is started first it will take
ownership of port 5025 in anticipation of being remote controlled, so making it
unavailable for the M8190A when it is later started. In this case, when the
81199A later attempts to communicate with the M8190A on port 5025 it ends
up talking to itself. This case is evident by the M8190A software reporting that
SCPI control is unavailable.



FAQ

E;MBIQGA Firmware - Copy Properties m

Secuity |  Detals |  Previous Versions
General Shortcut I Compatibility

E M81304 Firmware - Copy

Target type:  Application
Target location: bin

Target: Imwﬁiiﬁme.e@ P146::0::CHlV

Start inc I"E:\Plogtam Files (x86)\Agilent\M8130\bin\"

Shortcut key: INone

Run: | Normal window ~|

Open File Location I Changelm..l MAdvanced... |

[ ok | cacel | Aoy

Figure 103. Changing the M8190A default SCPI control port.

16.2.6 Does the 81199A support floating licenses?

Currently, only node locked licenses are available for the 81199A software.
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Release Notes

¢ 17 Release Notes

17.1 Introduction

The latest 81199A software release notes are installed along with the software
and can be found in the directory,

C:\Program Files\Agilent\81199A Wideband Waveform
Center\Documentation.
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Contacting Agilent

*0®e’ 18 Contacting Agilent

18.1 Contacting Agilent

This chapter provides contact information for support on the 81199A Wideband
Waveform Center and the associated hardware platform.

18.2 Where to Go For Help

For more information about 81199A Wideband Waveform Center and for a
current sales office listing, visit our web site:
http://www.agilent.com/find /81199

You can also contact one of the following centers and ask for a test and

measurement sales representative.

United States 1 800 829 4444
1 800 829 4433 (FAX)

Canada 1877 894 4414
1905 282 6495 (FAX)

Europe +31 20 547 2111
+31 20 547 2190 (FAX)

Japan 120 421 345
120 421 678 (FAX)
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Mexico (52 55) 5081 9469
(52 55) 5081 9467 (FAX)

Australia 800 629 485
800 142 134 (FAX)

Asia-Pacific +852 800 930 871
+852 2 506 9233(FAX)
Latin America +55 11 4197 3600

+55 11 4197 3800 (FAX)

This chapter provides a glossary of the terms and acronyms used in this User
Guide.
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